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FME Desktop Basic

FME Desktop Basic Training Manual
This is the manual for the introductory-level training course for Safe Software’s FME Desktop application.

The training will introduce basic concepts and terminology, help students become efficient users of FME, and direct you to
resources to help apply the product to your own needs.

Course Structure
The full course is made up of five main sections. These sections are:
Data Translation Basics
Data Transformation
FME Best Practice
Readers and Writers
Practical Transformer Use

Current Status
The current status of this manual is: COMPLETE: this manual can be used for training.
It is valid for both FME2016.0 and FME2016.1
The status of each chapter is:
Chapter 0: Complete content. No exercises
Chapter 1: Complete content and exercises
Chapter 2: Complete content and exercises
Chapter 3: Complete content and exercises
Chapter 4: Complete content and exercises
Chapter 5: Complete content and exercises
Chapter 6: Complete content. No exercises

6

FME Desktop Basic

NB: Even for completed content, Safe Software Inc. assumes no responsibility for any errors in this document or their
consequences, and reserves the right to make improvements and changes to this document without notice. See the full licensing
agreement for further details.
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About This Document

About This Document
This manual is the introductory-level training course for FME Desktop.

Look out for residents of the City of Interopolis, who will appear from time-to-time to give you advice and dispense FME-related
wisdom. In fact, here comes someone now:

Mr. E.Dict (Attorney of FME Law) says...
On behalf of the City of Interopolis, welcome to this training course. Here is the standard legal
information about this training document and the datasets used during the course.
Be sure to read it, particularly if you're thinking about re-using or modifying this content.

Licensing and Warranty
Permission is hereby granted to use, modify and distribute the FME Tutorials and related data and documentation (collectively, the
“Tutorials”), subject to the following restrictions:
1. The origin of the Tutorials and any associated FME® software must not be misrepresented.
2. Redistributions in original or modified form must include Safe Software’s copyright notice and any applicable Data
Source(s) notices.
3. You may not suggest that any modified version of the Tutorials is endorsed or approved by Safe Software Inc.
4. Redistributions in original or modified form must include a disclaimer similar to that below which: (a) states that the
Tutorials are provided “as-is”; (b) disclaims any warranties; and (c) waives any liability claims.
Safe Software Inc. makes no warranty either expressed or implied, including, but not limited to, any implied warranties of
merchantability, non-infringement, or fitness for a particular purpose regarding these Tutorials, and makes such Tutorials available
solely on an “as-is” basis. In no event shall Safe Software Inc. be liable to anyone for direct, indirect, special, collateral,
incidental, or consequential damages in connection with or arising out of the use, modification or distribution of these Tutorials.
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This manual describes the functionality and use of the software at the time of publication. The software described herein, and the
descriptions themselves, are subject to change without notice.

Data Sources
City of Vancouver
Unless otherwise stated, the data used here originates from open data made available by the City of Vancouver, British Columbia.
It contains information licensed under the Open Government License - Vancouver.

Others
Forward Sortation Areas: Statistics Canada, 2011 Census Digital Boundary Files, 2013. Reproduced and distributed on an "as is"
basis with the permission of Statistics Canada. © This data includes information copied with permission from Canada Post
Corporation.
Digital Elevation Model: GeoBase®
Fire Hall Data: Some attribute data adapted from content © 2013 by Wikipedia, used under a Creative Commons AttributionShareAlike license
Stanley Park GPS Trail: Used with kind permission of VancouverTrails.com.

Copyright
© 2005–2016 Safe Software Inc. All rights are reserved.

Revisions
Every effort has been made to ensure the accuracy of this document. Safe Software Inc. regrets any errors and omissions that may
occur and would appreciate being informed of any errors found. Safe Software Inc. will correct any such errors and omissions in a
subsequent version, as feasible. Please contact us at:
Safe Software Inc.
Phone: 604-501-9985
Fax: 604-501-9965
Email: train@safe.com
Web: www.safe.com
Safe Software Inc. assumes no responsibility for any errors in this document or their consequences, and reserves the right to make
improvements and changes to this document without notice.

Trademarks
FME® is a registered trademark of Safe Software Inc. All brand or product names are trademarks or registered trademarks of their
respective companies or organizations.

Document Information
Document Name: FME Desktop Basic Training Manual 2016.1
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Course Overview
This training course provides a framework for a basic understanding of FME. We find users come to master one function, but go
home with many new FME uses.
The training will introduce basic concepts and terminology, help students become efficient users of FME, and direct you to
resources to help apply the product to your own needs.

Course Structure
The full course is made up of five main sections. These sections are:
Data Translation Basics
Data Transformation
FME Best Practice
Readers and Writers
Practical Transformer Use

Course Length
The instructor may choose to cover as many of these sections as they feel are required, or possible in the time permitted. They
may also cover the course content in a different order and will skip or add new content to better customize the course to your
needs.
Therefore the length and content of the course may vary, particularly when delivered online.
Safe Software offers training in two lengths: two days, and five days. The five-day course covers the same content but with fewer
hours per day (two hours per day, compared to four hours per day for the two-day course).

About the Manual
The FME Desktop training manual not only forms the basis for FME Desktop training – in-person or online – but is also useful
reference material for future work you may undertake with FME.

.1 UPDATE
The FME development cycle includes a number of follow-up releases; service packs we used to call them
A dialog box like this denotes features new or updated in FME2016.1, the first service pack since the .0
release
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Course Resources
A number of sample datasets and workspaces will be used in this course.

On Your Training Computer
The data used in this training course is based on open data from the City of Vancouver, Canada.
Most exercises ask you to assume the role of a city planner at the fictional city of Interopolis and to solve a particular problem
using this data.
Whether it's a local computer or a virtual computer hosted in the cloud, you'll find resources for the examples and exercises in the
manual at the following locations:
Location

Resource

C:\FMEData2016\Data

Datasets used by the City of Interopolis

C:\FMEData2016\Resources

Other resources used in the training

C:\FMEData2016\Workspaces

Workspaces used in the student exercises

C:\FMEData2016\Output

The location in which to write exercise output

< documents>\My FME Workspaces

The default location to save FME workspaces

You should also find FME pre-installed, plus a digital copy of this manual.
Please alert your instructor if any item is missing from your setup.
You can find the latest version of FME Desktop and FME Server for Windows, Mac, and Linux - together with the latest Beta
versions - on the Safe Software web site.

Course Etiquette
For online courses, please consider other students and test your virtual machine connection before the course starts. The instructor
cannot help debug connection problems during the course!
For live courses, please respect other students’ needs by keeping noise to a minimum when using a mobile phone or checking email.
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Data Translation Basics
At its heart, FME is a data translation tool, and this is usually the first aspect users wish to learn about.
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What is FME?
FME (the Feature Manipulation Engine) is a data translation and transformation tool for solving problems of data
interoperability.
It is a way to integrate multiple data sources without the need for coding.

Extract, Transform, and Load
FME is sometimes classed as an ETL application. ETL stands for Extract, Transform and Load. It is a data warehousing tool that
extracts data from multiple sources (here A and B), transforms it to fit the users’ needs and loads it into a destination or data
warehouse (C).

While most ETL tools process only tabular data, FME also has the geoprocessing capabilities required to handle spatial datasets.
For more general information on FME and what is can do for you, see our web site.
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How FME Works
At the heart of FME is an engine that supports an array of data types and data formats; from GIS and CAD to BIM and Point
Cloud, via XML, Raster, databases, and many more.

Rich Data Model
The capability to support so many data types is made possible by a rich data model that handles all possible geometry and
attribute types.

Most importantly, the data translation process is seamless to the user; FME automatically converts between data types as required,
and automatically substitutes one attribute or geometry type for another where the destination format does not support it.
Check out our web site for a full list of data formats supported in FME

Miss Vector says...
Attention students! I'm Miss Vector, FME schoolteacher. I'm here to give you tests on what you have
learned. I really hope you don't get these questions wrong!
Q) ETL is an acronym for...?
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1. Extra-Terrestrial Lifeform
2. Extract, Transform, Load
3. Express Toll Lane
4. Eat, Transform, Love
Q) FME can seamlessly translate between so many formats because it has...
1. A sentient data dictionary
2. A retro-encabulator
3. A rich data model
4. A core of unicorn hairs
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FME Desktop
The FME Desktop product is for data translations and transformations at the desktop level (as opposed to FME Server, which is an
enterprise-level, web-based product).
FME Desktop consists of a number of different tools and applications.

FME Desktop Applications
The two key applications within FME Desktop are FME Workbench and the FME Data Inspector.

FME Workbench
FME Workbench is the primary tool for defining data translations and data transformations. It has an intuitive point-and-click
graphic interface to enable translations to be graphically described as a flow of data.

FME Data Inspector
The FME Data Inspector is a tool for viewing data in any of the FME supported formats. It is used primarily for previewing data
before translation or reviewing it after translation.
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FME Utilities
Besides Workbench and the Data Inspector, there are several other FME utilities.

Help
A help window for FME that refreshes automatically as you click on items in FME Workbench.

FME Quick Translator
A precursor to FME Workbench that is used only for quick translations requiring no data transformation.

FME Integration Console
A tool for applying FME functionality to other GIS and CAD applications; commonly enabling use of datasets not normally
supported by those applications.

FME Licensing Assistant
An application for managing FME licensing.

Other FME Desktop Components
Additional components are also included as part of FME Desktop (Professional Edition or higher).

FME Command Line Engine
The FME Command Line Engine enables translations to be initiated at the command line level.

FME Plug-In SDK
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The FME Plug-In SDK allows developers to add formats and functionality to the FME core.
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Introduction to FME Workbench
Let's take a look at what FME Workbench is and does.

What is FME Workbench?
Workbench is FME’s tool for defining data translations and transformations.
It has an intuitive point-and-click interface to define flows of data graphically.
Workbench is fully integrated to interact with other FME Desktop applications such as the FME Data Inspector and other products
such as FME Server and FME Cloud.

Starting FME Workbench
Find FME Workbench in the FME Desktop sub-menu in the Windows start menu. Click on the entry to start Workbench.

Miss Vector says...
As we work through the course the questions will get harder. Still, these are pretty easy:
Which of the following applications is NOT a part of FME Desktop?
1. FME Workbench
2. FME Integration Console
3. FME Server Console
4. FME Data Inspector
FME Workbench allows you to define flows of data in which way...
1. Graphically
2. Telepathically
3. Problematically
4. By writing lots of code in C++ or Java
Now try starting FME Workbench as described above.
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Major Components of FME Workbench
The FME Workbench user interface has a number of major components:

Menu/Toolbar
The menubar and toolbar contain a number of tools: for example, tools for navigating around the Workbench canvas, controlling
administrative tasks, and adding or removing Reader (source) datasets.

Canvas
The FME Workbench canvas is where users graphically define a translation. This definition is called a "workspace" and can be
saved for re-use later.
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By default the workspace reads from left to right; data source on the left, transformation tools in the center, and data destination
on the right. Connections between each item represent the flow of data and may branch in different directions, merge together, or
any combination of the two.
The canvas is the primary window within Workbench and the focus of all your work.

Police-Chief Webb-Mapp says...
I'm the police chief, responsible for tracking down crimes against FME.
So, let's make sure you get the terminology right. The application itself is called FME “Workbench”, but
the process defined in the canvas window is called a “Workspace”. The terms are so similar that they are
easily confused, but please don't, otherwise I will have to send my grammar squad to arrest you!
Although mistreating FME terminology is a minor offence the ignominy of being caught is long lasting!

Navigator
The Navigator window is a structured list of parameters that represent and control all of the components on your workspace
canvas.
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Transformer Gallery
The transformer gallery is a tool for the location and selection of FME transformation tools.

Translation Log
23
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The log window (translation log) shows a report on translation results. Information includes any warning or error messages,
translation status, length of translation, and number of features processed.

History
The History window displays the workspace editing history. It is a form of tree-based undo/redo that allows a user to revisit
previous revisions in a workspace.

Workspace Properties
A minor window in which a workspace author can enter information (metadata) about the workspace.

.1 UPDATE
The Help window in Workbench, that was removed in FME2016.0, has been returned in FME2016.1.1
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Window Control
All windows in Workbench can be detached from their default position and deposited in a custom location. To do this simply click
on the frame of the window and drag it into a new position.

If a window is dropped on top of an existing window, then the two will become tabbed.
If a window is dropped beside an existing window (or between two existing windows), then they will become stacked.
In the above screenshot the user is dropping the Navigator into position on the left-hand side of Workbench, stacked on top of the
History window.

FireFighter Mapp says...
Hi. I'm your friendly neighborhood firefighter, with a hot tip for you. Don't feel put out by a lack of canvas
space. Press F11 to instantly dispatch lesser-used windows to one side and expand the canvas window to
an alarming size!

Miss Vector says...
Switch over to FME Workbench and experiment with the windows (look under the View menu) to answer
these questions.
Which of these is a window in FME Workbench?
1. The Maths Window
2. The Geography Window
3. The English Literature Window
4. The History Window
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Which of these is NOT an arrangement of Windows in FME Workbench?
1. Stacked
2. Floating
3. Double-Glazed
4. Tabbed
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Creating a Translation
Workbench’s intuitive interface makes it easy to set up and run a simple format-to-format ('quick') translation.

The Start Tab
The Start Tab in FME Workbench includes a section called "Getting Started." This section has links to the different ways in which
a workspace can be created. The simplest method is Generate Workspace:

Generate Workspace Dialog
The Generate Workspace dialog condenses all the choices to be made into a single dialog box. It has fields for defining the format
and location of both the data to be read, and the data to be written.
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Format Selection
All format selection fields in FME are both a pull-down menu and a text entry field.
The text entry field allows you to type a format name directly. It has an 'intelli-complete' function that selects close matches as you
type.
The drop-down list shows the last ten formats used, so favourite formats are instantly available:

Format selection can also be made from a table showing ALL of the formats supported by FME. To access this table, select 'More
Formats...' from the foot of the drop-down formats list.
Dataset selection fields are a text entry field, but with a browse button to open an explorer-like dialog.
Red coloring in an FME dialog indicates mandatory fields. Users must enter data in these fields to continue. In most dialogs the
OK button is de-activated until the mandatory fields are complete.

Miss Vector says...
Here's a question you can't answer with 'a', 'b', 'c', or 'd'! In the Generate Workspace dialog, why might it
be useful to set the data format before browsing for the source data?
Try browsing for a dataset before setting the format type and see if you can detect the difference. Did you
get it yet?

Feature Types Dialog
Clicking OK on the Generate Workspace dialog causes FME to generate the defined workspace. However, whenever a source
dataset contains multiple layers the user is first prompted to select which are to be translated.
This is achieved through the Select Feature Types dialog. In FME Feature Type is another term for layer. Only selected layers
show in the workspace.
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Here, for example, is a Select Feature Types dialog where the user has chosen to include all available layers in the workspace.
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The New Workspace
A new workspace reads from left to right, from the source (Reader) layers, through a dataflow, to the destination (Writer) layers.
Arrows denote the direction of data flow, from source to destination.

In the above screenshot seven layers of data are being read from one format and written to another.

TIP
In most cases FME uses the terms 'Reader' and 'Writer' instead of 'Source’ and ‘Destination.' A later
chapter explains why.
For now, just be aware that a Reader reads datasets and a Writer writes datasets, and these terms are
analogous to source/destination and input/output.

Saving the Workspace
Workspaces can be saved to a file so that they can be reused at a later date. The save button on the toolbar is one way to do this:

There are also menu options to do the same thing, in this case File > Save (shortcut = Ctrl+S) or File > Save As.
The default file extension is .fmw. Double-clicking a *.fmw file in Explorer starts FME Workbench and opens up the workspace.

Sister Intuitive says...
Greetings. I am Sister Maria Intuitive of the Order of the Perpetual Translation. I'm here to demonstrate
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some of the less obvious features of the FME Workbench interface.
For example, select File > Open Recent on the menubar to reveal a list of previously used workspaces.
This list can show up to a huge 15 entries.
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Running a Workspace
The green arrow (or 'play' button) on the Workbench toolbar starts a translation:

Alternatively, look under Run on the menubar:

The same toolbar options appear on both the menubar and toolbar. Notice the shortcut option F5 can be used instead:

NEW
The action of the Run button is modified by a series of options. These options include the ability to prompt
the user for input (Run with Prompt), the ability to inspect the data (Run with Full Inspection) and the
ability to run in debug mode (Run with Breakpoints).
Users will notice this setup is different from previous versions of FME, where each of these options had a
separate run button.
For now, we can ignore these options and just use the Run Workspace option without modifiers.

Workspace Results
After running a workspace, related information and statistics are found in the translation log, which is displayed in the Workbench
log window.
The translation log reveals whether the translation succeeded or failed, how many features were read from the source and written
to the destination, and how long it took to perform the translation.
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In this example the log file reveals that 3995 features were read from a MicroStation DGN file.
These features were written to a MapInfo TAB dataset..
The overall process was a success (with some warnings).
The elapsed time for the translation was 1.1 seconds.

Miss Vector says...
I bet you've got all of the questions correct so far! Well done. Now see if you can get these:
Which of these is NOT a way to set the format of a translation?
1. Typing the format name
2. Selecting the format from a drop-down list
3. Browsing for the format in the formats gallery
4. By selecting a dataset with a known file extension
5. None of the above (they are all valid ways to set the format)
Which key is a shortcut to run a workspace?
1. F4
2. F5
3. F5.6
4. F#
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Exercise 1

Basic Workspace Creation

Data

Zoning Data (MapInfo TAB)

Overall Goal

Create a workspace to translate zoning data in MapInfo TAB format to AutoCAD DWG

Demonstrates

Basic workspace creation with FME Workbench

Start Workspace

None

End Workspace

C:\FMEData2016\Workspaces\DesktopBasic\Basics-Ex1-Complete.fmw

Congratulations! You have just landed a job as technical analyst in the GIS department of your local city. Your old schoolteacher,
Miss Vector, gave you a reference, so don't let her down!
On your first day you've been asked to do a simple file format translation.
We’ve outlined all of the actions you need to take; though FME's interface is so intuitive you should be able to carry out the
exercise without the need for these step-by-step instructions.
1) Start FME Workbench
Start FME Workbench by selecting it from the Windows start menu. You’ll find it under Start > All Programs > FME Desktop
2016.0 > FME Workbench 2016.0.

2) Select Generate Workspace
FME Workbench will start up and begin with the Start tab active. In the Create Workspace part of the Start tab, select the option to
Generate (Workspace). Alternatively you can use the shortcut Ctrl+G.

3) Define Translation
The Generate Workspace tool opens up a dialog in which to define the translation to be carried out. Fill in the fields in this dialog
as follows:
Reader Format

MapInfo TAB (MITAB)

Reader Dataset

C:\FMEData2016\Data\Zoning\Zones.tab

Writer Format

Autodesk AutoCAD DWG/DXF
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Writer Dataset

C:\FMEData2016\Output\Training\Zones.dwg

The dialog will look like this:

Remember, you can set a format by typing its name, by selecting it from the drop- down list, or by choosing “More Formats” and
selecting the format from the full table of formats. For now, ignore the Workflow Options and leave the default of 'Static Schema.'

4) Generate and Examine Workspace
Click OK to close the Generate Workspace dialog. A new workspace will be generated into the FME Workbench canvas:

Click the arrow icon on each object to expose a list of attributes in the data.

5) Run Workspace
Run the workspace by clicking the run button on the toolbar, or by using Run > Run Translation on the menubar. The translation
will run and the log file reports something like this:
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6) Locate Output
Locate the destination data in Windows Explorer to prove that it's been written as expected. In the next section we’ll cover how to
inspect the dataset to ensure that it is correct.

TIP
When a translation is run immediately in Workbench or Quick Translator, without further adjustment, it's
known as a 'Quick Translation.'
Because FME is a 'semantic' translator, with an enhanced data model, the output from a quick translation
is as close to the source data in structure and meaning as possible, given the capabilities of the destination
format.

CONGRATULATIONS
By completing this exercise you have learned how to:
Create an FME workspace
Run an FME workspace
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Introduction to Data Inspection
To ensure that you're dealing with the right information you need a clear view of your data at every stage of the transformation
process.
Data Inspection meets this need: it is the act of viewing data for verification and debugging purposes, before, during, or after a
translation.

What Can Be Inspected?
A number of different aspects of data may be inspected, including the following:
Geometry: Is the geometry in the correct spatial location? Are the geometry types correct?
Symbology: Is the color, size, and style of each feature correct?
Attributes: Are all the required attributes present? Are all integrity rules being followed?
Format: Is the data in the expected format?
Schema: Is the data subdivided into the correct layers, categories or classes?
Quantity: Does the data contain the correct number of features?
Output: Has the translation process restructured the data as expected?

Chef Bimm says...
Hi. I'm Chef Bimm and I'm here to help you cook up some tasty data translations.
I have a great recipe for loading CAD files into a Building Information Model. Inspecting the
ingredients... I mean data... before I use them lets me detect problems before they affect the translation.
Features in the wrong source layer could need the whole process to be repeated. Data Inspection saves me
that hassle.
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Introduction to the FME Data Inspector
The role of inspecting data in FME is not carried out in FME Workbench, but in a complementary application: the FME Data
Inspector.

What is the FME Data Inspector?
The FME Data Inspector is a utility that allows viewing of data in any of the FME supported formats. It is used primarily to
preview data before translation or to verify it after translation.
The FME Data Inspector can also be used to check data at any point during a translation; as you use FME you’ll find this is useful
for step-by-step examination of complex translations.
The FME Data Inspector is closely tied to FME Workbench so that Workbench can send data directly to the Inspector.

What the FME Data Inspector Is Not!
The FME Data Inspector isn’t designed to be a form of GIS or mapping application. It has no all-around analysis functionality,
and the tools for symbology modification and printing are rudimentary and intended for data validation rather than producing map
output.

Starting the FME Data Inspector
To start the FME Data Inspector, from the Windows start menu click FME Desktop 2016, then on the sub-menu click FME Data
Inspector 2016.

Miss Vector says...
FME is so easy to use, it's hard to think up some difficult questions! But I'll try.
When you are inspecting *schema*, what are you trying to verify?
1. The color and linestyle of features
2. The number of features
3. The layers (classes, tables, types)
4. Where the nearest coffee shop is
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Major Components of the FME Data Inspector
When the FME Data Inspector is started, and a dataset is opened, it looks something like this:

Menu bar and Toolbar
The menu bar and toolbar contain a number of tools. Some are for navigating around the View window, some control
administrative tasks such as opening or saving a dataset, and others are for special functionality such as selective filtering of data
or the creation of dynamic attributes.

View Window
The View window is the spatial display area of the FME Data Inspector. Multiple views of different datasets may be opened at any
one time.
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Display Control Window
The Display Control window shows a list of the open datasets and their feature types. Tools here let users turn these on or off in
the display, alter their symbology, and adjust the display order.

Feature Information Window
When users query a feature in the View window, information about that feature is shown in the Information window. This
information includes the feature’s feature type, attributes (both user and format attributes), coordinate system and details about its
geometry.
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Table View Window
The Table View window is a spreadsheet-like view of a dataset and includes all of the features and all of the attributes, with a
separate tab for each feature type (layer).
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Log Window
The Log window (hidden in above screenshot) reports information relating to the reading and look of a dataset that can be used to
confirm whether data has been read correctly. Some functions on the toolbar also generate messages in the Log window.

43

Viewing Data in the FME Data Inspector

Using the FME Data Inspector
With the FME Data Inspector it’s easy to open and view any number of datasets and to query features within them.

Viewing Data
The FME Data Inspector provides two methods for viewing data: opening or adding. Opening a dataset opens a new view window
for it to be displayed in. Adding a dataset displays the data in the existing view window; this way multiple datasets can be viewed
simultaneously.

Opening a Dataset
Datasets can be opened in the FME Data Inspector in a number of ways.
Select File > Open Dataset from the menu bar
Select the toolbar button Open Dataset.
Drag and drop a file onto any window (except the View window)
Open from within Workbench

Opening data from within FME Workbench is achieved by simply right-clicking on a canvas feature type (either source or
destination) and choosing the option ‘Inspect'.
All of these methods cause a dialog to open in the FME Data Inspector in which to define the dataset to view.

Adding a Dataset
Opening a dataset causes a new View tab to be created and the data displayed. To open a dataset within an existing view tab
requires use of tools to add a dataset.
Selecting File > Add Dataset from the menu bar
Selecting the toolbar button Add Dataset
Dragging and Dropping a file onto the view window
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Windowing Tools
Once data has been opened in the FME Data Inspector, there are a number of tools available for altering the view.
Pan
Zoom In
Zoom Out
Zoom to a selected feature
Zoom to the full extent of the data

Background Maps
The ability to view maps (or other imagery) as a backdrop to your spatial data is activated by a tool under Tools > FME Options
on the menubar.
The background map dialog lets the user select an existing dataset (of any FME-supported format) to use as a backdrop, like so:

It's also possible to use a number of different web services that supply mapping on demand. Some of these - such as ArcGIS
Online - do require an existing account:
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Police Chief Webb-Mapp says...
When I'm investigating - sorry, inspecting - source data I know it must be referenced against a valid
coordinate system for background data to be displayed. If the coordinate system is not recorded in the
dataset itself, I can enter it into a field when opening the dataset

I've also deduced that it doesn't matter what coordinate system the data is referenced against; FME will
automatically convert it to whatever system is being used by the background map.
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Inspecting Data
THE FME Data Inspector includes several querying tools, but in particular:
Query individual feature(s)
Measure a distance within a View window

The query tool button is like a toggle. By default it is active when you start the FME Data Inspector; if you click it again - or
select a windowing tool - you turn the query tool off.
The results of a feature query are shown in the Feature Information window.

Feature Information Window
The upper part reports on general information about the feature; which feature type (layer) it belongs to, which coordinate system
it is in, whether it is two- or three-dimensional, and how many vertices it possesses.
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The middle part reports the attributes associated with the feature. This includes user attributes and format attributes (for example
fme_type).
The lower part reports the geometry of the feature. It includes the geometry type and a list of the coordinates that go to make up
the feature.

Table View Window
Also available is a window called the Table View.
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The table view is a way to inspect data in a tabular, spreadsheet-like, layout. Although it does not have the same depth of
information shown by the Information Window, the Table View is particularly useful for inspecting the attribute values of multiple
features simultaneously.

Miss Vector says...
You'll need to have the FME Data Inspector started to answer this question.
Open a dataset and right-click on records and column-headers in the Table View window. Which of the
following is NOT an available option(s):
1. Sort (Alphabetical or Numeric)
2. Inspect Value
3. Cut/Copy/Paste
4. Save Selected Data As
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Exercise 2

Basic Data Inspection

Data

Zoning Data (MapInfo TAB)

Overall Goal

Inspect the output from a previous translation

Demonstrates

Basic data inspection with the FME Data Inspector

Start Workspace

C:\FMEData2016\Workspaces\DesktopBasic\Basics-Ex1-Complete.fmw

End Workspace

None

In the previous exercise you were asked to convert some data between formats. Before you send the converted data out you should
really inspect it to make sure it is correct. If you haven't been trying it already, let’s see how the FME Data Inspector interface
works by inspecting the output from that quick translation.
1) Start FME Data Inspector
Start the FME Data Inspector by selecting it from the Windows start menu. You’ll find it under Start > All Programs > FME
Desktop 2016.0 > FME Data Inspector 2016.0.

2) Select Dataset
The FME Data Inspector will start up and begin with an empty view display.
To open a dataset, select File > Open Dataset from the menubar. When prompted, fill in the fields in the Select Dataset dialog as
follows:
Reader Format

Autodesk AutoCAD DWG/DXF

Reader Dataset

C:\FMEData2016\Output\Training\Zones.dwg

NB: If you can't find the dataset - maybe you didn't complete the first exercise, or wrote the data to a different location - then you
can open the original zoning dataset as:
Reader Format

MapInfo TAB (MITAB)

Reader Dataset

C:\FMEData2016\Data\Zoning\Zones.tab

3) Open Dataset
The dataset should look something like this:
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4) Browse Data
Use the windowing tools on the toolbar to browse through the dataset, inspecting it closely. Use the Query tool to query individual
features and inspect the information in the Feature Information Window.
Try right-clicking in the different Data Inspector windows, to discover functionality that exists on context menus.

5) Open Data from Within Workbench
Back in FME Workbench, open the workspace from the previous exercise.
Click on any Reader or Writer feature type and a small pop-up menu has an option to 'Inspect'. This alternative method of opening
a dataset in the Data Inspector is very convenient when you are already using FME Workbench.

NEW
The pop-up Inspect option is new for FME2016. The prior method - that you can still use - is to right-click
a feature type and choose the 'Inspect' option.
Similarly, you can locate the output dataset by clicking the pop-up option to Open Containing Folder, and
can find the same function by right-clicking on a Reader or Writer feature type.

CONGRATULATIONS
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By completing this exercise you have learned how to:
Open datasets in a new view in the FME Data Inspector
Use the windowing and inspection tools in the FME Data Inspector
Use FME Workbench functionality to open a dataset in the FME Data Inspector
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Data Inspector Display Control
The FME Data Inspector has a number of controls to assist in showing the data in an orderly manner.

Display Control Window
Management of feature display order is carried out in the Display Control window.
Each dataset and feature type can be dragged above any other to promote its display order in the View window.

Feature Types can only be ordered within their container dataset.
For example, "Private" roads cannot be promoted above "Parks" in the display, without the entire Roads dataset being promoted
above Parks.

Display Status
Each level of the Display Control window has a checkbox to turn data on and off at that level.

You can choose to turn off individual layers or an entire dataset at once.

Style
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Each feature type can be assigned a different color or style that applies to its geometries. To access this functionality click on the
style icon for that feature type in the Display Control window:

The Drawing Style dialog allows you to set the color of a feature and its degree of transparency. The exact settings available
depend upon the type of geometry being set; for example a polygon feature will have settings for both fill and border:

Each Feature Type in the Display Control window is tagged with the number of features it contains, in parentheses after the
feature type name.
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Thus we can see that there are 957 arterial road links in the city of Vancouver.

.1 UPDATE
FME2016.1 introduces a number of styling improvements for the Data Inspector.
All style dialogs have been revised and updated with a new look and feel.
New options include the ability to resize point features and even replace them with a specific icon
Raster datasets - including the background map - can have an opacity set to make them semi-transparent.
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Miscellaneous Data Inspector Functionality
The FME Data Inspector has a number of miscellaneous functions that help users navigate through data, investigate data, and even
translate data to a different format!

Shift and Ctrl Key Functions
Press the Shift key on the keyboard and it will activate the zoom-in tool in the Inspector.
Press the Ctrl key and it will activate the zoom-out tool. Release the key to revert to the previous tool.
This functionality allows users to quickly move between query and navigation modes at the press of a key, so there’s no need to
click between query and navigation tools on the menubar or toolbar.

Save Tools
The FME Data Inspector save tool lets you save whatever data is currently being displayed in the view window. The data can be
saved in any FME-supported format of your choice.
Simply select File > Save Data As to open the prompt for saving data.
File > Save Selected Data As saves only the data that is currently selected in the view or table view windows.

Data Filtering
Data in the View window can be filtered by a set of user-defined criteria to show only the features that are required at the time.
This functionality is activated by Tools > Filter Features on the menubar.
The Filter Features dialog allows a whole series of test clauses to be set up, using a number of operators to test the values of
source data attributes. For example, here the user is filtering (keeping displayed) all features that are located in the neighborhood
of Kitsilano.
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Exercise 3

The FME Data Inspector

Data

Parks (MapInfo TAB)
Fire Halls (GML - Geographic Markup Language)
Neighborhoods (Google KML)

Overall Goal

Examine city data to select a suitable neighborhood to live in

Demonstrates

Viewing, symbolizing, and querying data with the FME Data Inspector

Start Workspace

None

End Workspace

None

The mayor of the city drops in to welcome you in your new job as technical analyst. He is fascinated by what FME can do and
asks you to to inspect some data, to help pick a neighborhood for him to buy a new house in! As a GIS professional we wouldn't
normally do spatial analysis in this way, but the mayor is unlikely to know that and anyway it's good practice with the FME Data
Inspector.

1) Start FME Data Inspector
Start the FME Data Inspector

2) Set Background
When inspecting data it will help to have a background map to provide a sense of location. The FME Data Inspector is capable of
displaying a backdrop from several different mapping services.
Select Tools > FME Options from the menubar. In the Background Map section, select a background map format of MapQuest
Web Map Tile Service:

Click the Parameters button. A map constraint (type) dialog will open. Select OpenStreetMap.

Click OK and OK again to close these dialogs.
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3) Add Data
Now let's add some data. Select File > Open Dataset from the menubar. Set the reader parameters as follows:
Reader Format

Google KML

Reader Dataset

C:\FMEData2016\Data\Boundaries\VancouverNeighborhoods.kml

Click OK to close the dialog and add the data.

4) Set Data Symbology
The data is added to the Data Inspector, but it is a solid-filled color and therefore obscures the background data.

Tiles Courtesy of MapQuest

We can fix this by setting the symbology. Click the symbology icon for the Neighborhoods data in the Display Control window:
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In the style dialog that opens, select a suitable color for the neighborhoods (say, orange). Then set the Transparency/Opacity scale
to be somewhat less than half (i.e. more transparent than opaque).

.1 UPDATE
The above dialog will look like this in FME2016.1:
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Click OK to accept the parameters and close the dialog. The background map will now be visible through the neighborhood data.

5) Add More Data
The mayor has a pet dog and therefore wishes to live in an area that has a dog park. We must therefore add some parks data to the
view.
Select File > Add Dataset from the menubar. Set the reader parameters as follows:
Reader Format

MapInfo TAB (MITAB)

Reader Dataset

C:\FMEData2016\Data\Parks\Parks.tab

Click OK to close the dialog and add the data.

6) Filter Data
The parks data is opaque too (you may optionally change this to be more transparent) but more importantly we cannot tell which
parks are dog parks.
Click on the tab marked Parks in the Table View window.
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Notice that there are many parks in the city, but that there is also a DogPark attribute to tell us which parks have a dog run area.
Click on the DogPark name to sort the table data by that attribute.
Now we know which are dog parks, clicking on a feature will highlight it on the display window. However, it would be easier to
find dog parks if we could filter the data. Therefore choose Tools > Filter Features from the menubar.
In the Filter Features dialog, double click in the Left Value field, click the drop down arrow, and select Attribute Value. Choose
DogPark as the attribute to filter by and click OK.
For the Operator field select the = (equals) symbol, if it is not already selected.
For the Right Value field, click in the field and type the character Y (it should be upper case, not lower).

Filtering in the Data Inspector is applied to all visible data, therefore we must also add a clause to enable the neighborhood data to
remain on screen.
Create a second test clause using the same techniques as before. This time test for where NeighborhoodID > (is greater than) 0
(zero)
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The Pass Criteria parameter should be set (or left as) "One Test (OR)."

Now click OK to close the dialog. The display will be filtered to show only the neighborhood features plus parks with a dog run
facility.

Tiles Courtesy of MapQuest

7) Add Data
The mayor's dog really is his best friend, and the mayor refuses to live in an area where there are no rescue services, just in case
he gets lost chasing a cat! So let's add some emergency facilities data.
Select File > Add Dataset from the menubar. Set the reader parameters as follows:
Reader Format

GML (Geography Markup Language)

Reader Dataset

C:\FMEData2016\Data\Emergency\FireHalls.gml

Click OK to close the dialog and add the data.
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8) Filter Data
Initially no data will appear on screen because we already have a filter set that will exclude it.
So, again select Tools > Filter Features from the menubar. This time set up a test to filter where Rescue = Y (i.e. Fire Halls which
are also a rescue facility).

At this point you should be able to suggest to the mayor a neighborhood that has both a dog park and an emergency rescue facility.
Click on the neighborhood feature to find out which it is.

CONGRATULATIONS
By completing this exercise you have learned how to:
Set a background map for the FME Data Inspector
Add datasets to an existing view in the FME Data Inspector
Set symbology for features in the FME Data Inspector
Query and sort data in the Data Inspector Table View window
Filter data using test clauses in the FME Data Inspector
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Translation Previews
A key ability of FME is communication of data between Workbench and the FME Data Inspector.

Redirect to FME Data Inspector
In some cases it’s desirable to inspect output data, but undesirable to actually have to write the data to do so. In other words, you
want to preview what the output of a translation will be.
For example, it would be useful to preview the results of a workspace that updates a spatial database. That way mistakes can be
detected before writing to the database.
The Workbench tool to do this is the menu option Writers > Redirect to FME Data Inspector:

When this setting is applied, the output from a translation is redirected away from the specified output and sent directly to FME
Data Inspector instead.
This setting is a toggle, which means that each subsequent selection alternately turns the setting on and off.

WARNING
An embarrassing problem occurs when a user forgets to deactivate the setting and does not understand
why no output datasets are being written. To help combat this issue, the FME Log window includes a
distinctive warning message when data is being redirected.

Notice how the redirection message in the FME Log window reports that zero features have been written
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to the output datasets.

66

Module Review

Module Review
This module introduced you to FME and investigated the basics of FME data translations.

What You Should Have Learned from this Module
The following are key points to be learned from this session:

Theory
FME is a tool to translate and transform spatial data. Quick Translation is the technique of carrying out a translation with
minimum user intervention. The semantic nature of FME is the means by which this is permitted.
FME Workbench is an application to graphically define a translation and the flow of data within it. This definition is known
as a workspace and can be saved to a file for later use.
The Generate Workspace dialog is the main method by which a Quick Translation can be set up in FME Workbench.
Data Inspection is a technique for checking and verifying data before, during, and after a translation. The FME Data
Inspector is a tool for inspecting data. Multiple datasets – including data from different formats – can be opened within the
same view window.

FME Skills
The ability to start FME Workbench, set up a Quick Translation, and run it
The ability to start the FME Data Inspector, open a dataset in a new view, and add a dataset to an existing view
The ability to navigate a dataset and to query features within it
The ability to control minor FME Data Inspector functionality for debugging data and translations
The ability to inspect data by redirecting it from FME Workbench to the FME Data Inspector

Further Reading
For further reading why not browse articles tagged with Data Inspector on our blog?
Or if you are an experienced FME user taking training to get up to speed with FME 2016, check out Seven Things to Get Excited
About for FME2016 and Seven More Things to Get Excited About for FME2016!
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Questions
Here are the answers to the questions in this chapter.

Miss Vector says...
ETL is an acronym for...?
1. Extra-Terrestrial Lifeform
2. Extract, Transform, Load
3. Express Toll Lane
4. Eat, Transform, Love

Miss Vector says...
FME can seamlessly translate between so many formats because it has...
1. A sentient data dictionary
2. A retro-encabulator
3. A rich data model
4. A core of unicorn hairs

Miss Vector says...
Which of the following applications is NOT a part of FME Desktop?
1. FME Workbench
2. FME Integration Console
3. FME Server Console
4. FME Data Inspector

Miss Vector says...
FME Workbench allows you to define flows of data in which way...
1. Graphically
2. Telepathically
3. Problematically
4. By writing lots of code in C++ or Java

Miss Vector says...
Which of these is a window in FME Workbench?
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1. The Maths Window
2. The Geography Window
3. The English Literature Window
4. The History Window

Miss Vector says...
Which of these is NOT an arrangement of Windows in FME Workbench?
1. Stacked
2. Floating
3. Double-Glazed
4. Tabbed

Miss Vector says...
Q) In the Generate Workspace dialog, why might it be useful to set the data format before browsing for the
source data?
A) Because then the explorer dialog only displays files whose extension matches the format type

Miss Vector says...
Which of these is NOT a way to set the format of a translation?
1. Typing the format name
2. Selecting the format from a drop-down list
3. Browsing for the format in the formats gallery
4. By selecting a dataset with a known file extension
5. None of the above (they are all valid ways to set the format)

Miss Vector says...
Which key is a shortcut to run a workspace?
1. F4
2. F5
3. F5.6
4. F#

Miss Vector says...
When you are inspecting *schema*, what are you trying to verify?
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1. The color and linestyle of features
2. The number of features
3. The layers (classes, tables, types)
4. Where the nearest coffee shop is

Miss Vector says...
Open a dataset and right-click on records and column-headers in the Table View window. Which of the
following is NOT an available option(s):
1. Sort (Alphabetical or Numeric)
2. Inspect Value
3. Cut/Copy/Paste
4. Save Selected Data As
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Exercise 4

Tourist Bureau Project

Data

Community Mapping/Food Vendors (Esri Geodatabase)

Overall Goal

Create a GPS-compatible dataset of food vendors for the local tourist bureau

Demonstrates

Basic Data Translation and Data Inspection

Start Workspace

None

End Workspace

C:\FMEData2016\Workspaces\DesktopBasic\Basics-Ex4-Complete.fmw

You've barely started in your new job, but requests are coming in fast!
The local tourist bureau is running a promotion where they provide tourists with a GPS device to help them visit street food
vendors in the city. Your manager wonders whether you can use FME to produce the data to be used in this scheme.
Let's get onto that right away shall we?!

1) Start FME Workbench
Start FME Workbench. In the Create Workspace section of the Start window, choose the option to Generate (Workspace). When
prompted generate a translation with the following parameters:
Reader Format

Esri Geodatabase (File Geodb API)

Reader Dataset

C:\FMEData2016\Data\CommunityMapping\CommunityMap.gdb

Writer Format

GPS eXchange Format (GPX)

Writer Dataset

C:\FMEData2016\Output\Training\FoodVendors.gpx

Click OK to accept the parameters. When prompted which tables to use from the source data (there are several) deselect all tables
except for FoodVendors and click OK to create the workspace.
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2) Connect Reader/Writer
When first created, the Reader and Writer are not connected in this workspace. Connect them by dragging a connection from the
output port of the Reader to the input port of the Writer object labelled WayPoint:

Click the expand buttons on the two objects to expose the list of attributes on each:

Now drag a connection between the Reader attribute VendorName and the Writer attribute name. Repeat the process for
VendorDescription and description:
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The technique of connecting objects like this is called Schema Mapping, and we shall learn more about it later.

3) Run Workspace
Save the workspace so you have a copy of it, then run the workspace by pressing the green play button. The workspace will run
and the data written to a Garmin POI dataset.

4) Inspect Data
Go to the FME Data Inspector. Select File > Open Dataset from the menubar. This opens the dialog titled "Select Dataset to
View".
Set the format type and select the GPX dataset. However, the GPX format does not record its coordinate system inside the dataset,
so to include a background map you must also set the coordinate system (LL83) in this dialog.
NB: Because of the coordinate system limitation for this format, you can't use the Inspect options inside Workbench. That's
because the data will be passed directly to the Data Inspector without the option to set the coordinate system. You have to open it
manually as above.
Click OK and the dataset will be opened for you to verify that it is correct.

5) Filter Data
All this talk of food is making you hungry. It must be lunchtime. To find somewhere to get a quick lunch filter the data to show
hot dog vendors in the city.
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CONGRATULATIONS
By completing this exercise you proved you know how to:
Create and run a workspace in FME Workbench
Carry out basic 'schema mapping' in FME Workbench
Use FME Workbench functionality to open a dataset in the FME Data Inspector
Filter data using test clauses in the FME Data Inspector
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Data Transformation
Data Transformation is the ability to manipulate data during Format Translation – even to the extent of having an output greater
than the sum of the inputs!
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What is Data Transformation?
Data Transformation is FME's ability to manipulate data.
The transformation step occurs during the process of format translation. Data is read, transformed, and then written to the new
format.

Data Transformation Types
Data transformation can be subdivided into two distinct types: Structural Transformation and Content Transformation.

Structural Transformation
Structural transformation is perhaps better called ‘reorganization'. It refers to FME's ability to channel data from source to
destination in an almost infinite number of arrangements.
This includes the ability to merge data (as in the image above), divide data, re-order data, and define custom data structures.
Transforming the structure of a dataset is carried out by manipulating its schema.

Content Transformation
Content transformation is perhaps better called ‘revision'. It refers to the ability to alter the substance of a dataset.
Manipulating a feature's geometry or attribute values is the best example of how FME can transform content.
Content transformation can take place independently or alongside structural transformation.

Mr Flibble says...
Mr. Flibble - certified FME jester - here to entertain you. Here's a riddle, but can you solve it?
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The most common format translation defined with FME is from Esri Shapefile to which format?
1. Esri Geodatabase
2. AutoCAD DXF/DWG
3. Google KML
4. Esri Shapefile
If you're in a class, have a group vote!
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Structural Transformation
Transforming a dataset’s structure requires knowledge of schemas and how to use FME to manipulate them.

Schema Concepts
A schema is the structure of a dataset or, more accurately, a formal definition of a dataset’s structure. FME uses the term ‘schema’,
but you may know this as 'data model'.
Each dataset has its own unique schema; it includes layers, geometries, attributes, and other rules that define or restrict its content.

Schema Representation
When a new workspace is created, FME scans the source datasets and creates a visual representation of its schema on the left side
of the workspace canvas.
On the right side of the canvas, FME creates a representation of how this schema will be duplicated in the chosen destination
format.
The workspace therefore reads from left to right.

Feature Type Schemas
A schema is not just represented as a set of layers on the Workbench canvas; for example, each different layer in a dataset can
have a different structure.
This part of the schema is revealed by clicking the cog-wheel icon on the canvas object representing that layer.
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This opens the Feature Type Properties dialog. This dialog represents schema under a number of tabbed tables.
Under the General tab there is the name of the feature type, in this case PostalAddress.
Allowed geometry types and the name of the parent dataset for the feature types are shown as well.

The User Attributes tab shows a list of attributes. Each attribute is defined by its name, data type, width, and number of decimal
places.
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Writer Schema
All of the above information goes to make up the Reader schema. It is literally "what we have".
There is also a schema for each Writer in FME. You can find it by opening the properties dialog for a Writer feature type:

By default, the Writer schema ("what we want") is a mirror image of the source, so the output from the translation will be a
duplicate of the input. This allows users to translate from format to format without further edits (Quick Translation).
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If 'what we want' is different to the default schema in FME, we simply have to change it using Schema Editing.

TIP
FME supports 300+ formats and there are almost as many terms for the way data is subdivided. The most
common terms are layer, table, class, category, level, or object.
As noted, the general FME term for these subdivisions is Feature Type, and that is what is used
throughout the manual.
Be aware though, that all dialogs in FME Workbench use format-specific terminology. So, screenshots in
the manual may display different terms depending on what format of data is being used!
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Schema Editing
Schema Editing is the process of altering the Writer schema to customize the structure of the output data. One good example is
renaming an attribute field.
After editing, the source schema still represents "what we have", but the destination schema now truly does represent "what we
want".

Editable Components
There are a number of edits that can be performed, including, but not limited to the following.

Attribute Renaming
Attributes on the destination schema can be renamed, such as renaming POSTALCODE to PSTLCODE.
To rename an attribute open the Feature Type Properties dialog and click the User Attributes tab. Click the attribute to be renamed
and enter the new name.

Attribute Type Changes
Any attribute on the writer schema can have a change of type; for example, changing STATUS from a character field to a number
field.
To change an attribute type open the Feature Type Properties dialog and click the User Attributes tab. Use the Data Type field to
change the type of an attribute.
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TIP
The Data Type column for an attribute shows only values that match the permitted types for that data
format. For example, an Oracle schema permits attribute types of varchar or clob. MapInfo does not
support these data types so they would never appear in a MapInfo schema.

Feature Type Renaming
To rename a destination feature type (for example, rename PostalAddress to Addresses) open the Feature Type Properties dialog.
Click the General tab. Click in the Feature Type Name field and edit the name as required.
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You can also rename a feature type by clicking on it in the Workbench canvas and pressing the F2 key.

Geometry Type Changes
To change the permitted geometry for a feature type, (for example, change the permitted geometries from lines to points) open the
Feature Type Properties dialog. Click the General tab. Choose from the list of permitted geometries.
This field is only available where the format requires a decision on geometry type. Where formats allow any mix of geometry type
in a single feature type, this setting is greyed out.

Once the user has made all the required changes to the Writer schema, the workspace reflects "what we want" - but it doesn't yet
specify how the Reader and Writer schemas should be connected together. This is the next task and it is called Schema Mapping.

TIP
You might be wondering "what would happen if I edited the Reader schema, instead of the Writer"?
Well, by default, you can't! The schema fields for a Reader are greyed out to stop you, since they would no
longer match the Reader dataset.
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There are a few, rare, use cases - but they're outside the scope of this training course!
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Schema Mapping
Schema Mapping is the second key part towards data restructuring in FME.
In FME Workbench, one side of the workspace shows the source schema ("what we have") and the other side shows the
destination schema ("what we want"). Initially the two schemas are automatically joined when the workspace is created, but when
edits occur then these connections are usually lost.
Schema Mapping is the process of connecting the source schema to the destination schema in a way that ensures the correct
Reader features are sent to the correct Writer feature types and the correct Reader attributes are sent to the correct Writer
attributes.
In FME, it is permitted to do this mapping in any way that is desired.

Ms. Analyst says...
Hi. I'm Ms. Analyst, one of your colleagues at the city. I think of Schema Editing and Mapping as a means
of reorganizing data.
A good analogy is a wardrobe full of clothes. When the wardrobe is reorganized you throw out what you
no longer need, reserve space for new stuff that you’re planning to get, and move existing items into a
more usable arrangement.
The same holds true for spatial data restructuring: it's the act of reorganizing data to make it more usable.
In Workbench’s intuitive interface, the most common way to make feature type and attribute connections is
by dragging connecting lines between these parts of the schema.

Feature Mapping
Feature mapping is the process of connecting source feature types to destination feature types.
Feature Mapping is carried out by clicking the output port of a source feature type, dragging the arrowhead across to the input port
of a destination feature type, and releasing the mouse button.
Here, a connecting line from source to destination feature type is created by dragging the arrowhead from the source to the
destination.
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Merging and splitting of data is permitted. Here, a user wishes to create a single layer called Transportation and so is merging two
input feature types (Roads and Rail) into one output feature type (Transportation).

Attribute Mapping
Attribute Mapping is the process of connecting Reader attributes to Writer attributes.
Attribute Mapping is performed by clicking the output port of a Reader attribute, dragging the arrowhead to the input port of a
Writer attribute, and releasing the mouse button.
Here feature mapping has been carried out already and attribute connections are being made.
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Notice the green, yellow, and red color-coding that indicates which attributes are connected.
Green ports indicate a connected attribute. Yellow ports indicate a Reader attribute that’s unconnected to a Writer. Red ports
indicate a Writer attribute that’s unconnected to by a Reader.
Feature mapping connections (or links) are shown with a thick, black arrow.
Attribute mapping connections are shown with a thinner, gray arrow.

Attributes with the same name in Reader and Writer are connected automatically, even though a connecting line might not be
visible; the port color is the key.

WARNING
Names are case-sensitive, therefore ROADS is not the same as roads, Roads, or rOADS.
That's important to know if you are relying on automatic attribute connections!
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Exercise 1

Grounds Maintenance Project - Schema Editing

Data

City Parks (MapInfo TAB)

Overall Goal

Calculate the size and average size of each park in the city, to use in Grounds Maintenance
estimates for grass cutting, hedge trimming, etc.

Demonstrates

Structural Transformation, Schema Editing

Start Workspace

None

End Workspace

C:\FMEData2016\Workspaces\DesktopBasic\Transformation-Ex1-Complete.fmw

You have just landed a job as technical analyst in the GIS department of your local city.
The team responsible for maintaining parks and other grassed areas needs to know the area and facilities of each park in order to
plan their budget for the upcoming year. You have been assigned to this project and will use FME to provide a dataset of this
information.
The first step in this example is to rename existing attributes and create new ones in preparation for the later area calculations.

1) Start Workbench
Use the Generate Workspace dialog to create a workspace using these parameters:
Reader Format

MapInfo TAB (MITAB)

Reader Dataset

C:\FMEData2016\Data\Parks\Parks.tab

Writer Format

MapInfo TAB (MITAB)

Writer Dataset

C:\FMEData2016\Output\Training

Yes! Here we write back to the same format of data we are reading from!

2) Update Attributes
FME creates a workspace where the destination schema matches the source. However, the end user of the data has requested the
attributes get cleaned up so that unnecessary information is removed. Also others need to be renamed and some extra ones added
to store the calculation results.
Open the Feature Type Properties dialog for the writer feature type by clicking the Properties button. Click the User Attributes tab
to open a list of the destination attributes. It will look like this:
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In turn, carry out the following actions:
Delete Attribute

RefParkID

Delete Attribute

EWStreet

Delete Attribute

NSStreet

Delete Attribute

DogPark

Delete Attribute

Washrooms

Delete Attribute

SpecialFeatures

Rename Attribute

from: NeighborhoodName

to: Neighborhood

Add Attribute

ParkArea

type: Float

Add Attribute

AverageParkArea

type: Float

After these edits the attribute list should look like this:

3) Rename Feature Type
Now click back on the General tab.
Click in the field labelled Table Name (remember this label is format-specific and in MapInfo we deal with "tables") and change
the name from Parks to ParksMaintenanceData.

Click OK to accept these changes.
Now when the workspace is run the output will be named ParksMaintenanceData.tab
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4) Un-Expose Source Attributes
The workspace will now look like this:

Notice there are several source attributes that are not going to be used in the workspace or sent to the output. We can tidy the
workspace by hiding these.
Open the Feature Type Properties dialog for the Reader feature type by clicking the Properties button. Click the User Attributes
tab to open a list of the source attributes. It will look like this:

Uncheck the check box for the following attributes, which we do not need:
RefParkID
EWStreet
NSStreet
Washrooms
SpecialFeatures
This is basically the list of attributes we deleted, except for DogParks, which we will make use of in the translation.
Click OK to close the dialog.

5) Save the Workspace
Save the workspace – it will be completed in further examples. It should now look like this:
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Police Chief Webb-Mapp says...
Some Writer attributes (ParkArea and AverageParkArea) have red connection arrows because there is
nothing yet to map to them, while another (Neighborhood) is just unconnected.
That's OK. I'll let you off with a caution if you promise to connect them later. And you can still run this
workspace just to see what the output looks like anyway.

CONGRATULATIONS
By completing this exercise you have learned how to:
Edit the attributes on a Writer schema
Edit the output layer name on a Writer schema
Hide attributes on a Reader schema
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Transformation with Transformers
Besides Schema Editing and Schema Mapping, transformation can be carried out using objects called transformers.

What is a Transformer?
As the name suggests, a transformer is an FME Workbench object that carries out transformation of features. There are lots of
FME transformers, each of which carry out many different operations.
Transformers are connected somewhere between the Reader and Writer feature types, so that data flows from the Reader, through
a transformation process, and on to the Writer.
Transformers usually appear in the canvas window as rectangular, light-blue objects.

Transformer Parameters
Each transformer may have a number of parameters (settings). Access the parameters by clicking the parameter button at the top
right of each transformer.

Color-Coded Parameter Buttons
The parameter button on a transformer is color-coded to reflect the status of the settings.
A blue parameter button indicates that the transformer parameters have been checked and amended as required, and that the
transformer is ready to use.

A yellow parameter button indicates that the default parameters have not yet been checked. The transformer can be used in this
state, but the results may be unpredictable.

A red parameter button indicates that there is at least one parameter for which FME cannot supply a default value. The parameter
must be provided with a value before the transformer can be used.
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First-Officer Transformer says...
Good morning everyone, I'm First Officer Transformer and I'd like to welcome you aboard today's
training.
Please be sure to check your parameters before your try to take off. Your workspaces just won't fly if there
are any red-flagged transformers in them!

Transformer Ports
Far from having just a single input and/or output, a transformer can have multiple input ports, multiple output ports, or both.
This 2DForcer transformer has a single input and output port.

This Clipper has multiple input and output ports. Notice that not all of them are – or need to be – connected.

This Inspector has just a single input port...

…whereas this Creator has only a single output port!

Transformer Attributes
Click on the drop-down arrow of a transformer output port to see all of the attributes that exit the transformer. This includes all
changes applied within the transformer.
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This is a good way to visualize which attributes have been created or lost within the transformer.
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Exercise 2

Grounds Maintenance Project - Structural Transformation

Data

City Parks (MapInfo TAB)

Overall Goal

Calculate the size and average size of each park in the city, to use in Grounds Maintenance
estimates for grass cutting, hedge trimming, etc.

Demonstrates

Structural Transformation with Transformers

Start Workspace

C:\FMEData2016\Workspaces\DesktopBasic\Transformation-Ex2-Begin.fmw

End Workspace

C:\FMEData2016\Workspaces\DesktopBasic\Transformation-Ex2-Complete.fmw
C:\FMEData2016\Workspaces\DesktopBasic\Transformation-Ex2-CompleteAdvanced.fmw

Let's continue your work on the grounds maintenance project.
In case you forgot, the team responsible for maintaining parks and other grassed areas needs to know the area and facilities of
each park in order to plan their budget for the upcoming year.
In this part of the project we’ll filter out dog parks from the source data (as these have a different scale of maintenance costs) and
write them to the log window. We'll also handle the renamed attribute NeighborhoodName.

1) Start FME Workbench
Start FME Workbench and open the workspace from the previous exercise. Alternatively you can open
C:\FMEData2016\Workspaces\DesktopBasic\Transformation-Ex2-Complete.fmw.

2) Add Transformer
Let's first handle the source attribute NeighborhoodName, which was renamed Neighborhood on the writer but not yet connected.
We could do this by simply drawing a connection, but it's generally better to use a transformer. There are two transformers we
could use. One is called the AttributeRenamer and the other - which we shall use here - is the AttributeManager.

NEW
The AttributeManager transformer is new for FME2016

Therefore click on the feature connection from Reader to Writer feature type:

Start to type the phrase "AttributeManager". This is how we can place a transformer in the workspace. As you type, FME searches
for a matching transformer. When the list is short enough for you to see the AttributeManager, select it from the dialog:
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This will place an AttributeRenamer transformer like so:

Notice that the parameters button is colored yellow, meaning we could run the translation without checking the parameters - but
that would be pointless because we want to set it up to rename an attribute.

TIP
For a great tip on adding transformers to a workspace, see #5 in our list of The Top Ten FME Tips of All
Time!

3) Set Parameters
Click the parameters button on the AttributeManager transformer to open the parameters dialog. It will look like this:

Notice that all of the attributes on the stream in which it is connected will automatically appear in the dialog.
Where the Input Attribute field is set to NeighborhoodName, click in the Output Attribute field. Click on the button for the dropdown list and in there choose Neighborhood as the new attribute name to use.
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Most importantly, check that the Action field is set to Rename.

TIP
Neighborhood only appears in the list because it already exists on the Writer schema. If we had done this
step before editing the Writer schema, we would have had to manually enter the new attribute name in this
dialog.

Click OK to close the dialog. Now in the Workbench canvas window you will see the Neighborhood attribute is flagged with a
green arrow, to confirm that a value is being provided to that attribute.

4) Add Transformer
Now we should remove dog parks from the data, because these have their own set of costs.
This can be done with a Tester transformer. Click on the connection from the AttributeManager output port to the
ParksMaintenanceData feature type on the Writer.
Start typing the word Tester. When you spot the Tester transformer click on it to add one to the workspace. After tidying up the
layout of the canvas, the workspace will now look like this:

Notice that the Passed output port is the one connected by default.
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5) Set Parameters
Click the parameters button on the Tester transformer to open the parameters dialog. Double click in the Left Value field and from
there click the down arrow and choose Attribute Value > DogPark.

For the Right Value click into the field and type the value N. The operator field should be filled in automatically as the equals sign
(=), which is what we want in this case.

Click OK to accept the values and close the dialog.

6) Add Transformer
We are now filtering out dog parks from our data, using a test on an attribute value. The question is, what should we do with this
data we have filtered out. There are many things we could do, but for now we'll simply log the information to the FME log
window.
To do this, right-click on the Tester Failed port and choose the option Connect Logger:

A Logger transformer will be added to the workspace. This will record all incoming features to the log window:
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Loggers inserted by this method are named after – and reported in the log with – the output port they are connected to, here
Tester_Failed.

7) Run Workspace
Save and run the workspace. It is not yet complete but running it will prove that everything is working correctly up to this point.

Advanced Exercise
As an advanced task, if you have time, filter the data further to remove parks that do not have a name; i.e.
their name attribute is missing or empty. Would you need to place a second Tester transformer, or could
you incorporate the test into the existing one?

CONGRATULATIONS
By completing this exercise you have learned how to:
Add transformers to a workspace
Carry out schema mapping with the AttributeManager transformer
Filter data using the Tester transformer
Record data using the Logger transformer
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Content Transformation
Content transformations are those that operate on the geometry or attribute content of a dataset.

What is a Feature?
A feature in FME is an individual item within the translation. It is the fundamental (that is, smallest) unit of FME data.
Typically a GIS or cartographic feature consists of a geometric representation plus a set of related attributes. FME is capable of
restructuring either of these components.

Sometimes content transformation operates on single features, sometimes on multiple features at once.
Features in FME have a flexible, generic representation that is unrelated to the format from which they originated. That means any
transformer can operate on any FME feature, regardless of its source format.

Ms. Analyst says...
You can think of Content Transformation as altering or editing data.
The wardrobe analogy still works here. You might take your clothes from the wardrobe to clean them, or
alter them, or repair them, or dye them a new color, or all sorts of other tasks, before returning them to
their place.
The same holds true for spatial data transformation: it's the act of fixing up your data to be cleaner and in
the style you really want

Geometric Transformation
Geometric Transformation is the act of restructuring the spatial component of an FME feature. In other words, the physical
geometry of the feature undergoes some form of change to produce a different output.
Some examples of geometric transformation include the following:
Generalization – a cartographic process that restructures data so it's easily visualized at a given map scale.
Warping – adjustment of the size and shape of a set of features to more closely match a set of reference data.
Topology Computation – conversion of a set of linear features into a node/line structure.
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Line Intersection is another example of geometric transformation.
Here roads have been intersected with rivers to produce points that mark the location of bridges.

Attribute Transformation
Attribute Transformation is the act of restructuring the non-spatial component of an FME feature. In other words, the attributes
relating to the physical geometry undergo some form of change to produce a different output.
Some examples of attribute transformation are:
Concatenation – joining together of two or more attributes
Splitting – splitting one attribute into many, which is the opposite of Concatenation
Measurement – measuring a feature's length or area to create a new attribute
ID Creation – creating a unique ID number for a particular feature
Attribute concatenation as an example of attribute transformation.
Each line of the address is concatenated to return a single line address.
Address1
Address2
City
Province
PostalCode
= Address

Suite 2017,+
7445-132nd Street,+
Surrey,+
British Columbia,+
V3W 1J8
Suite 2017, 7445-132nd Street,Surrey, British Columbia, V3W 1J8

Miss Vector says...
Did you miss me? You did? Well I'll cure that with some new questions for you!
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Which three colours represent checked, need checking, and unset parameters on transformer objects?
1. blue, yellow, red
2. green, yellow, red
3. red, green, blue
4. green, blue, yellow
If I use a transformer to remove irregularities (like self-intersecting loops) in the boundary of a polygon,
what type of transformation is it?
1. Structural Transformation of attributes
2. Structural Transformation of geometry
3. Content Transformation of attributes
4. Content Transformation of geometry
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Transformers used in Series
Much like a set of components in an electrical circuit, a series of Workbench Transformers can be connected together to have a
cumulative effect on a set of data.

Chaining Transformers
Even with the large number of transformers available in FME, users frequently need a combination or chain of transformers
instead of a single one.
A string of transformers that graphically represent an overall workflow is a key concept of FME.
In this example, a DuplicateFilter transformer removes duplicate polygon features. A Dissolver transformer merges each
remaining (unique) polygon with its neighbor where there is a common boundary. Finally each merged area gains an ID number
from the Counter transformer.

.1 UPDATE
The Counter transformer in the above screenshot gained its <Rejected> port in FME2016.1

104

Exercise: Grounds Maintenance Project - Calculating Statistics

Exercise 3

Grounds Maintenance Project - Calculating Statistics

Data

City Parks (MapInfo TAB)

Overall Goal

Calculate the size and average size of each park in the city, to use in Grounds Maintenance
estimates for grass cutting, hedge trimming, etc.

Demonstrates

Content Transformation. Schema Mapping

Start Workspace

C:\FMEData2016\Workspaces\DesktopBasic\Transformation-Ex3-Begin.fmw

End Workspace

C:\FMEData2016\Workspaces\DesktopBasic\Transformation-Ex3-Complete.fmw
C:\FMEData2016\Workspaces\DesktopBasic\Transformation-Ex3-CompleteAdvanced.fmw

Let's continue your work on the grounds maintenance project.
In case you forgot, the team responsible for maintaining parks and other grassed areas needs to know the area and facilities of
each park in order to plan their budget for the upcoming year.
In this part of the project we’ll calculate the size and average size of each park, and ensure that information is correctly mapped to
the destination schema.

1) Start Workbench
Start Workbench (if necessary) and open the workspace from Exercise 2. Alternatively you can open
C:\FMEData2016\Workspaces\DesktopBasic\Transformation-Ex3-Begin.fmw

2) Add an AreaCalculator Transformer
To measure the area of each park feature, an AreaCalculator transformer must be used.
“Calculator” is the term for when FME computes new attribute values.
Click onto the connection between Tester Passed port and the Writer feature type Parks. Start typing the letters “areac”. You will
see the Quick Add list of matching transformers appear beneath.
Select the transformer named AreaCalculator

3) Add a StatisticsCalculator Transformer
Using the same method, place a StatisticsCalculator transformer between the AreaCalculator:Outputport and the
ParksMaintenanceData feature type.
BUT! Do not click anything else yet! The transformer will now look like this:
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By default the Summary port has been connected, and we need the Complete port connected instead. But notice the little pop-up
icons over the top. Click the right-hand icon (the one with the ? character). This pops up a further list of ports:

Click on the Summary port entry to disconnect that, and then on the Complete port entry to connect that:

TIP
These pop-up menus are a great help in schema mapping and other feature connections.

The latter part of the workspace now looks like this:

4) Check AreaCalculator Settings
A yellow icon indicates the AreaCalculator has parameters that need to be checked.
Open the AreaCalculator transformer Parameters dialog.

106

Exercise: Grounds Maintenance Project - Calculating Statistics

The default settings cause the calculated value to be placed into an attribute called _area. However, the ParksMaintenanceData
schema requires an attribute called ParkArea, so change this parameter to create the correct attribute.

Notice that the attribute on the Writer feature type is now flagged as connected.

5) Check StatisticsCalculator Settings
A red icon indicates the StatisticsCalculator has parameters that need to be defined.
Open the StatisticsCalculator transformer's Parameters dialog.
The attribute to analyze is the one containing the calculated area; so select ParkArea.
Examine what the default setting is for an attribute name for average (mean) park size. Currently it doesn't match the
ParksMaintenanceData schema, which requires an attribute named AverageParkArea.
Change the attribute from _mean to AverageParkArea. For Best Practice reasons, delete/unset any StatisticsCalculator output
attributes that aren't required (for example _range and _stdev).
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Finally, click OK to accept the changes.

6) Run the Workspace
Run the workspace.
Inspect the result of the translation using the FME Data Inspector.

Inspect the Table View window to discover the area of each park and the average area of all parks.
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7) Save the Workspace
Save the workspace – it will be completed in further examples.

Advanced Exercise
Notice that the numbers in the Table View show the results have been calculated to 12 decimal places.
This is in excess of the precision that you require. As an advanced task - if you have time - use the
AttributeRounder transformer to reduce the values to just 2 decimal places.

CONGRATULATIONS
By completing this exercise you have learned how to:
Carry out content transformation with transformers (AreaCalculator, StatisticsCalculator)
Manage transformer connections using pop-up buttons
Use transformer parameters to create attributes that match the Writer schema
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Feature Count Display
Look back at the previous example's translation. Did you notice that while the workspace was running, each connection was
updated with the number of features that had passed along it?

The final feature counts show that 80 features were read, 73 passed the Tester while 7 failed (for being dog parks) and went on to
the Logger.
The Log window confirms the number of features written and lists the features that failed the Tester.
This number helps analyze the results of a workspace and provides a reference for debugging if the destination data differs from
what was expected.

.1 UPDATE
The AreaCalculator transformer in the above screenshot gained a <Rejected> port in FME2016.1
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Transformers used in Parallel
FME Workbench permits multiple data streams, each of which passes through its own set of transformers.

Multiple Streams
A key concept in FME is the ability to have multiple processing streams within a workflow:

The user can combine these streams of data into one, or split one stream into several.

.1 UPDATE
The Bufferer and SpatialFilter transformers in the above screenshot gained <Rejected> ports in FME
2016.1

TIP
Similar terms to 'stream' that people use are 'flows,' 'pipes,' or 'pipelines.'

Creating Multiple Streams
Splitting data can occur in a number of ways. Sometimes a transformer with multiple output ports (a Tester transformer is a good
illustration of this) will divide data into several output streams.
Additionally, a full stream of data can be duplicated by simply making multiple connections out of a single output port. In effect it
creates a set of data for each connection.
Here, 50 road features are being read but, because there are multiple connections from the feature type, multiple copies of the data
are being created.
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Multiple streams are useful when a user needs to process the same data, but in a number of different ways.

Bringing Together Multiple Streams
When multiple streams are brought into the same input port no merging takes place. The data is simply accumulated into a single
stream. This is often called a "Union".
Here, three streams of 50 features each, converge upon a single AreaCalculator:

Notice how no merging has taken place; the data simply accumulates into 150 output features.
To carry out actual merging of data requires a specific transformer such as the FeatureMerger.

.1 UPDATE
The AreaCalculator transformer in the above screenshot gained a <Rejected> port in FME 2016.1
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Exercise 4

Grounds Maintenance Project - Labelling Features

Data

City Parks (MapInfo TAB)

Overall Goal

Calculate the size and average size of each park in the city, to use in Grounds Maintenance
estimates for grass cutting, hedge trimming, etc.

Demonstrates

Content transformation with parallel transformers

Start Workspace

C:\FMEData2016\Workspaces\DesktopBasic\Transformation-Ex4-Begin.fmw

End Workspace

C:\FMEData2016\Workspaces\DesktopBasic\Transformation-Ex4-Complete.fmw
C:\FMEData2016\Workspaces\DesktopBasic\Transformation-Ex4-CompleteAdvanced.fmw

Let's continue your work on the grounds maintenance project.
In this part of the project we’ll create a label for each park and write it to a new output layer. This is best done using a parallel
stream of data.

1) Start Workbench
Start Workbench (if necessary) and open the workspace from Exercise 3. Alternatively you can open
C:\FMEData2016\Workspaces\DesktopBasic\Transformation-Ex4-Begin.fmw
The previous exercise measured park areas with the AreaCalculator. Now we are asked to add this information as labels to the
output dataset.
This can be achieved using the LabelPointReplacer transformer.

2) Create New Writer Feature Type
Right-click the Writer feature type and choose the option Duplicate. This creates a new feature type (layer) in the output dataset.

Now clean up this feature type's schema. Open the Feature Type properties dialog. Rename the new type to ParkLabels. In the
User Attributes tab delete all of the existing user attributes.

3) Place a LabelPointReplacer Transformer
Click onto a blank area of canvas. Type "LabelPointReplacer" to add a transformer of this type.
Connect it to the Complete port of the StatisticsCalculator by dragging a second connection from there to the new transformer.
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Make a new connection from the LabelPointReplacer to the new feature type.

4) Check Transformer Parameters
Open the parameters dialog for the LabelPointReplacer transformer.
Click the browse button to the right of the label field to open an advanced text editor. We want the label to include the park name
and area, with a notation for the units too.
So, firstly double click ParkName in the list of attributes to the left:

Now press the Enter/Return key to insert a new line.
Next double-click the ParkArea attribute to add that.
Finally type " sq metres" after the ParkArea attribute (including a <space> character before the "sq" part):
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Click OK to close this dialog.
Now click in the Label Height field and type 25 (that’s 25 working units, which in this case is metres).
The “Always Rotate Label” parameter can be left to its default value.

TIP
Many parameter fields (like Label Height) can be set either as a constant value (by typing it in) or set to
an attribute by using “Set to Attribute Value.
If in doubt, a tooltip is often provided to point the way.

5) Run the Translation
Run the translation and inspect the output.
Notice that the output is in two layers in two files. Use the FME Data Inspector to open both output files in the same view.
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Tiles Courtesy of MapQuest

6) Save the Workspace
Save the workspace – it will be completed in further examples.

Advanced Exercise
Now you know how to create a new feature type (layer) in the output, how to test data, and how to use
parallel streams, why not try this task:
Identify which parks are smaller than average and which parks are larger than average, and write them
out to different feature types.

CONGRATULATIONS
By completing this exercise you have learned how to:
Create a new Writer feature type
Use multiple streams of transformers in a single workspace
Use FME's built-in string editor dialog
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Group-By Processing
Group-By parameters are an important tool for effective FME data transformations.

What is a Group?
FME transformers carry out transformations on either one feature at a time, or on a whole set of features at once.
For example, the AreaCalculator transformer operates on one feature at a time (to measure the area of that one polygon feature).
We call it a feature-based transformer.
The StatisticsCalculator operates on multiple features at a time (to calculate an average value for them all).
In FME we call this set of features a group, and the transformer is a group-based transformer.

Creating Groups
By default a group-based transformer treats ALL the features that it is fed as a single group.
However, such transformers also have a Group-By parameter. This parameter lets the user define several groups based upon the
value of an attribute.

Mr. Statistics-Calculator, CFO says...
Hi. I don't think we've met yet. I'm Mr. Statistics-Calculator. I bet you can't guess my favourite
transformer!
To illustrate groups let's consider calculating the mean age of FME users. Don't worry - I'll be discrete
(ha ha)! The default group for the calculation includes ALL FME users.
But you could instead divide everyone up on into men and women, creating two groups, and calculate
average age per gender. Or you could divide everyone into their nationality, and calculate average age
per country.
This is the same as having a gender (or nationality) attribute in a dataset and selecting that in an FME
group-by parameter.

Here, a LineOnLineOverlayer transformer is being used to intersect a number of line features.
The selected Group-By attribute is name.
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The result is a series of groups for overlaying where the features in each group share the same value for name.
The practical outcome is that intersection will only take place on line features with the same name.

Miss Vector says...
Let's see if you've picked up the idea of what a group-based transformation is.
Which of the following transformers do you think is "group-based"? Feel free to use Workbench to help
you answer this question.
1. StringFormatter
2. Clipper
3. Rotator
4. AttributeRounder
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Exercise 5

Grounds Maintenance Project - Neighborhood Averages

Data

City Parks (MapInfo TAB)

Overall Goal

Calculate the size and average size of each park in the city, to use in Grounds Maintenance
estimates for grass cutting, hedge trimming, etc.

Demonstrates

Group-By Processing

Start Workspace

C:\FMEData2016\Workspaces\DesktopBasic\Transformation-Ex5-Begin.fmw

End Workspace

C:\FMEData2016\Workspaces\DesktopBasic\Transformation-Ex5-Complete.fmw

Let's continue your work on the grounds maintenance project.
The parks team has decided that they do not want the average area of park for the city as a whole. Instead they want the average
size of park in each neighborhood; so let's do that for them.

1) Start Workbench
Start Workbench (if necessary) and open the workspace from Exercise 4. Alternatively you can open
C:\FMEData2016\Workspaces\DesktopBasic\Transformation-Ex5-Begin.fmw

2) Set Group-By in StatisticsCalculator
This is a really simple task to do. Open the parameters dialog for the StatisticsCalculator transformer.
Click the 'browse' button next to the Group By parameter.
Select the attribute called Neighborhood and click OK until all dialogs are closed.
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3) Run the Workspace
Save and then run the workspace.
Inspect the output data in the Table View window of the FME Data Inspector.
You should see that each neighborhood now has its own value for AverageParkArea:

CONGRATULATIONS
By completing this exercise you have learned how to:
Use the group-by parameter in FME transformers
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Data Inspection Using FME Workbench
Besides Redirect to FME Data Inspector, Workbench can route data to the FME Data Inspector from individual transformers.

Using an Inspector Transformer
An Inspector is a Workbench transformer – with its own distinctive look and style – that causes data entering it to be directed to
FME Data Inspector.
An Inspector transformer differs from the Redirect to FME Data Inspector setting because the transformer can be applied at any
point in a translation (not just at the very end) and does not prevent the data being output to the writer. It also lets a user be more
selective about which features should be inspected.
Here data is being directed to the Inspector after a CenterPointReplacer transformer, but before a KMLStyler.

Placing an Inspector Transformer
The best, and simplest way to apply an Inspector is to right-click the output port of an object in Workbench and select the Connect
Inspector option.
Here the user right-clicks the Output port of an AttributeManager and chooses the option Connect Inspector.

Notice that the Inspector is named automatically using the transformer and output port names. Here it will be
"AttributeManager_Output". This helps to identify the data from this Inspector (as opposed to any others) in the FME Data
Inspector.
Note that the Inspector transformer only opens the FME Data Inspector when there are features to view. If there are zero features,
then the Data Inspector will not open!
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TIP
Inspectors are not particularly useful when in a workspace intended to be run on FME Server. That's
because a Server engine doesn't have to capability to open a Data Inspector.
For that reason, authors of FME Server workspaces tend to use a Logger transformer instead of an
Inspector.

Mr. E. Dict, (Attorney of FME Law) says...
Pursuant to clause d30 (section 43) in your training course agreement, you are required to re-open the
workspace from the previous example and add Inspector transformers to selected objects to practice using
this functionality.
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Coordinate System Transformation
To be located in a particular space on the Earth's surface the majority of spatial data is related to a particular coordinate system.

Coordinate System Basics
Some users call this location of data a 'projection,' but projection is just one component of a definition within space. A true
definition includes projection, datum, ellipsoid, units, and sometimes a quadrant, which together is called a 'Coordinate System.'

Coordinate System Settings
Each Reader and Writer within FME can be assigned a coordinate system. That coordinate system is set in the Navigator window
of Workbench, or in the Generate Workspace dialog.
Like the source schema, the Reader coordinate system is "what we have" and the Writer coordinate system is "what we want".
Here the source coordinate system has been defined as UTM83-10 and the destination as BCALB-83.

Each feature processed by the Reader is tagged with the coordinate system defined in its parameter.
When a feature arrives at a Writer, if it is tagged with a different coordinate system to what is defined for that Writer, then FME
automatically reprojects the data, so that the output is in the correct location.

TIP
Once tagged with a coordinate system, each feature retains this throughout the translation; FME knows
what coordinate system it belongs to at all times.
This is important when carrying out geometric transformations (like calculating area) or when reading
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multiple datasets that belong to different coordinate systems (yes, FME will handle that).

Automatic Detection of Coordinate Systems
It is not always necessary to set the coordinate system parameters manually. Some data formats (for example Esri Shapefile) are
capable of storing information about the coordinate system in which they are held, and FME will retrieve this information where it
can.

Here, because the source Reader coordinate system is marked <not set>, FME will try to determine the coordinate system from
the source dataset. If it can't, then the feature will be tagged with a coordinate system of <unknown>.
Because the destination Writer coordinate system is marked <not set>, FME will not reproject the data. Instead FME writes the
data using the same coordinate system as the feature is currently tagged with.

WARNING
FME cannot reproject data if it does not know what coordinate system a feature belongs too.
Therefore problems can occur when a Writer is set to create data in a specific coordinate system, but
receives features tagged as <unknown>.
In that scenario either the Writer will fail with an error message, or the data will be written, but with a
series of warning messages in the FME log file.
This also occurs where the Writer format has strict requirements on its coordinate system; for example
KML datasets can only be written in a Latitude/Longitude series of coordinates.
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Exercise 6

Grounds Maintenance Project - Data Reprojection

Data

City Parks (MapInfo TAB)

Overall Goal

Calculate the size and average size of each park in the city, to use in Grounds Maintenance
estimates for grass cutting, hedge trimming, etc.

Demonstrates

Data reprojection

Start Workspace

C:\FMEData2016\Workspaces\DesktopBasic\Transformation-Ex6-Begin.fmw

End Workspace

C:\FMEData2016\Workspaces\DesktopBasic\Transformation-Ex6-Complete.fmw

Let's continue your work on the grounds maintenance project.
The parks team has decided that the output data should be in an Albers Equal Area projection (coordinate system = BCALB-83).
They think it will take ages! We'll show them differently...

1) Start Workbench
Start Workbench (if necessary) and open the workspace from Exercise 5. Alternatively you can open
C:\FMEData2016\Workspaces\DesktopBasic\Transformation-Ex6-Begin.fmw

2) Edit Reader Coordinate System
On the Navigator locate the Parks [MITAB] Reader, and expand its list of settings.
Locate the setting labelled ‘Coordinate System’. The original value should be <not set>:

Double-click the reader Coordinate System setting to open the Edit Parameter dialog.
Enter the coordinate system name UTM83-10 or select it from the Coordinate System Gallery by selecting "More Coordinate
Systems..." from the bottom of the drop-down list.

TIP
Remember, when a Reader’s Coordinate System parameter is defined as <not set> FME will
automatically try to determine the correct coordinate system from the dataset itself.
When the source dataset is in a format that stores coordinate system information (as it does in this
example) you can safely leave the parameter unset. So this step isn’t really necessary.
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However, you MUST set this parameter when you wish to reproject source data that does not store
coordinate system information; otherwise an error will occur in the translation.

3) Edit Destination Coordinate System
Now locate the coordinate system setting for the destination (writer) dataset.
Again the value should be the default value of <not set>.
Double-click the setting. Enter the coordinate system name BCALB-83 or select it from the Coordinate System Gallery by
selecting "More Coordinate Systems..." from the bottom of the drop-down list.

4) Run the Workspace
Save and then run the workspace.
In the log file you should be able to find:
FME Configuration: Source coordinate system set to `UTM83-10'
FME Configuration: Destination coordinate system set to `BCALB-83'

5) Inspect the Output
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Open the FME Data Inspector. Choose Tools > FME Options and turn off the background map.
If the background map is activated then the data is automatically reprojected to match, and this would not help us verify the results
of the translation.
Open the newly reprojected dataset. Query a feature. The Feature Information window should report that the data is now in
BCALB-83. Optionally, click on the coordinate system name in the Data Inspector; a new window will open to display all of the
coordinate system parameters.

TIP
Reprojection can also take place using transformers – like the CSMapReprojector. In fact this might be
considered the better method because the transformers include extra parameters for controlling the
reprojection.

CONGRATULATIONS
By completing this exercise you have learned how to:
Use Coordinate System parameters to reproject spatial data
Query features in the Data Inspector to inspect coordinate system information
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Module Review
This module introduced you to the concept of Data Transformation and explained how to use FME Workbench for more than just
quick translations.

What You Should Have Learned from this Module
The following are key points to be learned from this session:

Theory
A Schema describes a dataset’s structure, including its feature types, attributes, and geometries.
Schema Editing is the act of editing the destination schema to better define what is required out of the translation.
The act of joining the source schema to the destination is called Schema Mapping. Differences between the two schemas lead
to Structural Transformation.
Content Transformation is the modifying of data content during a translation. In FME Workbench data transformation is
carried out using objects called Transformers, which can be found in the Transformer Gallery.
Groups can be created using the Group-By option in a transformer’s parameters dialog.
Splitting data into multiple streams creates multiple copies and not a division of data. Bringing together multiple streams
combines the data, rather than merges it.

FME Skills
The ability to edit a Writer schema
The ability to restructure data by mapping a Reader to a Writer schema, both manually and through transformers
The ability to locate transformers in Workbench and use them to transform data content
The ability to define feature groups using the Group-By option
The ability to reproject data using Workbench

Further Reading
For further reading why not browse articles tagged with Transformation on our blog?
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Questions
Here are the answers to the questions in this chapter.

Mr Flibble says...
The most common format translation defined with FME is from Esri Shapefile to which format?
1. Esri Geodatabase
2. AutoCAD DXF/DWG
3. Google KML
4. Esri Shapefile
Yes! The most common translation is from Esri Shapefile TO Esri Shapefile! It just proves how many
people use FME for data transformation instead of format translation.

Miss Vector says...
Which three colours represent checked, need checking, and unset parameters on transformer objects?
1. blue, yellow, red
2. green, yellow, red
3. red, green, blue
4. green, blue, yellow

Miss Vector says...
If I use a transformer to remove irregularities (like self-intersecting loops) in the boundary of a polygon,
what type of transformation is it?
1. Structural Transformation of attributes
2. Structural Transformation of geometry
3. Content Transformation of attributes
4. Content Transformation of geometry

Miss Vector says...
Which of the following transformers do you think is "group-based"?
1. StringFormatter
2. Clipper
3. Rotator
4. AttributeRounder
The StringFormatter, Rotator, and AttributeRounder can all operate on one feature at a time. For
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example, you can rotate one feature independently of any other. However, the Clipper can only operate on
a group of features. The "Group-By" parameter is a huge clue to identifying group-based transformers!
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Exercise 7

Voting Analysis Project

Data

Election Mapping (GML)
Election Statistics (Microsoft Excel)

Overall Goal

Map statistics of voting patterns

Demonstrates

Data Transformation

Start Workspace

C:\FMEData2016\Workspaces\DesktopBasic\Transformation-Ex7-Begin.fmw

End Workspace

C:\FMEData2016\Workspaces\DesktopBasic\Transformation-Ex7-Complete.fmw
C:\FMEData2016\Workspaces\DesktopBasic\Transformation-Ex7-CompleteAdvanced.fmw

In a break from grounds maintenance projects, the municipal Elections Officer has heard about your skills and asked for help
identifying voting divisions that had a low turnout at the last election, or divisions where there were difficulties understanding the
voting process.
He asks for your help and you suggest the results should be presented in Google KML format, so staff can view them without
having to use a full-blown GIS system.

1) Inspect Data
Start the FME Data Inspector and open the two datasets we will be using:
Reader Format

GML (Geography Markup Language)

Reader Dataset

C:\FMEData2016\Data\Elections\ElectionVoting.gml

Reader Format

Microsoft Excel

Reader Dataset

C:\FMEData2016\Data\Elections\ElectionResults.xls

Notice that both datasets have a Division attribute by which to identify each voting division (area). The Excel data is non-spatial
but has a set of other voting attributes:
Voters: Number of registered voters
Votes: Number of voters who voted
Blanks: Number of voters who left a blank or spoiled vote
OverVotes: Number of voters who voted for too many candidates
UnderVotes: Number of votes not cast
The OverVotes and UnderVotes attributes are an indicator of how well the voting process was understood. Each voter gets to vote
for up to 10 candidates (out of 30).
OverVotes are those voters who voted for more than ten candidates. UnderVotes are the number of votes that could have been cast,
but were not (for example, the voter only voted for five candidates).

2) Start Workbench
Start Workbench and open the starting workspace. It already has Readers and Writers added to handle the data; all we need to do
is carry out the transformation:
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3) Add FeatureMerger
The first task is to merge the statistical election data onto the actual features. We'll use a FeatureMerger transformer to do this
(more on this transformer appears later in this course).
Add a FeatureMerger transformer. Connect the VotingDivisions data to the Requestor port, and the Councillors (result) data to the
Supplier.

4) Set Parameters
Click the cog-wheel icon to open the FeatureMerger parameters dialog. For both the Requestor and Supplier join fields, click the
drop-down arrow and Attribute Value > Division.
This is the common key by which our data is merged:
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Click the OK key to close the dialog.

5) Add Inspector Transformer
Add an Inspector transformer after the FeatureMerger:Merged output port. Run the workspace.
Ignore any warning or log message that reports Unexpected Input.
Ensure that the Feature Count on that connection is the same as the number of incoming features from the VotingDivisions (note,
there will be extra features from the Councillors data that is not used, because that includes divisions outside our area of interest).
Also examine the data in the FME Data Inspector to ensure all division polygons now include a set of attribute data copied from
the Excel spreadsheet:

6) Add ExpressionEvaluator
Now that we have the numbers we need, we can start to calculate some statistics. To do this we'll use an ExpressionEvaluator
transformer to first calculate voter turnout percentage for each division.
Place an ExpressionEvaluator transformer after the FeatureMerger - connect it to the FeatureMerger's Merged output port - and
open the parameters dialog.
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Set the New Attribute to Turnout (to match what we have on the destination schema).
In the expression window set the expression to:
(@Value(Votes)/@Value(Voters))*100

You don't need to type this in - the @Value(Votes) and @Value(Voters) part can be obtained by double-clicking that attribute in
the list to the left.
Click OK to close the dialog. If you wish you can reconnect an Inspector and re-run the translation, to see what the result is.

7) Add ExpressionEvaluator
Using a similar technique, use an ExpressionEvaluator to calculate the number of UnderVotes per voter and put it in an attribute
that matches the output schema. The expression will be something like:
@Value(UnderVotes)/@Value(Voters)
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8) Add AttributeRounder
It's a bit excessive to calculate our statistics to 13 decimal places or more. We should truncate these numbers a bit.
Place an AttributeRounder transformer.

Open the parameters dialog. Under Attributes to Round select the newly created Turnout and UnderVoting attributes. Set the
number of decimal places to 2:

Click OK to close the dialog and, again, run the workspace to check the results if you wish.

9) Connect Schema
For the final step let's connect the AttributeRounder to the output schema. Simply make connections from the AttributeRounder to
both writer feature types:
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Run the workspace and examine the output in Google Earth to prove it has the correct attributes and is in the correct location.

Advanced Exercise
The project is done, but the output is very plain. It would be much better to improve the look of the results
and there are several ways to do this with KML.
We could simply color the voting divisions differently according to their turnout/overvotes, but a more
impressive method is to use three-dimensional blocks.
Follow the steps below to create three-dimensional shapes in the output KML dataset...

10) Add ExpressionEvaluator
The height of each block should be proportional to the turnout for that division. However, for differences to be clearly visible, the
vertical scale will need some exaggeration.
Place an ExpressionEvaluator between the AttributeRounder and the Turnout feature type. Set the parameters to multiple the
Turnout attribute by a value of 50. Put it into a new attribute called TurnoutScaled.
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11) Add 3DForcer
Add a 3DForcer transformer. This will elevate the feature to the required height. Open the parameters dialog and set the elevation
to Attribute Value > TurnoutScaled.

12) Add KMLPropertySetter
Add a KMLPropertySetter transformer. This will allow us to set up the 3D blocks in the output. Open the parameters dialog. Set:
Altitude Mode: Absolute
Extrude: Yes
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13) Add KMLStyler Finally add a KMLStyler transformer. The workspace will now look like this:

Open the parameters dialog. Select a color and fill color for the features. Increase the fill opacity to around 0.75.

Save and run the workspace. In Google Earth the output should now look like this:

These 3D blocks will show users where the voting turnout is high/low in the city.
If you wish, repeat these steps to give a 3D representation to the UnderVoting statistics.

CONGRATULATIONS
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By completing this exercise you proved you know how to:
Carry out content transformation with transformers (ExpressionEvaluator, AttributeRounder,
3DForcer)
Use transformer parameters to create attributes that match the Writer schema
Use multiple streams of transformers in a single workspace
You also learned how to:
Merge multiple streams of data using a common key (FeatureMerger)
Use FME's built-in maths editor dialog
Use transformers to set a symbology (style) for output features
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Best Practice
If a workspace runs to completion, and produces the output you want, it can’t be bad, can it? Well, yes it can. It's not enough just
to put together a functioning workspace, it's also important to use FME in a manner that is both efficient and scalable.

What is Best Practice?
In general terms Best Practice means the best way of doing something; in other words, carrying out a task in the most effective
and efficient manner.
Despite the word 'best', we're not presuming the ideas here will meet every need and occasion. The best description of this concept
I've heard – and one that fits well here – is:
“a very good practice to consider in this situation based on past experience and analysis”

Why Use Best Practice?
Best Practice in FME can help a user to…
Create well-styled workspaces that are self-documenting
Create workspaces that use the correct functionality in the correct place
Create high-performance workspaces
Use FME Workbench in a way that’s most efficient
Debug a workspace when it doesn’t work the way intended
Use FME in a project-based environment

Dr. Workbench says...
I'm Dr. Workbench, licensed to practice medicine on FME workspaces.
I learned about Best Practice the hard way, when I was tasked with surgery on a set of someone else’s
workspaces. They were so badly organized the whole operation took me three times as long as it should
have, and ruined my plans to spend the afternoon playing golf!

In this chapter we'll cover four different categories of Best Practice.

Style
This section is a guide to the preferred design for workspaces. The correct style makes a workspace easier to interpret, particularly
in the long run when the author might return to it after a period of inactivity.

Methodology
This section covers which techniques make efficient use of Workbench and its components - and which don't! Using Workbench
the right way makes for a more productive and efficient experience.
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Debugging
This section covers tools and methods to help identify and fix problems in translations.

Organization
This section covers what functionality exists to organize FME within a workplace. Sharing resources among several FME users is
one technique made possible by special FME functionality.
Each section will have a number of recommendations. These are suggested methods that meet the principles of best practice in
FME.
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Style
Style is perhaps the most obvious component of FME Best Practice. You can tell at a glance when a workspace is well-styled and
when it is not. But style is more than just looks; a properly designed workspace provides many benefits as it is further developed
and edited in the future.

An FME Workspace Style Guide
A good style of design makes it easier to navigate and understand an existing workspace. This is important when workspaces
might need to be edited by other users, or when you intend to make edits yourself at a later date.

Ms. Analyst says...
It’s very much like a computer programmer adding comments to their code to explain their actions. As an
example, nearly 30% of FME’s codebase consists of comment lines.

Specifically, a good style can help a user to…
Distinctly define different sections or components of a workspace
Quickly navigate to a specified section or particular transformer
Pass a workspace on to another user for editing
Rename workspaces and content with a more explanatory title

Example of Poor Design
You need proof? Well, would you want to be given the task of editing this workspace?
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Can you even tell what this section of workspace is doing?
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Annotating Workspaces
Annotation is a key method for a clear and comprehensible design.
Annotation helps other users understand what is supposed to be happening in the translation and also helps the creator when
returning to a workspace after a long interval (take it from me that this is especially important!)
There are a number of different types of annotation that can be applied to a workspace.

Header Annotation
By default FME adds three annotations to a newly-created workspace. The annotations are basic comments that indicate the
source data, the transformation, and the destination data. They can be deleted or, optionally, left ungenerated, and therefore may
not appear in every workspace.

Summary Annotation
Summary annotation is an FME-generated comment that provides information about any object within the workspace. This item
can be a source or destination feature type, or a transformer.
Summary annotation is always colored blue to distinguish it from other annotation. It's always connected to the item to which it
relates and cannot be detached.

The nice thing about Summary Annotation is that it automatically updates in response to changes. That makes it very useful for
checking transformer parameters (or Reader/Writer schemas) at a quick glance. It's particularly useful in situations where the
parameters are set through a wizard and are more awkward to check (for example, the SchemaMapper or FMEServerJobSubmitter
transformers).

.1 UPDATE
The AreaCalculator transformer in the above (and following) screenshots gained a <Rejected> port in
FME2016.1
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Aunt Interop says...
I'm Aunt Interop. I write a blog helping out users with their various FME problems.
As I always say, size doesn't matter! You should always use Best Practice, whether it's a small workspaces
or training exercise, or a large-scale project. Getting into the habit helps make your smaller projects
scalable.

User Annotation
User annotation is a comment created by the user. It can be connected to a workspace object (transformer or feature type), can be
connected to a workspace connection, or can float freely within the workspace.

To create floating user annotation, right-click the canvas and select Insert Annotation.
To create attached user annotation, right-click a workspace object and select Add Annotation.
When you place an annotation you have the opportunity to change the font style, font size, and background color; plus you can
also add hyperlinks, bullet points, and tables.

Recommendation
Use summary annotation to show what actions are taking place; but use user annotation to clarify why an
action is being carried out. This helps future edits and updates go more smoothly.

Annotation Options
Right-click an annotation object to reveal (among other things) the following options:
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Set Background Color change the background color of the annotation
Word Wrap Toggle word wrapping on and off
Follow Attached Object – make the annotation move when the attached object is moved
Attach to Feature Type – attach to a specific feature type
Attach to Transformer – attach to a specific transformer
Attach to Connection – attach to a specific connection between two objects
Detach – detach annotation from an object
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Bookmarks
A bookmark, like its real-world namesake, is a means of putting a marker down for easy access.
With FME the bookmark covers an area of workspace that is usually carrying out a specific task, so a user can pick it out of a
larger set of transformers and move to it with relative ease.

Why use Bookmarks?
Bookmarks play an important role in a well-styled workspace for a number of reasons, including these.
Sectioning: As a way to divide a workspace into different - clearly marked - sections
Access: As a marker for quick access to a certain section of workspace
Editing: As a means to move groups of transformers at a time

Adding a Bookmark
To add a bookmark, click the Bookmark icon on the toolbar.

Whereas a traditional bookmark marks just a single page in a book, the FME bookmark can cover a wide area of the canvas. A
single workspace can be divided into different sections by applying multiple bookmarks.

TIP
If any objects on the workspace canvas are selected when a bookmark is created, the bookmark is
automatically expanded to include those items.

Resizing and Editing a Bookmark
To resize a bookmark simply hover over a corner or edge and then drag the cursor to change the bookmark size or shape.

Double-clicking a bookmark title allows the color and title of the bookmark to be edited.

149

Bookmarks

TIP
Bookmarks are shown either as a frame around white-space or filled with color.
Tools > FME Options on the menu bar opens a dialog with a number of sections, one of which
(Workbench) has an option to have color-filled bookmarks.

Bookmark Options
Right-click a bookmark to show the following options:

Delete: Delete the bookmark
Duplicate: Create a duplicate bookmark
Rename: Edit the bookmark title
Edit Bookmark Description: Edit the description of the bookmark
Select All Objects in Bookmark: All objects (transformers included) in the bookmark are selected
Properties: Open a dialog to set bookmark name and color.

TIP
A bookmark description shows as a block of text inside the bookmark. Like annotation, it can be styled to
a specific font or color.
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.1 UPDATE
In FME2016.1 the option to set the bookmark description is available in the bookmark properties dialog,
opened by double-clicking a bookmark:
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Bookmarks for Sectioning
A bookmark is a great way of indicating that a particular section of a workspace is for a particular purpose. By subdividing a
workspace in this way, the layout is often a lot easier to follow. Think of bookmarks as being like the chapter headings in a book!

This workspace illustrates nicely how to mark up different sections of a workspace using Bookmarks.

Recommendation
If you use bookmarks for nothing else, use them to divide your workspace into easily identifiable sections.
It really makes the canvas more readable.

Mr E. Dict (Attorney of FME Law) says...
In my considered opinion, it's perfectly legal to nest bookmarks. Nesting means to place one bookmark
inside another. In this manner each ‘section' of a workspace can be divided into subsections.
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Bookmarks for Quick Access
Bookmarks are listed on the Workbench Navigator. Each bookmark is depicted as a folder and can be expanded to show its
contents. This may include feature types, transformers, or other - nested - bookmarks:

Clicking a bookmark in the Navigator selects that bookmark and brings it into view.
Double-clicking it selects the bookmark and brings it into the centre of the view.
So, when bookmarks have been used to divide a workspace into sections, they can also be used to navigate between different parts
of that workspace.

Workspace Presentation
Bookmarks also appear on this section of the FME Workbench toolbar:

Besides being a way to quickly access bookmarks, this tool can be used as what is known as "Presentation Mode" in FME
Workbench. By clicking the + button you flip from bookmark to bookmark, using animation, in a way that would be very useful
when showing the workspace as part of a presentation.

TIP
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To access the functionality you need to make sure it is added to the toolbar. You can do this by rightclicking on the toolbar and using the customize option.

.1 UPDATE
In FME2016.1 the order of the bookmarks in the Bookmark Navigator can be adjusted to give more
control over the display order. To do so, right-click on Bookmarks in the Navigator window and turn off
the default option to "Sort Alphabetically".

Bookmarks can then be dragged up and down in the Navigator window to give the correct order.
Additionally, a new option on the bookmark Properties dialog allows you to exclude specific bookmarks
from the Bookmark Navigator. Nested bookmarks are excluded by default, so must be turned on to be
included in the navigator.
For more information see the article on bookmarks in 2016.1 on the Safe Software blog.
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Bookmarks for Editing
Bookmarks define a section of workspace containing a number of objects. When editing a workspace without bookmarks, moving
objects is done by selecting the object or objects and dragging them to a new position.
However, when a workspace is divided by bookmarks, objects can be moved by simply dragging the bookmark to a new position.
When an object is located inside the bookmark, it moves as the bookmark does.

Using this technique large groups of objects can be moved about the workspace canvas, in order to create a clearer layout.

The Magnet Icon
Each bookmark in FME has a magnet icon in its top-left corner. Clicking on the icon toggles it from active to inactive (and vice
versa).

An inactive magnet (colored blue) allows the bookmark to be moved without disturbing the contents. It's useful when you need to
reposition the bookmark without also moving its contents.

Miss Vector says...
Here are some Best Practice questions. You do want to be the best, don't you?
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Which of the following is NOT a method of creating a bookmark?
1. Click the Insert Bookmark button on the toolbar
2. Select a transformer, right click, choose Create Bookmark
3. Select multiple transformers, right click, choose Create Bookmark
4. Use the Ctrl+B shortcut
Which of these is NOT a type of annotation in FME Workbench?
1. Header Annotation
2. Parameter Annotation
3. User Annotation
4. Summary Annotation
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General Style Suggestions
These items are general suggestions for what the style of an FME workspace should look like.

Transformer Layout
The layout of transformers – and, in particular, a consistent method of positioning – can really make the difference between a
poorly-designed workspace and one that is visually attractive and efficient. Objects that are lined up nicely demonstrate a care and
attention to detail that is the hallmark of a well-designed workspace.
Layout methods vary from user to user. Some users like to line up transformers so that all connections are horizontal lines:

Others prefer the tops of objects to be aligned, with angled connections:

Some prefer to align transformers vertically:

Given all of the different transformers, and the need to have multiple streams of data interact with each other, most users end up
with a hybrid approach:
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Recommendation
Be sure to use a thoughtful transformer layout at all times; transformers dropped onto the canvas at
random locations demonstrate a sloppy and thoughtless approach to workspace authoring.

Some users add extra vertices to create square corners to each connection. We call this "Manhattan Style".

Recommendation
Manhattan-style connections should be avoided while FME doesn't have a formal way of creating them (it
may do soon). Currently, creating this layout is time-consuming and the behaviour unpredictable when
one of the attached objects is moved to a different position.

Grid and Guides
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Grids and Guides are a tool to help align workspace objects in a neat and tidy way. This functionality is accessed through View >
Grid and Guides on the Workbench menubar.

Show Grid causes a grid of lines to be displayed on the Workbench canvas. Snap to Grid causes all objects - such as the summary
annotation highlighted - to snap onto the intersection of grid lines when moved. In this way objects can be more easily lined up.

Show Guides causes guidelines to be displayed on the Workbench canvas whenever an object is moved, and lines up
approximately to another canvas object. Snap to Guides allows an object to be snapped onto a highlighted guideline.
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These two tools make it very simple for workspace objects to be aligned in a pleasing style.

Non-Overlapping Connections
Does it really need to be said that overlapping lines are not good for workspace clarity?
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Far better to arrange your workspace objects to avoid overlaps:

.1 UPDATE
FME2016.1 introduces the ability to reorder output ports on transformers. Simply right-click a port and
choose to move it up or down. This makes it easier to detangle overlapping connections without having to

162

General Style Suggestions

move objects around on the canvas. For more details see this blog post.

Renamed Transformers
Did you notice that the Properties dialog for each transformer contains a field where the transformer may be renamed to a more
meaningful title?

This is particularly useful where there are tens (or hundreds) of the same type of transformer, as it can help identify which
transformer carries out which action.

Tip
Renaming transformers helps identify them both on the canvas and in the navigator window.

Users who wish to keep the original name on the canvas often use annotation instead. The default content
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of a new annotation is the name of the transformer, which is a good starting point for editing.

Workspace Properties
Look in the Navigator window and you will find a number of settings called Workspace Properties.
Workspace Properties are basically metadata fields that are useful in investigating the workspace's history. Like other style
elements, they have no effect on the translation, but they are useful for ensuring a workspace is properly documented.

.1 UPDATE
FME2016.1 introduces a new transformer called "Junction":

This transformer is a small, node-like object, that carries out no function on the data, but is instead used
to tidy connections within a workspace - as in the above screenshot. This makes it an excellent tool for
best practice.
As with any other transformer, a junction can be connected to an Inspector or Logger, and it can have
annotation objects attached to it. It also works with both Quick Add and Drag/Connect functionality.
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.1 UPDATE
FME2016.1 also introduces the ability to hide connections in a workspace. This is especially useful to
avoid overlapping connections. To do so, right-click a connection and choose the option to Hide:

This causes the connection to be hidden on the canvas, with each end represented by an icon like so:

The other available option is "Create Tunnel". This creates a hidden connection with the addition of a
junction transformer at each end:
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A tunnel makes a hidden connection slightly more obvious, plus allows for annotation at each end.
To return a connection back to view, simply right-click an object to which it is connected and choose Show
Connection(s). For more information on Tunnels and Junctions see this blog post.
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Exercise 1

Applying the Style Guide

Data

City Parks (MapInfo TAB)

Overall Goal

Clean up workspace and apply concepts of style guide

Demonstrates

Style Best Practice

Start Workspace

C:\FMEData2016\Workspaces\DesktopBasic\BestPractice-Ex1-Begin.fmw

End Workspace

C:\FMEData2016\Workspaces\DesktopBasic\BestPractice-Ex1-Complete.fmw

An FME author (it might have been you) created a workspace to process data for a grounds maintenance project. The results of
the workspace are fine and everyone is happy. However, the workspace was created before you knew about the FME style guide.
So let's apply a little bit of styling to this project.

1) Open the Workspace
Open the workspace for the grounds maintenance project. You may have already created it, or you can use a pre-defined version
from C:\FMEData2016\Workspaces\DesktopBasic\BestPractice-Ex1-Begin.fmw

2) Tidy the Workspace
Tidy the workspace layout and setup using the FME Style Guide covered in the previous pages.
Don't forget to use annotation and bookmarks, so that future users of the workspace will be able to tell at a glance what the
workspace is supposed to do. If you have FME2016.1, consider using the Junction transformer to tidy up potentially overlapping
connections.
By the time you have finished, the workspace should look something like this:
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CONGRATULATIONS
By completing this exercise you have learned how to:
Use annotations to clarify the processes taking place in a workspace
Use bookmarks to turn a single workspace into defined sections
Rename transformers to make their purpose more clear
Avoid poor design choices like overlapping connections
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Methodology
Methodology is all about using the tools you have in the way they were intended. If you have experience of software development
you might be aware of the concept of design patterns. According to Wikipedia:
Patterns are formalized best practices that the programmer can use to solve common problems when designing an
application or system
Design patterns make for a simplified and efficient development process. Likewise, using Workbench the right way makes for a
more productive and efficient FME experience.
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Format Methodology
Format best practices involve setting up Readers and Writers both quickly and without cluttering the canvas.

Minimizing Feature Type Objects
A schema definition may contain many, many Feature Types. If these are all chosen for translation then the workspace can become
extremely unwieldy and poorly laid out.
Here a user has 80 feature types, only 11 of which are being used:

Remember, when creating a workspace you'll be prompted which feature types to add to the translation. Don't add feature types
you don't need, as it will cause cluttering of the canvas.

TIP
An excess of attributes can also cause workspace clutter. Don't forget you can hide attributes on the
Reader feature type and make the workspace clearer and tidier than if the entire set of attributes was still
exposed.

Database Connections
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Database formats are an example of a repeating pattern, where the same connection and authentication parameters need to be
entered whenever a database Reader or Writer is added, or a connection is required inside a transformer.
To simplify this process, use a tool called Database Connections.
Database Connections are a pre-defined set of connection and authentication parameters, stored under a single name. Once
created, all FME Readers and Writers (and transformers) will accept a connection name in lieu of the actual parameters.

Creating a Database Connection
To create a Database Connection first select Tools > FME Options from the menubar and then click on the Database Connections
icon. A new connection is created by clicking the + button:

A new connection is defined by selecting the database type, entering connection parameters, and giving the connection a name:
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Now, whenever a workspace involves a database-related Reader/Writer, it's possible to simply use this connection instead of reentering all the usual parameters:

The benefit here is not only efficient workspace authoring, there is also a security benefit. If you embed the connection parameters
(i.e. enter them for each Reader/Writer) then they are stored inside the workspace file. This could be a security risk if you send the
workspace to someone. But FME Database Connections are stored securely on your system, outside of the workspace, and can
never be accessed by someone else.

NEW
For FME2016, database connections are also listed in the Navigator window once they are used:
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Right-clicking a connection here also displays a context-menu with the ability to edit, test, or embed that
connection; and to show where in the workspace it is used.
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Transformer Methodology
With FME's huge number of transformers it's very difficult to say exactly which transformers to use and when. However, it's much
easier to identify when something is wrong, with design weaknesses that may lead to future difficulties.

Duplicated Transformers
If a workspace duplicates the same transformer again and again – maybe creating multiple streams to do so – then it is probable
that the workspace has been designed very inefficiently.
The multiple attribute transformers here indicate there is a problem.

Here a single AttributeValueMapper transformer could be used to replace all of the above transformers (both AttributeFilter and
AttributeCreators).

Error Trapping
Error trapping is a way to design a workspace such that unexpected data does not cause the workspace to fail. Basically you try to
foresee the sort of data problems that might arise and build in methods to handle them.
Error trapping can be as simple as adding a test or filter transformer to weed out bad features, or it can be more complex and
include ways to process data in different ways depending on different circumstances.
Here a user is reading a surface model and assigning Z values to building footprints. The important part is that they are testing
what units the dataset is in (cded_units = meters|feet) and converting where the units are not what they want:
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This workspace can be depended on to produce the correct results, no matter whether the source data is in metres or feet.

NEW
The Tester transformer in FME2016 has a new operator for testing whether an attribute has a value:

This will be very useful for error trapping, to test whether an attribute has a value before trying to use it
as the source for a parameter.

Complexity
A workspace does not need to be complex to be a good project; it can carry out a complex process in a simple way.
These are clues that there might be a problem:
Low Level Complexity: When a workspace author uses FME functions and factories inside a workspace
Excess Scripting: When a workspace contains more scripting (in Python or Tcl) than it does FME transformers
Connection Density: When workspace connections are so dense they form a moiré pattern!
Multiple workspaces: This workspace calls that one, which calls this one, which runs Python to call that one...
The connections in this workspace are so dense they could form a black hole! If your workspace looks like this, it might be time to
look at how it can be improved:
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Firefighter Mapp says...
It's better to be safe than sorry. You don't want to get burned by bad designs. If you're unsure about a
workspace, consult other FME users, or contact the Safe Software support team for advice.
Also, be sure to check out this blog post on FME and Code Smells.
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Exercise 2

Design Patterns

Data

City Parks (MapInfo TAB)

Overall Goal

Clean up workspaces by improving the design patterns used

Demonstrates

Methodology Best Practice

Start Workspace

C:\FMEData2016\Workspaces\DesktopBasic\BestPractice-Ex2-Begin.fmw

End Workspace

C:\FMEData2016\Workspaces\DesktopBasic\BestPractice-Ex2-Complete.fmw
C:\FMEData2016\Workspaces\DesktopBasic\BestPractice-Ex2-Complete-Advanced.fmw

An FME author (don't worry, this time it wasn't you) created a project to map roads in the downtown area. However, the author
knew very little about FME and broke a lot of basic design rules. You've been asked to make some edits to the project but it's a
very difficult workspace to understand and you find that you first need to make some improvements in the methodologies used.

1) Open the Workspace
Open the workspace for the project. You can find it at C:\FMEData2016\Workspaces\DesktopBasic\BestPractice-Ex2-Begin.fmw

Examine what the workspace does. You'll see there are two main processing streams. In the first, a number of raster files are being
read and a test carried out to filter those that are not needed. The raster data is then mosaicked together.
The second stream starts with a set of roads data. The data is buffered (to enhance its appearance), a color is set, and it is written
onto the raster data backdrop (using a VectorOnRasterOverlayer transformer).
Run the workspace and examine the result. The output is fine - but the design of the workspace is not very good at all.

2) Remove Unwanted Feature Types
Looking at the raster feature types, it is obvious that much of the data being read is being filtered out by the Tester. Use summary
annotation on the Tester. This will show the Tester parameters without you having to keep opening and closing the parameters
dialog.
Check which files the Tester is keeping. Remove any Reader feature types that are not part of the list. Then remove the Tester
itself.
This should reduce the size of the workspace considerably:
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3) Remove Unwanted Road Feature Types
Looking at the road feature types, some of those are not even connected. They can be deleted immediately.

The workspace might now fit the canvas at a reasonable scale!

4) Trap Errors
One obvious oddity in the workspace is that the Secondary and Residential roads are given a color with the FeatureColorSetter
transformer, but the Arterial and Other roads are not.
Perhaps the workspace author thought the existing red color was already suitable. This might be true, but there's no guarantee the
source data might not change, or contain errors in color. We should ensure that these features appear red, regardless of what the
source data says.
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So, place a new FeatureColorSetter transformer in the workspace (or copy one of the other ones), and use it to color the
Other/Arterial features in red:

Police Chief Webb-Mapp says...
I think this workspace is going to be fine, but in other scenarios I might be concerned about the
RasterMosaicker and the VectorOnRasterOverlayer transformers. For example, how do I know that only
valid raster features will reach the RasterMosaicker transformer? What might happen if a rogue vector
feature reached that transformer?
A simple GeometryFilter transformer can help me filter out features with unexpected geometry before they
can cause a problem, but it is these sort of questions you need to ask in order to fully error-trap a
workspace.

5) Check FMEFunctionCaller
You may have noticed the FMEFunctionCaller transformer lurking towards the end of the translation. This transformer is able to
make calls directly into the heart of the FME engine. However, it's not often that you would need to do such a thing.
Open the FMEFunctionCaller's parameters dialog to see what it is being used for:
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The transformer seems to be doing a very simple call to log the current feature to the log window. Besides the fact that it's
probably for debugging, there's no need to use an FME function to do such a thing. The Logger transformer works just as well,
and has more options available.
Replace the FMEFunctionCaller with a Logger transformer:

6) Save and Run Workspace
You can now save the workspace and then run it to prove the output is the same as it was before (but in a markedly improved
workspace design):
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Dr. Workbench says...
If you get a message pop-up (or appear in the log window) about features not matching, don't worry. It
isn't an error message and won't stop the workspace from functioning. You'll find out more about this
message in another chapter of training.

Advanced Exercise
One other change we can make is a little more advanced. It concerns reducing the number of Bufferer
transformers. If you're up for a challenge, follow these steps...

7) Delete and Replace Bufferers
Check the buffer sizes being used in the Bufferers and then delete those transformers. Add an AttributeValueMapper and a single
Bufferer after the FeatureColorSetters:
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.1 UPDATE
The Bufferer transformer in the above screenshot gained a <Rejected> port in FME2016.1

8) Set AttributeValueMapper Parameters
Open the AttributeValueMapper parameters dialog. Set the Source Attribute to be fme_feature_type (a record of the feature type
the feature belongs to) and set the Destination Attribute to be BufferAmount:

Underneath, in the Value Map settings, set the following:
Residential = 2; Other = 5; Arterial = 5; Secondary = 3;
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9) Set Bufferer Parameters
Now open the Bufferer parameters dialog. Set the Buffer Amount parameter to Attribute Value > BufferAmount:

Basically, by doing this, we have reduced the number of transformers required in the workspace. In this case, we only saved a
single transformer. However, if future edits required other road types to be included, we could use the same infrastructure and not
need to add more transformers.
Similarly, future changes to the buffer amounts can be set through a single transformer, not a series of them.
In all, this part of the exercise has made this workspace very scalable.
If you have time, repeat these steps to reduce the number of FeatureColorSetter transformers as well, like so:

CONGRATULATIONS
By completing this exercise you have learned how to:
Remove excess feature types from a workspace
Identify where errors might occur and pre-emptively fix them
Identify and replace excessively complex transformers
(Advanced) Identify and fix repeating transformers
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Debugging
Even skilled FME users seldom produce correct results with the first version of a new workspace.
In the event of an error message or unexpected output, a user must 'debug' the workspace to find what error has been introduced
into the workflow definition. And when the workspace is very large, like this:

...debugging can be as much an art as a science.
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Logging
When you run a workspace FME writes to both the FME Workbench log window and a log file.
These logs contain a record of all stages and processes within a translation. The contents may appear complex, but such
information is vital for interpreting a workspace's actions.
The log file is (by default) written to the same folder as the workspace with the name <workspace name>.log.

Message Types
There are a number of different message types that show in the log window including:
Error: An error, denoted in the log by the term ERROR, indicates that a problem has caused FME to terminate processing. For
example, FME is unable to write the output dataset because of incorrect user permissions.
Warning: A warning, denoted by the term WARN, indicates a processing problem. The problem is sufficiently minor to allow
FME to complete the translation, but the output may be adversely affected and should be checked. For example, FME is unable to
write features because their geometry is incompatible with the Writer format. The features will be dropped from the translation
and a warning issued in the log.
Information: Information messages, denoted by the term INFORM, indicate a piece of information that may help a user
determine whether their translation has been processed correctly. For example, FME sometimes log confirmation of a particular
dataset parameter, such as coordinate system.
Statistics: Statistics messages, denoted by the term STATS, provide information on various numbers relating to the translation;
for example the number of features read from a source dataset, and the time taken to do so.

Sister Intuitive says...
You can search for different types of messages by clicking in the log window and pressing Ctrl+F to open
a search dialog.

Log Options
Workbench has the ability to filter different message types from the log window. This is done using Tools > FME Options >
Translation.

Adjusting the view of messages in this way does not affect the output written to the log file (just the log window within
Workbench).
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Turning off STATS and INFORM log messages helps to highlight WARN and ERROR messages in the log so there is less chance
of missing them; though it does feel strange to watch a translation take place without the log window scrolling past as usual!
The Log Debug option forces FME to show additional messages (of any of the usual types) that depict what is going on at a lower
level in the FME engine. This option can be helpful when trying to debug a workspace problem, and particularly useful for
logging information about HTTP connections.

WARNING
Logging debug messages is NOT a good idea unless you already have a problem you are trying to track
down. That's because it includes errors and warnings that are part of the natural process of a workspace.
For example, this message looks bad, but it is really a common debug message in successful translations:
ERROR |BADNEWS: File C:\apps\FME\metafile\MULTI_WRITER.fmf could not be opened
(tabrdr.cpp:1037)

Log Timings
Besides log message types, there are other useful options under Tools > FME Options > Translation.

One of these options is the ability to turn log timestamp information on or off.
Log timestamps indicate the absolute date and time for each step of the translation process. They also show the time taken by
FME to process the previous stage and the cumulative time taken to reach that point in the translation.

Mr. Statistics-Calculator says...
What kind of statistician would I be if I didn't like numbers? Even so, I recommend you to turn on log
timings and keep them turned on. They do add to the amount of content in the window, but 97.8% of users
find them incredibly useful when trying to debug a poorly-performing translation.

Logger Transformer
Besides FME writing information to the log window, the user can force information about a feature to be logged using the Logger
transformer.
This transformer is extremely useful for debugging purposes, and has a number of parameters:
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The 'Log Message:' parameter is especially important. When a feature is logged, the message entered into that parameter appears
with the feature in the log window. Setting a unique message helps you locate logged features with the log search function.

Spatial Log File
Besides writing the log to a text file (<workspace name>.log) FME also writes a spatial log. This is a dataset of features that have
been mentioned in the log - either because of a warning from FME or by use of the Logger transformer.

The log is an FFS (FME Feature Store) format dataset. It can be opened within the FME Data Inspector to inspect the features and
identify the problems that caused them to be rejected.
This is a much easier process than trying to locate the same feature within the full source dataset.
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Interpreting the Log Window
It can't be emphasized enough that the log window is THE most important place to look for information when a translation does
not complete as expected - or to be sure that a translation has completed as expected.
Here are some suggestions for interpreting what you see in the log window.

Check for Errors
If an ERROR occurs, it is likely that the translation will be halted. There will be a lot of red text and some terminating statements
such as:
Program Terminating
Translation FAILED.
There may be several ERROR messages, so scroll back up the log window to try and identify the first of these, which is likely to
be the root cause of the problem. For example:
ERROR |Error connecting to PostgreSQL database(host='postgis.train.safe.com', port='5432', dbname='fmedata',
user='fmedata', password='*'): 'FATAL: password authentication failed for user "fmedata" FATAL: password authentication
failed for user "fmedata"
...is an obvious problem with authenticating a database connection.

Check for Warnings
Even when a translation succeeds, it's important to check the log for the following comment:
Translation was SUCCESSFUL with X warning(s)
If there are any warnings (i.e. if X > 0) then use the search option to look for the word WARN. Any warning messages might have
important consequences for the quality of the output data.

TIP
More and more FME transformers favour a <Rejected> port, rather than dropping the feature and
logging it.
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This allows the workspace author to deal with bad features immediately, rather than having to handle
them after the workspace has finished.

Check Timestamps
Timestamps in the log have this format:
Absolute Date
2015-11-11

Absolute Time
13:27:07

Total FME Time
0.2

FME Time for this Step
0.1

The time taken for the process being logged is the "Time for this Step". Often this is rounded down to 0.0. The Total FME Time
is, literally, the amount of time that FME has been actively processing.
Sometimes, this total appears at odds with the absolute date/time:
Absolute Date

Absolute Time

Total FME Time

FME Time for this Step

2015-11-11

13:27:07

0.2

0.1

2015-11-11

13:29:30

68.4

68.3

Here the step took 68.3 seconds, but the difference between the two absolute times is 123 seconds!
The absolute start and end times can differ from FME processing time because non-FME processes, such as a database query, add
to the absolute time taken without adding to the FME processing time.
Therefore the log can provide an indication of the efficiency of external processes; for example, database reading. A slow database
read would imply database indexing needs to be improved.

Sequence
The FME engine is set up to process features as efficiently as possible. In most cases that is not a single process that takes place in
the same order as the transformers appear on the Workbench canvas.
Because of that, it's unlikely the log window will show features processing in the order you would expect. Don't be confused if the
order of actions in the log file doesn't match the layout of the workspace.
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Feature Counts
A workspace Feature Count refers to the numbers shown on each connection once a translation is complete:

When a log file shows a translation that ended in an error or where the number of output features was not what was expected, then
the Feature Count values shown on each connection can help to diagnose where the error occurred.
For example, if all your features entered a transformer, but none emerged, then you can be fairly confident that the transformer is
the cause of the problem.
Here, for example, 80 features enter the Clipper transformer (to be clipped against a single boundary) but none emerge.

Here the user will want to inspect the data as it enters the transformer as it's possible that Clipper and Clippees don't occupy the
same coordinate system, hence one does not fall inside the other.

Rejected Features
Many transformers now include a <Rejected> port to output incorrect features. To help in debugging, rejected features are
automatically counted on a <Rejected> port, even if there is no Logger or other transformer attached:

Additionally, the rejected features are also saved as a temporary dataset, so right-clicking (or double-clicking) allows the user to
inspect them in the Data Inspector, whether or not the features were expected.
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Single Feature Counts
Sometimes a workspace fails (usually with an ERROR) and only a single feature has emerged from a transformer:

In such a case it is likely to be the following transformer (here the Chopper) that is the cause of the problem. This part of the log
proves it:
ERROR |MAX_VERTICES clause must be specified for 'ChoppingFactory' definition, and must have a value of 1 or greater
Although 100 features enter the StatisticsCalculator and only 1 emerges, that transformer is not the source of the error. The error is
triggered when the first feature exits the StatisticsCalculator and reaches the Chopper. The Chopper basically failed before the
other 99 features had the chance to even reach it!

TIP
Again, the addition of <Rejected> ports on transformers means this scenario is becoming more and more
rare.
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Workspace Searching
FME Workbench includes a search tool for locating objects in a workspace according to a set of search text. This is an obviously
useful tool for debugging by looking up items mentioned in the log window.
The workspace search function is accessed through a hyperlink at the foot of the Navigator window:

Clicking this link opens up a text dialog in which to enter search terms. The results of the search include any attribute names,
feature types, transformers, parameter names, and parameter values that include the search term entered.

Searching is particularly useful in large workspaces, and when the same component is used throughout the workspace. For
example, in the above screenshot, maybe JoinID causes a problem in the Writer, but is actually defined (incorrectly) by a
transformer much earlier in the workspace.

Chef Bimm says...
What I especially like about the search tool is that it returns bookmarks and annotations too. Delicious!
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Testing Isolated Sections
Testing and debugging a large workspace is easier when it's possible to isolate sections and test them separately.
The ability to isolate specific sections is done by disabling connections. This renders a connection inoperative in much the same
way as if it had been deleted, and no features will pass through.
A connection is disabled by right-clicking it and choosing the option to Disable (or selecting it and using the shortcut Ctrl+E):

Disabled connections are listed in the Navigator window:

Here the user has chosen to disable connections so that they can test the first PointOnAreaOverlayer transformer without the
second one running as well:
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This speeds up the translation so that testing of the required section runs quicker.

TIP
An alternative to testing isolated sections is to run a workspace with the run option Run with Full
Inspection turned on.
However, be aware that:
Such an approach will take up more time and system resources
You will need to disable all Writers to avoid writing data
SQL and Python transformers may contain statements that will still change data (this is something
you should be careful of anyway)

Miss Vector says...
Of course, it's much easier to disable certain parts of a workspace when you've properly divided it up into
sections with bookmarks. Anyway, here's a question for you:
It's possible to disable other objects besides connections. Can you pick out which of these objects (there
may be more than one) can be disabled in Workbench?
1. Transformers
2. Feature Types
3. Annotation
4. Bookmarks
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Exercise 3

Debugging a Workspace

Data

GPS Roads data (JSON)

Overall Goal

Fix the bugs in someone else's workspace

Demonstrates

Debugging Best Practice

Start Workspace

C:\FMEData2016\Workspaces\DesktopBasic\BestPractice-Ex3-Begin.fmw

End Workspace

C:\FMEData2016\Workspaces\DesktopBasic\BestPractice-Ex3-Complete.fmw

As President of your local FME user group, you are responsible for checking projects that are submitted for presentation at your
monthly meetings. One day you receive this in an email:

Mr Flibble says...
I love driving across bridges! This workspace takes a set of GPS points, converts them to road lines, and
then shows where I drove across a bridge by clipping it against the Vancouver land boundary.

Unfortunately Mr Flibble is seriously in error, and has produced a very poor workspace. Rather than turn down his presentation,
let's help him debug the problems so it is worth sharing.

1) Start Workbench
Start FME Workbench and open the starting workspace.
Run the workspace and inspect any warning or error messages that occur.

2) Fix Translation
Track down all the problems in the workspace (I count five) and be sure to fix them.
Remember to make use of:
The FME Data Inspector
The Logger and Inspector transformers
Feature Counts
Log window WARNings and ERRORs.
Your output should look like this in the FME Data Inspector:
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.1 UPDATE
Notice - in the above screenshot for example - that some features are emerging from a "rejected" port. In
FME2016.1.1 a new workspace parameter controls what happens in that situation:

The options are to terminate the translation when rejected features are encountered, or to allow the
translation to continue. Workspaces created before 2016.1.1 will act as they always did - by allowing the
translation to continue. But, by default, new workspaces will terminate the translation.

CONGRATULATIONS
By completing this exercise you have learned how to:
Read the translation counts to locate a workspace problem
Used Inspector transformers to identify problems
Interpret a log file to ensure everything is correct
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Feature Debugging
Feature Debugging is a tool that allows individual features to be inspected, one-by-one, during a translation. As might be
imagined, this is very useful for debugging purposes.
Feature Debugging is triggered by "breakpoints"; workspace connections that are flagged by the user as a location where features
should be inspected.
Here a user wishes to inspect data after processing by the AttributeRenamer transformer.
A right-click on the connection and selection of Add Breakpoint is used to set it up.

The connection is highlighted blue with a red "stop" sign, to denote its new status.

Now the workspace is run using “Run with Breakpoints.”

.1 UPDATE
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In 2016.1 the Run with Breakpoints button on the toolbar got a different icon.

When the first feature arrives at the breakpoint, the translation is temporarily paused and information about the feature displayed
in a Feature Inspector window.
The upper part of the window shows a graphic representation of the feature; the lower part lists properties such as Feature Type
and Coordinate System; plus attribute and geometry information.

There are four buttons at the foot of the Feature Inspector window:
Button

Operation

Description

Step to Next
Connection

This tool steps through the workspace one transformer at a time, showing the status of a
feature as it is processed.

Step to Next
Breakpoint

This tool re-starts the translation, stopping the next time a feature reaches an inspection
point.

Continue
Translation

This tool re-starts the translation, ignoring all further breakpoints.
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Stop Translation

This tool stops the translation.

The currently active connection is highlighted orange to show it is the location where the translation is currently paused.
The current connection might be different to the original breakpoint when the "Step to Next Connection" tool has been used.

TIP
Use Feature Debugging when the output from a transformation is wrong and you can't tell why, or when
you suspect one particular feature is causing a problem. It's likely to help less when the problem is a crash
or ERROR in the log window.

Miss Vector says...
Now you've learned about Feature Debugging, why not try the previous exercise again, this time using
these techniques to show what happens step, by step?
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Organization
A goal without a plan, is just a wish!
A key part to any FME project is to keep organized and combine your efforts with other colleagues by sharing data and resources.
Luckily FME has a number of tools that can help you achieve this.
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Sharing Resources
Re-using components, and sharing them with fellow FME users, is vital in creating consistent designs among a large group of
employees. It also improves efficiency – because a translation author will not have to create every workspace from the beginning
– and reliability, because any change to a shared resource is passed on through any workspaces that make use of it.
Resources that may be shared include workspaces, custom transformers, custom formats, custom coordinate systems, and
templates.

Shared Files
The most basic method of sharing is simply giving someone else your workspace file. A function exists on the File menu in
Workbench to do just that:

Shared Resource Folders
A more advanced method of sharing is through a Shared Resource Folder. FME is able to identify resources stored in these
folders, and use them directly within a translation.
A shared resource folder can be used by just one person, or many.
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Using a shared folder is as simple as defining it using Tools > FME Options > Default Paths.
By specifying a location in this option, FME automatically searches for and uses any shared resources that are stored in this folder.

Resources that can be shared in this way include custom coordinate systems, custom transformers, custom FME themes, and
workspace template files.

TIP
Use a shared folder on your network as a shared resource folder when you have several FME authors who
all need access to the same resources, or just as a location to store your own files.
<user>/<documents>/<FME> is a shared resource folder created and used by default, without having to
define it within the options dialog.
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Templates
FME Templates are a particularly useful form of shared resource. Like similarly-named items in other software, FME templates
are a means of creating a workspace with/from a predesigned format and structure.
The closest analogy is to think of templates as a blueprint design.
They have their own extension (*.fmwt) and their own storage folder (<user>/FME/Templates).
Perhaps the most interesting thing about FME templates is that they can include source datasets within the file. This way both a
workspace example, and the data required to run it, can be bundled together and provided to another user.

What Are Templates For?
Templates have potentially very many uses. The most obvious ones are:
A Complete Translation
Wrapping up source data and workspace inside a single file makes it a very elegant way of providing a complete set of
translation files to another user.
Pre-Defined Data
When a series of workspaces are all to use the same source or destination data, a template allows the author to duplicate
Readers and Writers without having to recreate the workspace each time.
Pre-Defined Transformation
Templates are a great way to store a set of processing tasks for re-use. The end-user can simply create a workspace from
the template and add their own readers and writers.
An Example Translation
A template is also a great way to share demos and examples in a way that another user can run immediately.

Creating Templates
Templates are created by saving a workspace using File > Save As Template on the menubar:
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Miss Vector says...
Templates are very useful functionality. You really should be aware of how to create and use them.
What ways can a template be opened for use in FME Workbench (there might be more than one correct
answer):
1. Open it using File > Open
2. Open it using File > Open Recent Template
3. Double-click the fmwt file in Windows Explorer
4. Use Create Workspace from Template in the Getting Started part of the start tab
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FME Projects
FME is often used not just for one-off translations, but for a particular project or series of projects.
Project best practice involves suggestions more than hard and fast rules; but suggestions that are highly recommended!

Folder Structure
Project use of FME is more efficient when a proper project structure is maintained.
For example, assuming a special disk for storing projects (P:), a simple project structure could include a project ID if you have
one; for example: P:\P2016_999_PROPERTY_UPDATES
Follow this with subfolders, such as:
.\FMEworkspaces which could itself have subfolders such as
.\Templates for templates
.\Scripts for Python, SQL, or Tcl scripts
.\SourceData for storing source dataset files
.\OutputData for storing destination dataset files
.\NoteDocs&Stuff project estimates, specifications, proposals, etc.
.\Testing a folder for test data and workspaces
For a large scale FME project, set up a project structure and stick to it. Keep copies of all FME workspaces, maybe in a revision
control system like Subversion or GitHub.

File Naming
Based on past experience the Safe Professional Services team has the following recommendations for file and folder naming
within an FME project:
Use revision numbers on workspaces or folders; for example, myworkspace_rev17.fmw.
It's tempting to save to the same workspace all the time, but then there is no fallback position from a mistake.
When using dates for file names or folders, use international dates such as 2015-03-21 or 20150321 so files are listed in the
correct order. Do not use a date such as Mar-21-15, which will be listed alphabetically after April in Windows Explorer.
Reduce clutter in the project's main folder by saving files inside subfolders.
Avoid meaningless folderand filenames, such as 'fr_clnt'. From Client? Father Clint?!
Share ideas with others. Make sure all users conform to the same conventions.

Relative Paths
Although it isn't possible to browse for a relative path, it is possible to manually edit a path to be relative; for example, change
P:\P2016-999\SourceData\myfile.dgn to .\SourceData\myfile.dgn.
The advantage of doing this is that if the original project is renamed or even moved to a new location, all of the workspaces will
still function correctly without further editing.
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Module Review
This module was designed to help you use FME Workbench in the most efficient manner, to effectively manage FME related
projects, and to ensure those projects are scalable and portable.

What You Should Have Learned from this Module
The following are key points to be learned from this session:

Theory
Best Practice is the act of using FME in a manner that is efficient, but also easily comprehensible by other FME users.
Best Practice in FME can be divided into Methodology, Style, Performance, Debugging and Organization.

FME Skills
The ability to use Workbench in the right way, so as to provide maximum efficiency and productivity.
The ability to use bookmarks, annotation, and workspace settings to apply a well-designed workspace style.
The ability to interpret an FME log file at a basic level and to use debugging techniques to locate problems in a translation.
The ability to use FME as part of a larger project, in an organized and efficient manner.

Further Reading
For further reading why not browse articles tagged with Best Practice on our blog?
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Questions
Here are the answers to the questions in this chapter.

Miss Vector says...
Which of the following is NOT a method of creating a bookmark?
1. Click the Insert Bookmark button on the toolbar
2. Select a transformer, right click, choose Create Bookmark
3. Select multiple transformers, right click, choose Create Bookmark
4. Use the Ctrl+B shortcut

Miss Vector says...
Which of these is NOT a type of annotation in FME Workbench?
1. Header Annotation
2. Parameter Annotation
3. User Annotation
4. Summary Annotation

Miss Vector says...
It's possible to disable other objects besides connections. Can you pick out which of these objects (there
may be more than one) can be disabled in Workbench?
1. Transformers
2. Feature Types
3. Annotation
4. Bookmarks
OK, technically you can't disable a bookmark, but you can choose to disable all the objects within it.
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Miss Vector says...
What ways can a template be opened for use in FME Workbench (there might be more than one correct
answer):
1. Open it using File > Open
2. Open it using File > Open Recent Template
3. Double-click the fmwt file in Windows Explorer
4. Use Create Workspace from Template in the Getting Started part of the start tab
Yes! Every one of those is a valid method of using a template file!
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Exercise 4

FME Hackathon

Data

Roads (Autodesk AutoCAD DWG, Esri Shapefile, and/or PostGIS)

Overall Goal

Find the shortest route from the hackathon to an Italian Cafe

Demonstrates

Data Translation, Transformation, and Best Practice

Start Workspace

None

End Workspace

C:\FMEData2016\Workspaces\DesktopBasic\BestPractice-Ex4-Complete.fmwt

A regional GIS group is holding an FME Hackathon and you have been invited to take part.
You have been provided with a set of source data and asked to create a useful project from it. You decide that it would be
interesting to produce a tool that maps the route from the hackathon venue to a cafe the where a group get-together will be held
that evening.
So, your task is to use the data available to you to calculate the best route from the convention centre to the cafe, and to write out
that data to GPX format so folk can use it in their GPS/mobile device.

1) Create Database Connection
The source data has been provided in a PostGIS database; therefore our first task should be to create a connection to it. That way
we can use the connection instead of having to enter connection parameters.
In a web browser visit http://fme.ly/database - this will show the parameters for a PostGIS database running on Amazon RDS.
In Workbench, select Tools > FME Options from the menubar
Click on the icon for the Database Connections category, then click the [+] button to create a new connection. In the "Add
Database Connection" dialog, first select PostgreSQL as the database type. Then enter the connection parameters obtained through
the web browser.

Give the connection a name (such as Hackathon PostGIS Database) and click Save. Then click OK to close the FME Options
dialog.
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2) Inspect Data
Start the FME Data Inspector to inspect the dataset we will be using. Select File > Open Dataset and, when prompted, enter the
following:
Reader Format

PostGIS

Reader Dataset

Hackathon PostGIS Database

Parameters

Under Table List choose Roads and One-Way Streets

Click OK to close the dialogs and open the data. Change the color of the one-way streets so you can see that they are a different
set of features. It's important to know which roads are one-way if we want to calculate a route that is actually legal!

*NB: If you have any problems using the PostGIS database - for example connectivity problems with a firewall - then the
following AutoCAD dataset can be substituted with very few changes required:*
Reader Format

Autodesk AutoCAD DWG/DXF

Reader Dataset

C:\FMEData2016\Data\Transportation\OneWayStreets.dwg

3) Start Workbench
Start Workbench and use the option to Generate a workspace.
Reader Format

PostGIS

Reader Dataset

Hackathon PostGIS Database

Parameters

Under Table List choose Roads and One-Way Streets

Writer Format

GPS eXchange Format (GPX)

Writer Dataset

C:\FMEData2016\Output\Training\Route.gpx

The workspace will look like this:
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For the sake of Best Practice, you may want to put a bookmark around these features, and maybe annotate which are the one-way
streets.

4) Add ShortestPathFinder
Now we need to start calculating a route. The obvious first step is to add a ShortestPathFinder transformer, which is how we can
calculate our route.
So, add a ShortestPathFinder transformer. Connect Roads to the Network port.

.1 UPDATE
The ShortestPathFinder transformer in the above (and following) screenshots gained a Reordered port in
FME2016.1

5) Add Creator
The other input port on the ShortestPathFinder is for the From-To path (the start and end points of our journey). To add a feature
to input here we can manually create it with the Creator transformer.
Add a Creator transformer and connect it to the From-To port.
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Open the Creator parameters dialog.
Firstly enter UTM83-10 as the coordinate system of the data we are about to create. For the Geometry Object parameter, click the
[...] browse button to the right to open a geometry-creation dialog. Select Line as the geometry type and enter the following
coordinates:
X 491500 Y 5459550
X 494500 Y 5457440

The first coordinate is that of the hackathon venue and the second is the closest point in our network to the cafe we're going to
visit.

Click the OK button to close the dialog.

6) Check ShortestPathFinder Parameters
The coordinates of the feature we've added might not sit exactly on the road network. To get around this issue there are parameters
we can use in the ShortestPathFinder.
So, open the ShortestPathFinder parameters dialog. Under Snap Options set From-To Snapping to Yes and enter 150 as the
Snapping Tolerance:

Also notice that there are parameters for network costs - we'll be making use of those later.
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7) Run Workspace
Add some Inspector transformers after the ShortestPathFinder and run the workspace to prove it is working up to this point.

If all has gone well, the output will look like this, with a route defined:

Tiles Courtesy of MapQuest

Of course, if all has not gone correctly, you must make use of Inspector and Logger transformers, plus Feature Debugging, to try
and locate the error!

8) Add ChangeDetector
The result looks fine, but there are some things we are yet uncertain about: what if the route takes us the wrong way down a oneway street; and what if it uses slower, residential routes?
The first issue we can fix - most quickly - by ignoring one-way streets (i.e. avoiding them).
This we can implement in FME by matching up one-way streets so we can remove them from the network.
Add a ChangeDetector transformer to the workspace. Connect the Roads feature types to the Original port and the OneWayStreets
feature type to the Revised port: i.e the Roads feature type includes one-way streets, and we can match them with the One-Way
Streets feature type to filter them out:

217

Exercise: Shortest Route Hackathon

Open up the ChangeDetector parameters. Note that we are matching geometry (correct) so don't change any parameters, just click
OK to close the dialog.
By using the ChangeDetector road features that match a one-way street will emerge from the Unchanged port, so we should leave
this unconnected. Similarly, Added features will be oneway streets that haven't been matched, and we can leave these out too.
So connect the Deleted port to the ShortestPathFinder Network port. The "Deleted" features are those that the transformer thinks
have been deleted because they exist as roads, but not in the one-way data.

9) Re-Run Workspace
Now re-attach any Inspector transformers (if necessary) and re-run the workspace. Check the new route. If it has changed from
before then you know this is because it is now avoiding oneway streets. This might not be the shortest route, but it's one we can
confidently follow without heading directly into incoming traffic!

10) Add AttributeValueMapper
To weight our route in favour of arterial roads (not residential) we need to give each type of route a cost.
The best solution is an AttributeValueMapper transformer; so place one of these into the workspace.
After the ChangeDetector will be the best location, as then some features will have already been filtered out and this transformer
will have less work to do.
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11) Edit AttributeValueMapper
Now we can set up the AttributeValueMapper transformer. Open its parameters dialog:
Select 'type' as the Source Attribute
Enter Cost as the Destination Attribute
Enter 2 as the Default Value

Now, underneath those parameters, we'll map some data.
Enter "Arterial" into the first Source Value field and a value of 1 in the matching Destination Value.
Enter "Residential" into the second Source Value field and a value of 3 in the matching Destination Value.

Basically, if the route is arterial (a main road) it will get a cost of 1; residential routes will get a cost of 3 and all other types will
get a cost of 2 (because that's the default value). Click OK to close the dialog.

12) Apply Costs
Now we'll apply that newly calculated cost in the ShortestPathFinder.
Open the ShortestPathFinder parameters dialog. Set the Cost Type parameter to be "By Two Attributes".
Select "Cost" as the attribute for both the Forward and Reverse cost parameters (i.e. it will cost the same whichever direction the
road feature runs and whichever direction we travel along it).
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First-Officer Transformer says...
If we knew that the one way streets were connected in the right direction (i.e. from the first vertex to the
last was the actual direction of travel) we could just set a weighting of 999 for the reverse cost and that
would leave them out. Since this isn't our data we can't be sure of that, so our method is safer.

13) Run Workspace
The workspace will now look like this:

Save and then run the workspace. You'll find that your new route directs you from the convention centre to Commercial Drive
avoiding one-way streets and taking the slowness of residential routes into account.

14) Connect Schema
Oh! Don't forget to remove the Inspector transformers and connect the Path port to the Route output feature type:

Now run the workspace, upload the data to your GPS device, and you are ready to go!

Advanced Exercise
Not really advanced, but you did use Best Practice throughout, right? I mean, you have bookmarks and
annotations where needed, and no overlapping connections? If not, well you might want to fix that!
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CONGRATULATIONS
By completing this exercise you proved you know how to:
Create and use an FME database connection
Create an FME workspace and use transformers
Use debugging techniques to find any problems encountered in an exercise
Use a good style for developing workspaces
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Translation Components
An FME translation is made up of a number of different components.
For each component there are:
Tools to create, add, or remove them
Parameters to control them
It’s very useful to have an understanding of FME components, especially when you work with multiple datasets or multiple
formats.
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Key Components
The list of key components in an FME translation is as follows:
Workspace
Readers and Writers
Feature Types
Features

TIP
This section covers “official” FME components only. For example, it won’t cover any user-defined Python
scripting that might be used to exert control over several workspaces.
However, once you understand the structure, it’s easy to imagine where such custom components might fit
it.

Workspace
A workspace is the primary element in an FME translation and is responsible for storing a translation definition. A workspace is
held as a file with an .fmw file extension. It can be run in either the Quick Translator or FME Workbench, but can only be opened
for editing in Workbench.
Think of a workspace as the container for all the functionality of a translation.

Readers and Writers
A Reader is the FME term for the component in a translation that reads a source dataset. Likewise, a Writer is the component that
writes to a destination dataset.
We'll see that Readers and Writers don’t appear as objects on the Workbench canvas, but instead are represented by entries in the
Navigator window.

Feature Types
Feature Type is the FME term that describes a subset of records. Common alternatives for this term are 'layer,' 'table,' 'sheet,'
'feature class,' and 'object class.' For example, each layer in a DWG file is defined by a feature type in FME.
Feature Types are the brown-colored objects that appear on the Workbench canvas.

TIP
Don’t confuse the term Feature Type with Geometry Type.
Feature Type means “layer;” Geometry Type means “lines,” “points,” “polygons.”
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Features
Features are the smallest single components of an FME translation.
They aren’t individually represented within a workspace, except by the feature counts on a completed translation.
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Component Hierarchy
It’s important to notice that all these components exist in a related hierarchy:

The workspace is at the top level, followed by Readers and Writers, feature types, then features.
Hierarchy is an important concept because it affects how components are added to a translation, and - more importantly - how
they are controlled.

One-To-Many Relationships
The hierarchical relationship between workspace, readers, writers, feature types, and features isn't always one-to-one; often it is a
one-to-many (1:M) relationship with the level beneath:
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A single workspace can contain any number of Readers and Writers, each Reader can contain a number of feature types, and each
feature type can contain any number of features within it.
This means that a single workspace can read and write multiple datasets, in multiple formats, with multiple layers, and multiple
features per layer.
Now we know what these components are, let's look at each of them individually, in detail, to see how they can be managed and
how they can be controlled.

Miss Vector says...
Here's a fun question to test your knowledge of formats. Here are four different formats and four different
terms for "feature type". Connect the format to the correct terminology.
Format

Feature Type Terminology

Oracle Spatial

Level

MicroStation Design

Layer

Esri Geodatabase

Table

Adobe PDF

Feature Class
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Workspaces
A workspace is a file responsible for storing a translation definition.
Workspaces are the primary containers of translation components. At the top of the hierarchy they can contain any number of
Readers, Writers, and feature types; or sometimes none at all!

Creating a Workspace
Workspaces can be created using the commands on the File menu, or through shortcuts in the Start tab.

Creating a workspace through the Generate option is a simple way to define a translation because it includes Reader, Writer and
feature type components in the setup process.
However, a workspace can also be created empty - i.e. the canvas is blank and each new component is added from scratch.
The option "Create workspace from template" allows the user to create a workspace based on a template design. That template can
come from either the user-defined templates, templates installed with FME, or templates available on the FME Store.

Controlling a Workspace
Workspace parameters are those that relate to a workspace as a whole, and which have an effect on how the translation is
performed. They apply to the current workspace only and may change between workspaces.
Workspace parameters are shown and set in the Navigator Window.
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For ease-of-use, workspace parameters are divided into two sections: basic and advanced. The most-important and most-used
parameters fall under the Advanced section.

Logging Parameters
There are three logging parameters. The Log File (basic) parameter specifies where the log file is written to. This is important
when you want to keep that file for future reference. For example, you might (as an advanced task) create a user parameter to set
the Log File location to C:\LogFileStorage\<date/time> so that each log file is recorded with a different file name matching the
translation date/time.
The Max Features to Log and Max Logged Features to Record (advanced) parameters control how many features that are
incorrect will be recorded in the log (or spatial log file). Often, just knowing that one feature was logged as a problem is enough to
revisit the source data; you don't need to pad the log file by logging every single problem feature.

Reprojection Engine
Different GIS applications have slightly different algorithms for reprojecting data between different coordinate systems. To ensure
that the data FME writes matches exactly to existing data, this parameter permits a user to use the reprojection engine from a
different application.
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A user with ArcGIS installed is choosing to use that package’s engine for reprojecting the spatial data.

Start-up and Shutdown Scripts
These parameters deliver the ability to run a Tcl or Python script. A startup script is executed when the run button is pressed,
before any of the workspace is processed. A shutdown script is executed directly after the workspace has finished writing data.

Potential uses of such scripts include:
To check a database connection before running the translation
To move data prior to or after the translation
To write the translation results to a custom log or send them as e-mail to an administrator
To run scripts from other applications; for example Esri ArcObjects Python scripts
An interpreter parameter allows the user to choose which version of Python will be used to run any scripts:

If you choose "2.7 or 3.4+" then you are telling FME that your script is compatible with both versions of FME and that it doesn't
matter which one FME uses.

.1 UPDATE
Notice that in FME2016.1.1 a new workspace parameter controls what happens when features emerge
through the rejected port of a transformer:

The options are to terminate the translation when rejected features are encountered, or to allow the
translation to continue. Workspaces created before 2016.1.1 will act as they always did - by allowing the
translation to continue. But, by default, new workspaces will terminate the translation.
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Exercise 1

Creating a Workspace

Data

City Parks (MapInfo TAB)

Overall Goal

Create a set of data for mapping a recreational event

Demonstrates

Workspace component and parameters

Start Workspace

None

End Workspace

C:\FMEData2016\Workspaces\DesktopBasic\Components-Ex1-Complete.fmw

The city is hosting a fundraising walk for a major charity. There will be many thousands of people taking part and good
organization of the event is vital. One of the requirements is a map for participants and you have been tasked with using FME to
put together the data that will form the map.
The data required for this project (and the format it is held in) includes:
Dataset

Format

Location

Park outline

MapInfo TAB

C:\FMEData2016\Data\Parks\Parks.tab

Trail Route

Comma Separated
(CSV)

C:\FMEData2016\Data\GPS\WalkingTrail.csv

Food vendors

Esri File Geodatabase

C:\FMEData2016\Data\CommunityMapping\CommunityMap.gdb

Parking facilities

OpenStreetMap

C:\FMEData2016\Data\OpenStreetMap\amenity.osm

Roads into/out of
park

OpenStreetMap

C:\FMEData2016\Data\OpenStreetMap\highway.osm

The outputs required are Google KML and GPX. So with this and the amount of input data, you will need to add lots of Readers
(and Writers) to your workspace.

1) Inspect Data
As usual, the first thing to do is inspect the source data. There is a lot of it and - in many cases - the required data is just one
feature or one layer within a larger dataset. The final dataset we want will look something like this:
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2) Create Workspace
OK. Let's get going. Start FME Workbench and choose the option to generate a workspace. We'll start with the parks data so,
when prompted, enter the following choices:
Reader Format

MapInfo TAB (MITAB)

Reader Dataset

C:\FMEData2016\Data\Parks\Parks.tab

Writer Format

Google KML

Writer Dataset

C:\FMEData2016\Output\Training\FundraisingWalk.kml

3) Add Tester
The park that the walk is taking place in is called Stanley Park. Add a Tester transformer and use it to filter out any park features
that are not part of Stanley Park:

Run the workspace (as you can see from above, only 1 feature passes the test) and view the output in either the FME Data
Inspector or Google Earth.

4) Add Shutdown Script
The organizing team has created a share folder for materials. We could write our data to it directly, but instead let's write a the file
to our system, then copy it to the centrally shared folder.
Locate the workspace parameter called Shutdown Python Script and double-click it to open an editor window. In the window
enter the following code (NB: The code can be copied from the file: C:\FMEData2016\Resources\ComponentsExerciseScript.py):
import shutil
import os
if not os.path.exists('C:/FundraisingWalk'):
os.makedirs('C:/FundraisingWalk')
shutil.copy2('c:/FMEData2016/Output/Training/FundraisingWalk.kml',
'C:/FundraisingWalk/FundraisingWalk.kml')

You'll notice that we're not really writing to a shared folder, just a different folder on our own system. That's OK. It's not a real
project! Anyway, the workspace parameters should look like this:
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5) Run Workspace
Run the workspace. You should see that the 'shared' folder is created (assuming it doesn't already exist) and the data is copied to it.
This is an excellent example of the sort of thing you might be with a shutdown script.

Aunt Interop says...
If the workspace fails because of a Python error (it shouldn't, but just in case), don't worry about it.
Everyone has a failure sometime. We aren't here to debug Python so just erase the script from the
parameter and carry on. The important part is that you can see the type of thing a script can do and know
where the parameters are to use them.

CONGRATULATIONS
By completing this exercise you have learned how to:
Create a new workspace with Reader and Writer as the first step in a larger project
Locate and use a Python shutdown script
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Readers
Readers are the main components that read data in FME.
A Reader is the FME term for the component in a translation that reads a source dataset. A Reader reads a single format of data, so
to read multiple formats requires multiple Readers. However, each Reader can read any number of datasets in its format.
By default, the Generate Workspace dialog creates workspace with a single Reader (and a single Writer). However, this does not
mean the workspace is forever limited to this. Additional Readers can be added to a workspace at any time, any number of
formats can be used, and there does not need to be an equal number of Readers and Writers.
For example, the Navigator window shows this workspace contains 50+ Readers and Writers of all data types and formats!

Ms. Analyst says...
It's important to note that Readers and Writers don’t appear as objects on the Workbench canvas. Their
feature types (layers) do, but Readers and Writers don't.
Instead they are represented by entries in the Navigator window, as in the above screenshot.
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Adding a Reader
Adding a Reader to a workspace is a common requirement. There are several reasons:
The Generate Workspace dialog only adds a single Reader
Each Reader handles only one format of data
Different datasets (of the same format) may require reading with different parameters
Therefore the need to read multiple formats of data – such as Smallworld, DXF, and Geodatabase – requires multiple Readers.

Additional Readers are added to a translation using Readers>Add Reader from the menubar.

Adding a Reader has this effect on the hierarchy diagram:
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Removing a Reader
Not only can you add a new Reader, you can remove an existing one; for example when you have an old Reader whose input you
no longer need. Tools exist to remove a Reader from a workspace, both on the menubar and in context menus in the Navigator
window.

Removing a Reader obviously has the reverse effect on the hierarchy diagram!
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Controlling Readers
Readers are controlled with Reader parameters.
Because parameters refer to specific components and characteristics of the related format, Readers of different formats have a
different set of control parameters.

Reader Parameters
Reader parameters can be located - and set - in one of two locations.
Firstly, these parameters can be found in a dialog when a new workspace is being generated, or a new Reader added:

Secondly, after the workspace is generated/Reader is added, parameters are shown and set in the Navigator Window.
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For ease-of-use, basic parameters are listed first, then the remainder are divided into a number of sections: Advanced, Search
Envelope, and Features to Read.
In general, basic parameters are the ones used most often; advanced parameters a little less so. Search Envelope parameters relate
to the geographic area of data to be read, and Features to Read parameters give control over how many features will be read and
from which layers.
To edit a parameter, double-click it. A dialog opens up where the parameter’s value may be set.

Dr. Workbench says...
Some Reader parameters are ONLY accessible through the Parameters button when you initially create a
workspace or add the Reader to an existing workspace. That’s because they affect how the schema is read
and therefore how the workspace is constructed.
It’s like preparing a patient for surgery. Once the workspace (patient) is created (prepped) those
parameters aren’t available because you’re past the point where they would have any effect.
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Of course, sometimes you get such a parameter wrong, in which case you simply recreate the workspace.
Or find yourself a new patient!
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Reader Dataset Parameter
Of course, perhaps the most important parameter is that which defines the dataset to be read. This too is found in the Navigator
window:

As usual, double-clicking the parameter opens a dialog for it to be changed. You can change the dataset being read by selecting
any other dataset - of the same format - within that dialog.

Multiple Dataset Selection
As long as the format is file-based (i.e. not a database) a Reader is capable of reading multiple source datasets:

To do this, when selecting the dataset to read simply select multiple files instead of a single one.

TIP
When selecting a source dataset, an advanced file browser is available. This allows you to select files from
different folders, all at the same time!

241

Reader Dataset Parameter

File Dataset Types
When dealing with files it's useful to consider datasets as existing in two differnt forms: File-based and Folder-based

File-Based Datasets
A file-based dataset is just that: a single file that contains all layers of data. A format of this type has an internal structure that
assigns data to different layers within the file.
Good examples of this are:
AutoCAD DWG: Each DWG file is a dataset containing its own set of layers
Microsoft Excel: Each Excel file is a dataset containing a set of sheets
In this scenario the dataset parameter is simply a pointer to the location of the file(s), here a single AutoCAD dataset:

Folder-Based Datasets
A folder-based dataset is still made up of files (of course). However, a format of this type DOES NOT have an internal way to
define layers. Therefore each layer becomes a separate file within a folder.
Good examples of this are:
Esri Shapefile: To store different layers requires multiple Shapefiles: e.g. roads.shp and railways.shp
Comma-Separated (CSV): To store separate tables requires two separate CSV files
In this scenario the dataset parameter is a pointer to the individual files, here a set of layers in a shapefile dataset:

Sister Intuitive says...
Both File or Folder dataset parameters can be pointers to a Zip file. You simply select the zip file in the
source parameter and FME will extract the data when it is being read.
Similarly, a File or Folder dataset can be read directly from a URL. Simply enter the URL into the source
parameter. For Folder datasets the URL must point to a zip file containing all of the relevant files.
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Exercise 2

Adding Readers

Data

City Parks (MapInfo TAB)
Walking Trail (CSV)

Overall Goal

Create a set of data for mapping a recreational event

Demonstrates

Readers and Reader Parameters

Start Workspace

C:\FMEData2016\Workspaces\DesktopBasic\Components-Ex2-Begin.fmw

End Workspace

C:\FMEData2016\Workspaces\DesktopBasic\Components-Ex2-Complete.fmw

Let's continue your work on the fundraising walk project.
In case you forgot, the city is hosting a fundraising walk for a major charity and you have been tasked with using FME to put
together the data that will form the event map.
In this part of the project we’ll add another of the source datasets to the workspace as a Reader. This format will need close
inspection of the Reader parameters to make sure we're reading the data correctly.

1) Start Workbench
Start Workbench (if necessary) and open the workspace from Exercise 1. Alternatively you can open
C:\FMEData2016\Workspaces\DesktopBasic\Components-Ex2-Begin.fmw

2) Add Reader
The existing workspace already has a Reader for MapInfo (parks) data. Now let's add one for the most important dataset - the
walk trail. This was walked by a colleague and captured on his GPS device.
Select Readers > Add Reader from the menubar in Workbench. When prompted fill in the following details (but don't press OK):
Reader Format

CSV (Comma Separated Value)

Reader Dataset

C:\FMEData2016\Data\GPS\WalkingTrail.csv

Now press the Parameters button. This brings up a parameters dialog that is rather large and looks like this:
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The dialog includes various parameters for this Reader and a preview of what the source dataset looks like. By default the
Separator Character should be a comma (change it to a comma if it is not) and the File Has Field Names parameter should be
turned on.
In the lower part of the dialog - under Schema Attributes - change the type of the Latitude attribute to a Y_Coordinate and the
Longitude attribute to an X_Coordinate:

By setting these parameters FME will convert the plain-text CSV data into true spatial features. Click OK to close this dialog and
OK again to close the Add Reader dialog.

Mr. Statistics-Calculator says...
Some things just won't wait. It's important to set these parameters now as they affect how the schema is
depicted on the canvas. If I mess this up I'd have to delete the Reader and re-add it. That's not an efficient
use of time and resources.
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3) Check Reader Parameters
Locate the Reader in the Navigator window and expand the list of parameters to see what there is:

Notice that some of the parameters we set earlier are no longer available. That's because they specified how to define the feature
type schema, and it's too late to set them now.
Other parameters we could set, but don't really need to (the data should already be sorted in the correct order, for example, so we
don't need to apply the sort parameter).

4) Add Reprojector
The one issue with the CSV data is that it is in a Latitude/Longitude coordinate system, and not the same UTM system as used by
the parks data. Let's fix that by adding a Reprojector transformer to the workspace:

Open the Reprojector parameters dialog and set it to reproject from LL83 to UTM83-10

5) Run Workspace
Feel free to add Inspector transformers and run the workspace to inspect what we have created so far.
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Tiles Courtesy of MapQuest

CONGRATULATIONS
By completing this exercise you have learned how to:
Add Readers to a workspace
Set parameters when adding a new Reader
Set parameters after adding a new Reader
Convert CSV attributes into spatial features
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Reader Feature Types
As per the hierarchy diagram, each Reader in FME can have a number of feature types. Feature types define the layers being read
from a source dataset and the attributes that those layers possess. They are represented as objects on the workspace canvas and
also listed in the Navigator window.
In this workspace, a Reader is reading a source dataset of roads, with a different layer for each road type. Notice the Reader in the
Navigator window and how it has a list of feature types; then notice that each of these feature types is also depicted on the canvas:

In this workspace there are two Readers (one Esri Shapefile, one File Geodatabase). Each Reader has three different feature types.
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Notice - and this is where is can be confusing - there is no visible connection between the Reader and its feature types.

TIP
Clicking on a feature type in the Navigator will highlight it on the canvas - and vice versa

Adding Reader Feature Types
Adding a new Reader is the point at which most feature types are added to the translation.
For a file dataset (like AutoCAD) FME scans the source dataset(s) and prompts you which feature types to add to the canvas. If a
feature type is selected, then it will appear in the workspace and data on that layer will be read. If it is not selected then the feature
type will not appear in the workspace and the data is discarded.
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For a folder dataset (like Esri Shapefile) the user should just select the files that represent the feature types:

For a database (like PostGIS) the user should click the parameters button and use the Tables to Read parameter:

Note that it’s not necessary to select all feature types that exist in a dataset. If you don’t want to read a particular layer of data,
don’t select it. This way the feature types that you need to be read are all represented on the canvas, and feature types you don’t
need are not.

Removing Feature Types
Feature types can be deleted by selecting them on the canvas and pressing the delete key. They can also be deleted using the
remove feature types tool on the menubar:
A user might delete a feature type is there is a source dataset layer that they no longer wish to read.
Whenever all feature types are deleted from a Reader then FME will prompt the user to decide whether to remove the Reader
component as well.
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It makes sense to remove the Reader because if there are no feature types you wish to keep, why would you still wish to read the
dataset at all? So Yes is the most common choice here.
If you answer No, then the feature types are all removed, but the Reader is left in the translation. We call this a "dangling” Reader
because it has no children in the hierarchy.

Chef Bimm says...
A dangling Reader isn’t that useful, and the workspace should definitely not be run in this condition!
Performance suffers because all the source data is still being read, yet discarded immediately.
It's like ordering food in a restaurant for a friend who you know is not coming: a waste of time and
resources!
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Importing Reader Feature Types
A further tool under the Reader menu is labelled Import Feature Types.
Importing feature types is like when you add a new Reader; you pick the format and source dataset and FME gives you a list of
feature types to add. However... instead of creating a new Reader, the feature types are added to a Reader that already exists.

One reason to import feature types is to read extra feature types from a dataset. Maybe they chose not to read those feature types
when they added the Reader, or maybe the dataset was edited to give it extra layers.
The way to do this is to use the menu tool Readers > Import Feature Types:
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For example, the user has created a workspace with a Reader that reads a dataset called 'Transportation'. The only feature type
chosen at the time of creation was a layer called 'Roads'. If the workspace now needs to read a second layer from the dataset (say
'Railway') the import tool can be used to add it to the existing Reader.

Firefighter Mapp says...
There's no tool to add a Reader feature type in a manual way. That's because Reader feature types are
supposed to represent what already exists in a source dataset - and it's easier to just import a definition
from one of them.
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Updating Reader Feature Types
A final tool for Reader feature types allows you to update them:

When you have created a workspace and more tables are added, then the Import tool is the one to use. However, when the schema
of an existing table has changed, then the update tool is the one to use.
For example, I have a source feature type with this attribute schema:

The database administrator decides that the three PostBox attributes are no longer required and removes them from the database
table. To fix my FME workspace to match, I would use the Update Feature Types tool.

Miss Vector says...
Let's see if you can figure out which tool should be used in which scenario? Here are four scenarios and
four tools or settings. Connect the scenario to the correct tool/setting.
Scenario

Tool

Source filename changes

Add Reader
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Attribute type changes in database

Import Feature Type

Additional database table needs reading

Update Feature Type

New file dataset needs reading

Source Dataset Parameter
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Reader Feature Type Parameters
Just like Readers, feature types have their own set of parameters that control how that feature type (layer/table) is being read.
These parameters appear under the Format Parameters tab in the Feature Type Properties dialog:

The important thing is that these parameters only apply to a single feature type, whereas a Reader parameter would apply to all
feature types.
For example, when reading a SQL Server database there is a feature type parameter that defines the name of the geometry column
to read:

This is a Feature Type parameter because each table might have a different geometry column name, therefore each feature type
needs a way to define it. If, for example, four tables were being read, the user could set a different geometry column name for
each.
Conversely, there is no password parameter at the feature type level because authentication applies to the entire database, not the
individual tables. Authentication parameters are at the Reader level in the Navigator window:

TIP
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Not all feature types need a set of parameters, so the Format Parameters tab is not always present.
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Exercise 3

Reader Feature Types

Data

City Parks (MapInfo TAB)
Walking Trail (CSV)
Food Vendors/Water Fountains (File Geodatabase)

Overall Goal

Create a set of data for mapping a recreational event

Demonstrates

Handling and Controlling Reader Feature Types

Start Workspace

C:\FMEData2016\Workspaces\DesktopBasic\Components-Ex3-Begin.fmw

End Workspace

C:\FMEData2016\Workspaces\DesktopBasic\Components-Ex3-Complete.fmw

Let's continue your work on the fundraising walk project.
In case you forgot, the city is hosting a fundraising walk for a major charity and you have been tasked with using FME to put
together the data that will form the event map.
In this part of the project we’ll add another of the source datasets to the workspace.

1) Start Workbench
Start Workbench (if necessary) and open the workspace from Exercise 2. Alternatively you can open
C:\FMEData2016\Workspaces\DesktopBasic\Components-Ex3-Begin.fmw

2) Add Reader
The existing workspace already has various Readers; now it needs one for loading a layer of food vendor data. This is stored in
the Community Mapping Geodatabase
Select Readers > Add Reader from the menubar in Workbench. When prompted fill in the following details:
Reader Format

Esri Geodatabase (File Geodb API)

Reader Dataset

C:\FMEData2016\Data\CommunityMapping\CommunityMap.gdb

This dataset contains several tables, but we only need one of them. So, when prompted, deselect all feature types and leave only
FoodVendors selected:
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3) Remove FoodVendors Feature Type
No sooner have you added the FoodVendors layer to the workspace than the telephone rings. It is the event organizers. Instead of
showing food vendors on the map, they now want to simply show the location of drinking fountains.
Muttering under your breath, click on the newly added feature type for FoodVendors and press the delete key. You will see this
dialog appear:

The dialog appears because FoodVendors is the only feature type in the workspace for this Reader. It is asking if we wish to delete
the Reader component as well, since there are no feature types left to read.
Usually the answer is Yes. However, we wish to now read the DrinkingFountains data. We could choose to delete the Reader and
just add a new one. But, because DrinkingFountains is a table in the same geodatabase as FoodVendors there is another way.
So, click No in this dialog.

4) Import DrinkingFountains Feature Type
Now we have a Reader reading from a Geodatabase, but without feature types. You can see that if you look in the Navigator
window. Let's fix that. Click Readers > Import Feature Types on the menubar.
The first dialog that pops up will ask you which Reader you want to import the feature type to. Select the Community Mapping
Geodatabase:
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Now you are prompted which dataset you wish to import the feature type from. Enter the details (as above) for the Community
Mapping Geodatabase:

Finally you are prompted to select the feature type to import. In this case deselect all tables except for DrinkingFountains:

This will add the DrinkingFountains feature type to the workspace.

5) Add Clipper
If you recall the Community Maps dataset covers the entire city, and yet we're restricting the map to the park boundaries. To cut
the excess data away we'll use a Clipper transformer, so add one to the canvas. Then...
Connect the Tester:Passed port to the Clipper:Clipper port.
Connect the CommunityMap:DrinkingFountains feature type to the Clipper:Clippee port:
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You can check the transformer parameters, but the defaults should be fine for this project.

6) Run Workspace
Again, add Inspectors and run the workspace to ensure the result is what we are expecting.

Tiles Courtesy of MapQuest

CONGRATULATIONS
By completing this exercise you have learned how to:
Delete feature types from a workspace
Handle the options when the final feature type in a Reader is deleted
Import a feature type from a dataset into a Reader in the workspace
Use the Clipper transformer to clip data
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Managing Datasets and Feature Types
We've already seen that when you add a Reader to a workspace its feature type schemas are greyed out. That's to ensure that no
edits are made and that the schema matches the source data.
However, there are other ways in which the Reader schemas can become out of sync with the source datasets they claim to
represent.

Limiting Source Data
In some - maybe most - workspaces, the user does not need or want to read the entire source dataset.
For example, an AutoCAD DWG dataset includes layers for Roads, Railways, Rivers, and Vegetation. If my project only requires
transportation layers (i.e. Roads and Railways) I don't need to read any data from the other layers (Rivers and Vegetation).
When a Reader is added, the user is given the choice of which feature types to add to the workspace, and does not need to include
all of them. This is how they can choose not to read all of the data:

What this means is that the workspace schema is now a little out of sync with the source data, as it doesn't have the same set of
feature types.

Changing Source Dataset Parameter
As we have seen, each Reader in a workspace contains a source dataset parameter. This is set at the time of creation, but it can be
edited at a later time. Selecting a different source dataset is another way for workspace schemas to become out of sync with the
data.
For example, an AutoCAD DWG dataset (file1.dwg) includes layers for Roads, Railways, Rivers, and Vegetation, all of which are
added as feature types:
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However, the user then changes the source dataset parameter to read a different dataset (file2.dwg):

If that dataset contains layers for Airports, Sports Facilities, Shops, and Natural Features, then the workspace schema will be very
much different to the source data being read.

Consequences
It’s important to remember that the original dataset establishes the basis for the Reader schema definition, and that problems arise
if subsequent datasets do not conform to this original schema.
In this scenario data whose feature type does not match one in the workspace is automatically discarded; i.e. Reader feature types
defined in the workspace act as a type of filter through which incoming data must pass.
The incoming feature types are unexpected, and so the filter is called the Unexpected Input Remover.
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Exercise 4

Unexpected Input

Data

City Parks (MapInfo TAB)
Walking Trail (CSV)
Water Fountains (File Geodatabase)
Car Parking (OpenStreetMap)
Roads (OpenStreetMap)

Overall Goal

Create a set of data for mapping a recreational event

Demonstrates

Handling Unexpected Input

Start Workspace

C:\FMEData2016\Workspaces\DesktopBasic\Components-Ex4-Begin.fmw

End Workspace

C:\FMEData2016\Workspaces\DesktopBasic\Components-Ex4-Complete.fmw

Let's continue your work on the fundraising walk project.
In this part of the project we’ll add some OpenStreetMap format data to the workspace.

1) Start Workbench
Start Workbench (if necessary) and open the workspace from Exercise 3. Alternatively you can open
C:\FMEData2016\Workspaces\DesktopBasic\Components-Ex4-Begin.fmw

2) Add Reader
Let's add some more data. This time we'll add the car parking. Select Readers > Add Reader and choose the following data:
Reader Format

OpenStreetMap (OSM) XML

Reader Dataset

C:\FMEData2016\Data\OpenStreetMap\amenity.osm

Reader Parameters

Feature Types: Use Specific Features

The parameter is important because it specifies what feature types we will be presented with:

If we go with the Broad feature types, we will be presented with a broad set of layers and car parks will be hidden inside
Amenities. If we go with Specific feature types we can select only car parks by themselves.
So, click OK to close this dialog and OK to add the Reader. When prompted, deselect all feature types and leave only
amenity_parking selected:
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3) Add Reprojector
Like the trail data, OSM is in a Latitude/Longitude coordinate system, and not the same UTM system as used by the parks data.
So add a second Reprojector to the workspace to reproject the amenity_parking feature type from LL84 to UTM83-10

4) Run Workspace
Add an Inspector transformer to visualize the car park data and run the workspace. The data appears to be read correctly, but we
get a pop-up dialog like so:

In fact, the log window also reports this information:
During translation, some features were read that did not match a reader feature type in the workspace. This can happen if
the reader dataset is changed, or a reader feature type removed or renamed.
OK. Well let's add some more data and see if the same thing happens.
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5) Add Reader
Now add another Reader. Select Readers > Add Reader and choose the following data:
Reader Format

OpenStreetMap (OSM) XML

Reader Dataset

C:\FMEData2016\Data\OpenStreetMap\highway.osm

Reader Parameters

Feature Types: Use Specific Features

Our initial specification said only major roads are required so, when prompted, deselect all feature types and leave only
highway_primary selected:

Dr Workbench says...
If you've taken your smart pills today, you'll be thinking that we could use the same OSM Reader to read
both datasets. That's true. Well done you. But we'll stick to separate Readers just to make this exercise
simpler.

6) Connect to Reprojector
Like some other datasets, this data is in Latitude/Longitude. Connect it to the same Reprojector that the car park data is connected
to:

7) Run Workspace
Run the workspace once more. Once more that output appears correct, but that dialog pops-up again. This time it includes an even
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longer list of features:

What on earth can be going on? We'll find out shortly...

CONGRATULATIONS
By completing this exercise you have learned how to:
Delete feature types from a workspace
Handle the options when the final feature type in a Reader is deleted
Import a feature type from a dataset into a Reader in the workspace
Use the Clipper transformer to clip data
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The Unexpected Input Remover
Every time FME reads a dataset, it checks the feature types inside that dataset to ensure that they are all defined within the
workspace schema. If there are feature types that exist in the dataset, but do not exist in the workspace, then features are classed as
unknown and filtered out by a function called the Unexpected Input Remover.
The actions of the Unexpected Input Remover are reported in the Log file:
STATS |Router and Unexpected Input Remover(RoutingFactory): Tested 3995 input feature(s), wrote 3995 output
feature(s): 957 matched merge filters, 957 were routed to output, 3038 could not be routed
...and also through a dialog that opens at the end of a translation:

Notice how each feature type mentioned is listed along with a count of the affected features. Also notice the checkbox that allows
this report to be turned off in future translations.

Dr Workbench says...
It's important to consider that the feature types in a workspace might be deliberately different to those in
the source dataset.
For example, a user may have purposely left a feature type out of a workspace when it was generated, or
may have decided a feature type was no longer required and so deleted it. In that scenario, the
Unexpected Input dialog may still pop up, but can be safely ignored as the user deliberately requires this
behaviour.
Therefore this dialog is considered a reminder rather than an error, and is not always an indication
something has gone wrong.

Unexpected Input and Dataset Type
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Unexpected input is reported only for file datasets; databases do not cause the same problems. That's because a user is unlikely to
want to read every single table in the database; it's not unexpected for them to miss some out.
However, when a file dataset has a Reader feature type missing, then it's more likely to be a problem and the unexpected input
warning is issued.
Also, remember that there are two different types of file dataset: file-based and folder-based.
For file-based datasets, if there is a layer in the file that is not represented on the canvas then FME treats the layer as "unexpected"
and drops it from the translation.
For folder-based datasets - where layers are stored as separate files in a folder - if there is a file selected that is not represented on
the canvas, then FME treats the file as unexpected and drops it from the translation.
This is most often a problem when a set of tiled datasets are being read, as each tile is a separate file (feature type) and needs a
separate definition if it is to be allowed into the translation.
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Dealing with Source Feature Types
Assuming the Unexpected Input dialog does indicate a problem, there are two different methods within Workbench by which to
resolve the issue:
Add the missing feature types
In other words, feature types are missing; so let’s add them. The Import Feature Type tool can be used to do this.

Relax the filtering process
In other words, allow unexpected feature types to pass through an existing one. Merge Parameters can be used to
deliberately permit undefined feature types to pass.

Import Feature Type
The Import Feature Type tool will take the schema definition of a selected dataset and add it to the workspace. By adding in the
missing feature types to the schema, features of that type will be allowed to pass into the workspace.
Once in the workspace the data will now be read and accepted as having a matching feature type.

Merge Parameters
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Rather than adding in missing feature types to a workspace, the second option is to relax the restrictions on the feature type
filtering process, purposely letting undefined feature types to pass.
The functionality is described as a merge, because features with an unknown feature type are literally merged into the input from
an existing feature type.
Merge Parameters are available in each reader feature type for this purpose. The first action is to select a feature type through
which to merge the data and open its Feature Type Properties dialog.

Once the Merge Feature Type option is checked a Merge Filter can be set. This is used to define exactly what incoming feature
types are allowed to merge.
The filter type can be a wildcard or a regular expression.
In this example an asterisk (*) means FME should accept any unknown data into the workspace through this feature type. This
filter is the default value for all Merge Feature Types.
In the workspace itself, the title of the feature type object is updated to reflect the filter being applied.

Once set, the data will now be read and - any feature types previously undefined - will be read through this feature type.

271

Exercise: Fundraising Walk - Dealing with Unexpected Input

Exercise 5

Dealing with Unexpected Input

Data

City Parks (MapInfo TAB)
Walking Trail (CSV)
Water Fountains (File Geodatabase)
Car Parking (OpenStreetMap)
Roads (OpenStreetMap)

Overall Goal

Create a set of data for mapping a recreational event

Demonstrates

Handling Unexpected Input

Start Workspace

C:\FMEData2016\Workspaces\DesktopBasic\Components-Ex5-Begin.fmw

End Workspace

C:\FMEData2016\Workspaces\DesktopBasic\Components-Ex5-Complete.fmw

Let's continue your work on the fundraising walk project.
In this part of the project we’ll look at whether the Unexpected Input warnings we received are something we need to be
concerned about.

1) Start Workbench
Start Workbench (if necessary) and open the workspace from Exercise 4. Alternatively you can open
C:\FMEData2016\Workspaces\DesktopBasic\Components-Ex5-Begin.fmw

2) Run Workspace
Run the workspace (if you haven't before) to remind yourself of the warning dialog that pops up.

3) Consider Amenities Data
Let's look at the amenities dataset. We are reading that to get a set of car parks into the workspace. The car parks are the only
feature type we require. We do not need - for example - either hospitals or schools to appear in our data.
Therefore the unexpected input dialog can be safely ignored. The warnings about missing feature types applies only to layers of
data that we do not need.

4) Consider Roads Data
Like the amenities, the only feature type we wanted to read from the highways dataset was for highway_primary. Other feature
types we can safely ignore. Except.....
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Tiles Courtesy of MapQuest

...I can only see a single road feature on the map. There are no roads marked to show us how to get to the car parks. These must be
in a different feature type. In fact, if I inspect the source data (you can too if you like) I see that the two feature types I need are
called highway_primary_link and highway_unclassified - both of which are reported as unexpected input:

So there the Unexpected Input dialog is telling us something useful that we need to fix.
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5) Fix Unclassified Roads
Let's fix the unclassified roads first. As mentioned, if a required source feature type is missing from the workspace, the simplest
method is to add it. We can do that with the Import Feature Type tool.
So, select Readers > Import Feature Type from the menubar. When prompted, select the Highways Reader to add it to, then define
the highways dataset to read it from:
Reader Format

OpenStreetMap (OSM) XML

Reader Dataset

C:\FMEData2016\Data\OpenStreetMap\highway.osm

Reader Parameters

Feature Types: Use Specific Features

Finally, when prompted, deselect all feature types in the dataset except for highway_unclassified. The feature type will be added
and can be connected like so:

5) Fix Primary Links
Now let's fix the primary links (these are short roads that connect the primary roads to the unclassified roads). We could use the
same import tool to add a feature type, but let's try a different way.
Click on the cogwheel button to open the properties dialog for the highway_primary feature type. You will see a section of the
General tab is labelled Merge Feature Types.
Click in the Merge Feature Type toggle setting to turn it on:

OK. By default the merge filter is set to allow everything in. This is a great way to read all of the data from a single dataset into a
single feature type. If you run the workspace now you will see that we read ALL of the data from the roads dataset (except for
Unclassified roads, which have their own feature type).
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Tiles Courtesy of MapQuest

This is clearly not what we need (although notice that no highway features now appear in the unexpected input dialog), so we
have to be more subtle. In the Merge Filter settings, change the filter type to be a Regular Expression. Change the merge filter to
be:
^highway_primary.*

Basically, this will allow feature types to pass only if they begin with "highway_primary". The result should be as follows:
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Tiles Courtesy of MapQuest

Hurrah! We now have the data we want entering the workspace. Any other reports of Unexpected Input can now be ignored.

6) Connect to Clipper
You might have noticed that the OSM data covers the entire city whereas, once more, we only want that which covers the park the
event is taking place in. So connect the Reproject:Reprojected port to the existing Clipper:Clippee port:

Run the workspace to prove that the output is correct. We have now completed the reading part of this project!
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CONGRATULATIONS
By completing this exercise you have learned how to:
Identify when unexpected input is (and isn't) a problem
Handle unexpected input by using the Import Feature Type tool
Handle unexpected input by using the Merge Feature Type tool
Use a regular expression in the Merge Feature Type tool
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Writers
Writers are the main components that write data in FME.
A Writer is the FME term for the component in a translation that writes a destination dataset. A Writer writes a single format of
data. In general it also writes just a single dataset (i.e. a Reader can read any number of datasets but, if sent to the same Writer,
they will be combined into a single output dataset).
By default, the Generate Workspace dialog creates workspace with a single Writer. However, this does not mean the workspace is
forever limited to this. Additional Writers can be added to a workspace at any time, any number of formats can be used, and there
does not need to be an equal number of Readers and Writers.

Adding a Writer
Adding a Writer to a workspace is a common requirement. There are several reasons:
The Generate Workspace dialog only adds a single Reader and Writer
Each Reader and Writer handles only one format of data.
Different datasets (of the same format) may require reading handling with different parameters
Therefore the need to write multiple formats of data – such as Geodatabase and Oracle – requires multiple Writers.

Additional Writers are added to a translation using Writers > Add Writer from the menubar.
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Adding a Writer has this effect on the hierarchy diagram:

Removing a Writer
Not only can you add a new Writer, you can remove an existing one; for example when you have an old Writer whose output you
no longer need. Tools exist to remove a Writer from a workspace, both on the menubar and in context menus in the Navigator
window.

279

Writers

Removing a Writer obviously has the reverse effect on the hierarchy diagram!
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Controlling Writers
Writers are controlled with Writer parameters.
Because parameters refer to specific components and characteristics of the related format, Writers of different formats have a
different set of control parameters.

Writer Parameters
Writer parameters can be located - and set - in one of two locations.
Firstly, these parameters can be found in a dialog when a new workspace is being generated, or a new Writer added:

.1 UPDATE
The Geodatabase parameters dialog in the above screenshot was slightly redesigned in FME2016.1, with
different options for a template Geodatabase and an XML Workspace template:

281

Controlling Writers

This means the screenshots below are slightly different too.

Secondly, after the workspace is generated/Writer is added, parameters are shown and set in the Navigator Window.

For ease-of-use, basic parameters are listed first, followed by advanced.
To edit a parameter, double-click it. A dialog opens up where the parameter’s value may be set.
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Exercise 6

Adding Writers

Data

City Parks (MapInfo TAB)
Walking Trail (CSV)
Water Fountains (File Geodatabase)
Car Parking (OpenStreetMap)
Roads (OpenStreetMap)

Overall Goal

Create a set of data for mapping a recreational event

Demonstrates

Adding Writers

Start Workspace

C:\FMEData2016\Workspaces\DesktopBasic\Components-Ex6-Begin.fmw

End Workspace

C:\FMEData2016\Workspaces\DesktopBasic\Components-Ex6-Complete.fmw

Let's continue your work on the fundraising walk project.
In this part of the project we’ll start concentrating on the output requirements.

1) Start Workbench
Start Workbench (if necessary) and open the workspace from Exercise 5. Alternatively you can open
C:\FMEData2016\Workspaces\DesktopBasic\Components-Ex6-Begin.fmw

2) Add Writer
One of the output requirements is a GPX dataset of the walk route. So select Writers > Add Writer from the menubar and then
enter these parameters:
Writer Format

GPS eXchange Format (GPX)

Writer Dataset

C:\FMEData2016\Output\Training\TrailRoute.gpx

Click OK to add the Writer.
This format is what we call Fixed Schema. It means the feature types are predefined by the format specification and we shouldn't
try to change them. In this case we get six output feature types:

A route is a route to be followed, a track is a route that has been taken.

3) Connect Schema
When the Writer is fixed schema, and generally when Writers are added separately, some schema mapping is required. The
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incoming source data is a series of points that specify the route to take, so connect it to the RoutePoint feature type:

We need to set a value for the route_id attribute. The simplest method is to right-click on that attribute, choose Edit Value, and
enter a value of 1:

4) Create Route Feature
We also need to create a single feature (of any geometry) to set as a Route (not RoutePoint) feature. So, place a Creator
transformer and connect it to the Route feature type.
Repeat the step above to give this feature type a value for route_id too:

5) Run Workspace
Now run the workspace and examine the GPX output in the FME Data Inspector to ensure it is correct.

6) Delete Writer
Another phone call leads to another change. You're now asked to write the data in Adobe PDF instead of Google KML. So locate
the Google KML Writer in the Navigator window, right-click on it, and choose the option to Delete Writer:
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CONGRATULATIONS
By completing this exercise you have learned how to:
Add Writers to a workspace
Delete a Writer from a workspace
Handle a fixed-schema Writer
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Writer Feature Types
As per the hierarchy diagram, each Writer in FME can have a number of feature types. Feature types define the layers being
written to a destination dataset and the attributes for those layers to possess. They are represented as objects on the workspace
canvas and also listed in the Navigator window.
In this workspace, a Writer is writing a dataset of roads, with a different layer for each road type. Notice the Writer in the
Navigator window and how it has a list of feature types; then notice that each of these feature types is also depicted on the canvas:

A workspace can contain any number of Writers, each with any number of feature types.

Writer Feature Type Attributes
The attributes on a Reader feature type represent 'what we have' - literally what already exists in a source dataset. On the Writer
feature type attributes represent 'what we want'.
Each Writer feature type has a User Attributes tab to define the attributes to be written. Unlike a Reader feature type, there is a
setting with three options to control how attributes can be defined:
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These options are Automatic, Manual, or Dynamic. Being aware of what these options do is important for managing Writer
feature types. So we’ll look into them with Manual definitions first, since they are the easiest to understand.

Manual Attribute Definitions
A manual attribute definition is simply when the workspace author manually enters attribute names, and manually selects the
attribute types, like so:

In this example, we are starting to define an address table. We have entered the definitions for two attributes, and are just entering
a definition for the third.
In the Workbench canvas, the feature type would look like this:

By default, when you create a new workspace the Writer feature types are set in Manual attribute mode.

Automatic Attribute Definitions
An automatic attribute definition is when Workbench itself automatically defines the list of attributes, depending upon what
Reader feature types are connected.
Here – when the user chooses the Automatic option - the attribute definition fields are left empty and uneditable, like so:

287

Writer Feature Types

Similarly, on the canvas the feature type is also empty initially:

What makes the definitions automatic is the action that occurs when it is connected to the rest of the workspace:

Notice that all of the attributes defined - either on a Reader feature type or a transformer - are now copied over to the Writer
feature type automatically.
Because this operates automatically, the list of attributes on the Writer feature type will be immediately updated to match
whenever attributes are chanegd in the workspace. For example, if a Reader feature type is removed and another one connected, or
if a second Reader feature type is connected:

This is really useful because it means that multiple streams of data can be merged into a single feature type, and all attribute
definitions are taken care of.
However, what this won’t do is handle the scenario where you change a source dataset parameter to read a dataset with a different
set of attributes. In other words, the Writer attributes will only be defined by what is connected, not what actually exists in the
source data. For that scenario you need dynamic attributes.

Dynamic Attribute Definitions
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When the attribute definition is set to dynamic it causes the Dynamic Properties option (in the General tab) to be selected:

A dynamic feature type truly has no definition in advance. Instead, it dynamically takes its attribute definitions from either
whatever data is fed to it when the workspace is run, or another set of schema definitions selected by the user.
So, like an automatic definition, you don’t see attributes on the initial feature type. However, neither do you see attributes when
Reader feature types are connected!

Police Chief Webb-Mapp says...
OK let me spell out these important differences.
Automatic attributes takes their definition from whatever is connected to them. If the Source Dataset
parameter is changed, it will have no effect.
Dynamic attributes are different. If the Source Dataset parameter is changed, the attribute definition
comes from whatever source data gets read.
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Adding Writer Feature Types
Generating a workspace is the point at which most feature types are added to the translation. Whatever feature types are added by
the Reader are automatically duplicated on the Writer:

The Writer feature types represent "what you want", but that is often not the same as "what you have". Therefore you need to edit
the Writer feature types to get the structure that you desire.
Also, depending on format, you may need to add further Writers. How you add new feature types depends on whether it is a new
Writer or an existing one.

Adding Feature Types to an Existing Writer
Feature Types can be added manually to a writer using Writers>Add Feature Type on the menubar.

WARNING
At least one writer must exist in the translation hierarchy; else this option will be greyed out.

Adding a feature type opens the Feature Type Properties dialog in order to edit the new feature type's properties.
As when editing the schema, the General tab can be used to define the new feature type’s name. Also, if there is more than one
Writer in the workspace, there is a parameter to specify which Writer this new feature type belongs to:
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TIP
It's worth remembering that, with format-specific terminology, instead of "Feature Type" this dialog's
labels may state "Feature Class," "Layer," "Sheet," or whatever terminology is specific to the format of
data you are writing.

As usual, the User Attributes tab can be used to define the new feature type’s attribute schema, in either of the three different
ways:

Here the user has added a new feature type and is manually defining the attributes that belong to it.

Adding Feature Types to a New Writer
When a new Writer is being created the option is provided to add new feature types:
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Addition of feature types can be completed in a number of ways:

The three methods we have already looked at are:
Automatic: Adds a new feature type with the attribute definition parameter set to automatic
Manual: Adds a new feature type with the attribute definition parameter set to manual
Dynamic: Adds a new feature type with the attribute definition parameter set to dynamic
The others are:
Copy from Reader: Adds a new feature type with manual attribute definition; however, the attributes are pre-defined to an
existing Reader schema. This is useful when you have manually added a Reader and want to duplicate its schema on the Writer.
Import from Dataset: Adds a new feature type with manual attribute definition parameter; however, the attributes are pre-defined
to an external dataset schema. This is useful where - for example - you are adding a Writer to write to a database; the database
tables already exist and you use this tool to copy their schema definition into the workspace.
None: Does not add any new feature type. This is a rare scenario; usually you are adding a Writer but are not yet ready to define
its schema.

292

Exercise: Fundraising Walk - Managing Writer Feature Types

Exercise 7

Managing Writer Feature Types

Data

City Parks (MapInfo TAB)
Walking Trail (CSV)
Water Fountains (File Geodatabase)
Car Parking (OpenStreetMap)
Roads (OpenStreetMap)

Overall Goal

Create a set of data for mapping a recreational event

Demonstrates

Adding Writer Feature Types

Start Workspace

C:\FMEData2016\Workspaces\DesktopBasic\Components-Ex7-Begin.fmw

End Workspace

C:\FMEData2016\Workspaces\DesktopBasic\Components-Ex7-Complete.fmw
C:\FMEData2016\Workspaces\DesktopBasic\Components-Ex7-Complete-Advanced.fmw

Let's finish up your work on the fundraising walk project.
In this part of the project we’ll finalize the output requirements.

1) Start Workbench
Start Workbench (if necessary) and open the workspace from Exercise 6. Alternatively you can open
C:\FMEData2016\Workspaces\DesktopBasic\Components-Ex7-Begin.fmw

2) Add Writer
If you recall, one late change was to write to PDF instead of KML. So add an Adobe PDF Writer with the following parameters:
Writer Format

Adobe Geospatial PDF

Writer Dataset

C:\FMEData2016\Output\Training\CharityWalk.pdf

Add Feature Type(s)

Layer Definition: Copy from Reader

Click OK. When prompted select all of the Reader feature types to copy onto the Writer:

This will give a series of Writer feature types like so:
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Now all that is to do is do some schema mapping.

3) Add FeatureTypeFilter
One issue about our schema mapping is that we merged a lot of data together through a Clipper transformer and it's necessary to
divide it back up again if we want to write the data onto the separate layers.
So, add a FeatureTypeFilter transformer and connect it to the Clipper:Inside output port:

Now open the parameters dialog and click the Update button:
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Now we can map all of our source data to the correct feature type.

4) Map Schema
OK. Make the following connections:
Tester:Passed to PDF:Parks
(CSV)Reprojector:Reprojected to PDF:CSV
FeatureTypeFilter:DrinkingFountains to PDF:DrinkingFountains
FeatureTypeFilter:amenity_parking to PDF:amenity_parking
FeatureTypeFilter:highway_primary to PDF:highway_primary
FeatureTypeFilter:highway_unclassified to PDF:highway_primary
FeatureTypeFilter:Unfiltered to PDF:highway_primary
You'll note that all highway data is being sent to a single Writer feature type. Unfiltered data are the link features that entered
through our merge filter.
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5) Tidy Output
The only thing left to do now is tidy up some of the Writer feature types.
Firstly delete all Writer feature types that aren't being used (Track, TrackPoint, Metadata, WayPoint, highway_unclassified).
Secondly rename all Writer feature types to something more user friendly, for example:
Rename highway_primary to Roads
Rename amenity_parking to Car Parking
Rename CSV to Trail Route
Rename DrinkingFountains to Drinking Fountains
Re-run the workspace and examine the output in Adobe PDF Reader. It should look like this:
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That is the end of this project. The data can now be passed on to produce the actual event map.

Advanced Exercise
Oh! Now that we dropped the KML output dataset, the Python script we wrote probably won't work!
If you have time, and have experience of Python, why not edit the script to support copying the GPX and
PDF output datasets to the "shared" folder.
If you have spare time, but no Python experience, why not try improving the look of the PDF output
instead?
Transformers you might find useful are the PDFStyler and the PDFPageFormatter.

CONGRATULATIONS
By completing this exercise you have learned how to:
Copying Reader feature types while adding a new Writer
Deleting Writer feature types
Dividing data using the FeatureTypeFilter transformer
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Copying Feature Types to a Writer
If a workspace already contains a Writer, it's still possible to copy a Reader schema into it. This is simply done by selecting the
required Reader feature types, right-clicking them, and using the option Duplicate (on Writer).

The command causes duplicates of the Reader feature types to be added to the Writer and automatically connected.
Again, at least one writer must exist in the translation hierarchy; else this option will be greyed out.

Removing Feature Types
Feature types can be deleted by selecting them on the canvas and pressing the delete key. They can also be deleted using the
remove feature types tool on the menubar:

A user might delete a feature type is there is a destination dataset layer that they no longer wish to write.
Whenever all feature types are deleted from a Writer then FME will prompt the user to decide whether to remove the Writer
component as well.
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This makes sense because if there are no feature types you wish to write, why would you still wish to write the dataset at all?
If you answer No, then the feature types are all removed, but the Writer is left in the translation. We call this a "dangling” Writer,
because it has no children in the hierarchy.

TIP
A dangling Writer isn’t as much of a problem as a Reader, since there is no data to be written, although it
can cause a loss of performance depending on other (advanced) factors such as the order of Writers.
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Import Writer Feature Types
A further tool under the Writer menu is labelled Import Feature Types.
Importing feature types is like when you add a new Writer and choose to import the feature types, the difference being the Writer
here already exists.
One reason to import feature types is to write to extra tables in a database.
For example, a user has a workspace that writes to a spatial database. It only needs to write to a single table (Roads), so there is a
single Writer representing the database, and a single feature type representing the Roads table.
However, at some future point the user decides the workspace also needs to write to a second existing table (Rail) and so imports
the schema for the Rail table.
The way to do this is to use the menu tool Writer > Import Feature Types:

The user selects the Writer to add the feature type to (if there is more than one Writer in the workspace) and then is prompted for
the format and dataset to import the schema from.
The import tool will take the chosen schema definition and add it to the chosen Writer in the workspace.

Mr E. Dict (attorney of FME law) says...
Whenever I create a new legal contract for a client, I copy previous contracts. I don't put the same clauses
(data) in there, but they do have the same structure (schema). It's like using a template, and that's exactly
what the Import Feature Types tool does.

Miss Vector says...
Here's an interesting question for you to consider. I want to convert some data from Esri Shapefile to GML
format, with the GML having the same schema as an existing PostGIS database. How can I do this?
1. Create a workspace to convert the Shapefile to PostGIS. Create a second workspace to convert the
PostGIS to GML.
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2. Create a workspace to convert the PostGIS to GML. Create a second workspace to convert the
Shapefile to GML, overwriting the previously created GML file.
3. Create a workspace with PostGIS and Shapefile Readers, and a GML Writer. Copy the PostGIS Reader
feature types to the GML Writer and connect the Shapefile Reader feature types to them. Delete the
PostGIS Reader and run the workspace.
4. Create a workspace with a Shapefile Reader and a GML Writer. Import feature type schemas from the
PostGIS database into the GML Writer.
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Writer Feature Type Parameters
Just like Writers, Writer feature types have their own set of parameters that control how that feature type (layer/table) is being
written. These parameters appear under the Format Parameters tab in the Feature Type Properties dialog:

The important thing is that these (feature type) parameters only apply to a single feature type, whereas a Writer parameter would
apply to all feature types.
For example, when writing to a PostGIS database there is a feature type parameter that defines the operation to carry out:

This operation can be Insert, Update, or Delete. It is a Feature Type parameter because then each table might require a different
operation; for example I want to insert records into table A, but delete records from table B.
Conversely, there is no password parameter at the feature type level because authentication applies to the entire database, not the
individual tables. Authentication parameters are at the Writer level in the Navigator window or - like below - included in an FME
Database Connection:
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TIP
Not all feature types need a set of parameters, so the Format Parameters tab is not always present.
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Module Review
This session was designed to help you understand the different components of a translation, how they can be controlled, and how
they interact.

What You Should Have Learned from this Module
The following are key points to be learned from this session:

Theory
A translation is made up of a Workspace, Readers and Writers, and Feature Types. Tools exist to manage all of these
components
Readers and Writers are defined by entries in the Navigator window, Feature Types by objects in the workspace canvas
Translations are controlled by Reader and Writer Parameters, and Feature Type Parameters
Datasets are selected by Reader and Writer parameters in the Navigator window, not in the canvas
The Unexpected Input Remover filters incoming data if it doesn’t match a known feature type defined in the workspace

FME Skills
The ability to set up and manage the components of a translation
The ability to control a translation with read and write parameters
The ability to handle source datasets regardless of feature type or attributes.

Further Reading
For further reading why not browse articles tagged with Feature Type on our blog?
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Questions
Here are the answers to the questions in this chapter.

Miss Vector says...
Here are four different formats and four different terms for "feature type". Connect the format to the
correct terminology.
Format

Feature Type Terminology

Oracle Spatial

Table

MicroStation Design

Level

Esri Geodatabase

Feature Class

Adobe PDF

Layer

Technically, Esri feature classes are stored in tables, but feature class is the best match in this list.

Miss Vector says...
Here are four scenarios and four tools or settings. Connect the scenario to the correct tool/setting.
Scenario

Tool

Source filename changes

Source Dataset Parameter

Attribute type changes in database

Update Feature Type

Additional database table needs reading

Import Feature Type

New file dataset needs reading

Add Reader

Technically, if a new file dataset needs reading, and you already have a Reader of the same format, you
could add the dataset to that Reader using the Source Dataset parameter. However, usually you would
create a new Reader entirely.

Miss Vector says...
I want to convert some data from Esri Shapefile to GML format, with the GML having the same schema as
an existing PostGIS database. How can I do this?
1. Create a workspace to convert the Shapefile to PostGIS. Create a second workspace to convert the
PostGIS to GML.
2. Create a workspace to convert the PostGIS to GML. Create a second workspace to convert the
Shapefile to GML, overwriting the previously created GML file.
3. Create a workspace with PostGIS and Shapefile Readers, and a GML Writer. Copy the PostGIS Reader
feature types to the GML Writer and connect the Shapefile Reader feature types to them. Delete the
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PostGIS Reader and run the workspace.
4. Create a workspace with a Shapefile Reader and a GML Writer. Import feature type schemas from
the PostGIS database into the GML Writer.
While it's true that #3 might do the job (#1 and #2 are just plain wrong) #4 is the best way. It works
because you don't have to import the schema from the same dataset you are writing to - or even a dataset
of the same format!
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Exercise 8

Elevation Model Updates

Data

Contours (Esri Shapefile)
Raster Orthophoto (JPEG)

Overall Goal

Generate a 3D surface model using updated information

Demonstrates

Workspace components and parameters

Start Workspace

None

End Workspace

C:\FMEData2016\Workspaces\DesktopBasic\Components-Ex8-Complete.fmw
C:\FMEData2016\Workspaces\DesktopBasic\Components-Ex8-Complete-Advanced.fmw

A new property development is being planned within the city. The planning department has asked for a 3D visualization of the
city elevation model, taking this new development into account.
The task is to read the current elevation model, apply changes provided by the property developer, and create a three-dimensional
output in Adobe PDF format.
Your manager has handed you this task, thinking that it will be very difficult. He doesn't know FME as well as you do!

1) Inspect Data
The first task is to read the existing contour files into a workspace. Examine the folder and you see that the contours are held in a
set of Shapefile tiles:

Feel free to use the FME Data Inspector to inspect these source files.

2) Add Reader
Start FME Workbench and begin with a blank workspace. Select Readers > Add Reader to read the contour files:
Reader Format

Esri Shapefile

Reader Dataset

C:\FMEData2016\Data\ElevationModel\Contours\*.shp

When it comes to selecting the data, select all of the Shape files in that folder. But don't click OK yet. First of all, select the
workflow option for a "Single Merged Feature Type":
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What this will do is add a single feature type with a Merge Filter automatically set:

Sister Intuitive says...
This is a HUGE shortcut here. It has added a single feature type and set a merge filter to read ALL data.
In this scenario it makes the workspace way tidier and easy to use than if each file had its own feature
type.
Of course, this only works where all of the source files have the same attribute schema (like here) and we
are sure that we want to read all of the source layers (we do).

3) Add Reader
Now let's add the developer's data. Again select Readers > Add Reader from the menubar.
Reader Format

Esri Shapefile

Reader Dataset

C:\FMEData2016\Data\Parcels\NewDevelopment.zip

Because the data has been sent in a zip file, we can still read it, but when we browse for the data we need to change the filter to
look for zip files:
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The other thing we should do is set the workflow option back to Individual Feature Types, in case there is data other than contours
in there.

Now click OK. When prompted for which feature types you want from the zip file, select NewContours only.

4) Add ChangeDetector
The ChangeDetector transformer will tell us which contours are new in this dataset, which are replacements, and which are the
same as before. So, place a ChangeDetector transformer and connect it in. The original contours should be connected to the
Original port(!) and the revised contours to the Revised port.

You can check the parameters, but none should need changing. We can check in 2D because the contours are 2D with an elevation
attribute.

5) Add Inspectors
Add Inspector transformers to the output ports of the ChangeDetector and run the workspace to see what we have got so far.
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TIP
The Unexpected Input Remover might appear, but you know this isn't a problem, right? We deliberately
chose not to read the BuildingFootprint or Labels from the source data.

You should find 3,967 contours were unchanged; i.e. they were in the original data and the new version. Seven (7) contours have
been added; i.e. they appear in the new data but not the original version. Three (3) contours have been deleted; i.e. they appear in
the original data but not in the new data.

We'll want to generate the new elevation model from the Unchanged and the Added features; deleted ones we can drop. But first,
there is a more pressing problem...

6) Import Feature Type Definition
Did you notice that the Added contours do not have an elevation value set? This is a problem because we can't generate a proper
3D model without elevation! It must be that the labels in the source data are meant to denote the contour elevation (you can use
the Data Inspector to open the data and confirm this is so).
Therefore we need to add that data to the workspace. We already have a Reader so you just need to add the Feature Type.
So choose Readers > Import Feature Type and select the NewDevelopment Reader to import to. This time, when the list appears,
be sure to select the Labels feature type:

Click OK and now you should get a new feature type. Because we're reading from a zip file we don't even need to change the
dataset parameter; FME will pick up the data anyway.

7) Add NeighborFinder
A NeighborFinder transformer will transfer the label values onto the nearest contour. So, add a NeighborFinder transformer and
connect it in. The ChangeDetector:Added features are the Base and the labels are the Candidate:
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Open the parameters dialog and set the Maximum Distance parameter. This defines the maximum distance from the contour to the
label. Because the labels appear to be almost on top of the contour you can set this to a low number, for example 5.
Now add some more Inspectors and rerun the workspace to ensure all seven contour features have an elevation value now.

8) Add 3DForcer
Having an elevation attribute is fine, but to actually create a 3D model we must convert this into a true Z value. This is done with
a 3DForcer transformer, so place one of these. The ChangeDetector:Unchanged and NeighborFinder:Matched are the features we
need to process.

.1 UPDATE
The 3DForcer transformer in the above screenshot gained a <Rejected> port in FME2016.1

Now open the parameters dialog. For Elevation, click the drop-down arrow and choose Attribute Value > Elevation.
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Run the workspace again and you will see the contours now have a Z value and the Data Inspector reports they are true 3D
features:

9) Add SurfaceModeller
Now we have 3D contours we can create a surface model. Add a SurfaceModeller transformer connected to the 3DForcer output.
The input port to connect is Points/Lines.

Open the parameters dialog. Set a Surface Tolerance of 1, and turn off the checkbox for Output Contours (it will run faster
without). If you now connect an Inspector to the TINSurface output port and run the workspace, you will be able to inspect the
data in 3D.

TIP
To rotate the data in 3D in the FME Data Inspector, click the orbit icon on the toolbar, or press down on
the centre mouse button if you have one.

10) Exaggerate Scale (Optional)
If Vancouver seems a little flat, then why not exaggerate the Z scale a little to compensate!
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Add an ExpressionEvaluator before the 3DForcer and use it to multiply the value of Elevation by a factor of 4. You'll want to use
to option to apply the result to an existing attribute:

Now Vancouver will have a more interesting profile:

11) Add Writer
Now let's write this data. Select Writers > Add Writer and add a Writer with the following specifications:
Writer Format

Adobe 3D PDF
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Writer Dataset

C:\FMEData2016\Output\Training\SurfaceModel.pdf

Make sure you choose the 3D (not 2D) version of the PDF Writer. You can choose to add a new feature type for the output in
whatever way you want. The best method will be to select either Manual or Automatic from the Add Writer dialog. Give the
feature type a name such as Surface and connect it up to the SurfaceModeller:TINSurface port.
In the Writer parameters (Navigator window) locate the background color parameter and change it to black (0,0,0). Locate the
Page Size parameter and change it to 600 400:

Now run the translation. Locate the output data - it will take a minute or so to write - and open it in Adobe Reader.

Advanced Exercise
You've now used Readers and Writers (and transformers) to update an elevation model and create a 3D
rendering of it. But there is so much more we can do with this.
As an advanced task let's drape a raster image onto the surface model to make it look prettier.

12) Add Reader
Add a Reader to read the raster data. The details are:
Reader Format

JPEG (Joint Photographic Experts Group)

Reader Dataset

C:\FMEData2016\Resources\OverlayImage.jpg

13) Add AppearanceSetter
Now add an AppearanceSetter transformer. This is used to apply the raster as an "appearance" or texture onto the DEM surface.
The Raster data is the Appearance and the TINSurface port is the Geometry:
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Open the parameters dialog. Change "Set Appearance On" to be Front Side.
Expand the section Texture Coordinate Generation Parameters and set "Texture Mapping Type" to be From Top View:
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Run the workspace (be sure to close the PDF first if it is open in Adobe Reader). This time the PDF output should have a raster
image draped on it.
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WARNING
By default the PDF output will now be close to 100mb in size. If this is too large for your computer to
handle, add a RasterResampler transformer before the JPEG feature type and set the parameters to
resample to 25% of the original.
The PDF will now only be 8mb in size, but the quality will, of course, be much less.

14) Overlay Building Footprint
In the previous output, did you spot the lump in the surface where the new property is going to be developed? The one last thing
we could do is add the building outline so that we can see where it will go.
Because we don't have the building data in the workspace the first task is to use Import Feature Types to add that back to the
NewDevelopment Shapefile Reader.
Connect that up to the SurfaceModeller:DrapeFeatures input port (i.e. we want to drape the building onto the 3D surface that is
being generated).
Add an Extruder transformer, connected to the SurfaceModeller:DrapedFeatures output port.
Set the Extruder parameters to extrude the data by a height of 25. This will create a 25m high building.
Now add a new Writer feature type to create a new output layer for the buildings. Connect it to the Extruder transformer and you
will have a workspace that looks like this:
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Run the workspace and the output will now look like this:

Wow! Even allowing for the 4x scale increase on the DEM, this building is very prominent on the Vancouver skyline!

CONGRATULATIONS
By completing this exercise you proved you know how to:
Add Readers and Writers to a workspace
Set Reader and Writer parameters
Import Reader feature types
Read data from a zip file
And have learned how to:
Use the Merge Feature Type option when adding a Reader
Convert contours to a 3D surface model
Drape a raster image onto a 3D surface model
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Practical Transformer Use
Even experienced FME users find the full list of transformers a daunting sight. In this section you’ll learn to stop worrying and
love the transformer gallery.
With over four hundred (400) transformers FME possesses a lot of functionality; probably a lot more than a new user realizes, and
much of which would be very useful to them. This section helps find the transformer you need, even if you didn’t realize you
needed it.
Although the transformer list can look a bit overwhelming, don't panic! The reality is that most users focus on 20-30 transformers
that are relevant to their day-to-day workflow. You don't need to know every single transformer to use FME effectively.
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Transformer Gallery
The transformer gallery is the obvious place to start looking for transformers. There are a number of ways in which transformers
here can be located.

Transformer Categories
Transformer categories are a good starting point from which to explore the transformer list. Transformers are grouped in
categories to help find a transformer relevant to the problem at hand.

TIP
Notice that each category lists the number of transformers that it contains!

322

The Transformer Gallery

Important categories include:
Calculators: Calculate a value and supply it as a new attribute
Database: Interact with external databases
Filters: Split and re-route data
Geometric Operators: Process feature geometry
Infrastructure: Structural transformation and scripting with Tcl/Python
Strings: Create, modify and delete string (character) attributes
Workflow: Run workspaces either locally or on an FME Server
Simply click on the expand button to show all transformers within a particular category.

Transformer Help
The FME Workbench Help tool displays information about transformers. Simply click on a transformer and press the F1 key to
open the help dialog.
This tool is linked to FME Workbench so that a transformer selected (in the gallery or on the canvas) triggers content to display in
the Help tool.

.1 UPDATE
In FME2016.1 the help window was altered to not update automatically when a new object is clicked on.
But in 2016.1.1 this behavior was returned, along with the embedded help window!
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TIP
Another useful - and printable - piece of documentation is the FME Transformer Reference Guide.

324

Transformer Searching

Transformer Searching
There are search functions in both the transformer gallery and Quick Add dialog.

Transformer Gallery Search
To perform a search in the transformer gallery, simply enter the search terms and either press the key or click the search icon (the
binoculars icon).
The transformer gallery search searches in both name and description. Therefore a search term may be the exact name of a
transformer, or it may be a general keyword referring to functionality in general:

Search terms can either be full or partial words, and may consist of a number of keywords, including quote marks to enclose a
single search reference.

Quick Add Search
Quick Add search-terms can also be full or partial words:
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By default, Quick Add does not look in transformer descriptions, so the search term must be the actual name of a transformer.

However, Quick Add will search in the transformer descriptions if you press the <TAB> key.

Quick Add results include aliases - for example transformers that have an alternative name or which have been renamed - and also
include transformers found in the FME Hub.

Firefighter Mapp says...
in case you weren't aware, the FME Store (store.safe.com) is a facility for sharing (and selling) FME
functionality such as custom transformers and formats:
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Transformers from the store are flagged in Quick Add with a small, downwards-pointing arrow, to denote
that they will be downloaded if selected.

CamelCase
Quick Add also allows the use of CamelCase initials as a shortcut. CamelCase is where a single keyword is made up of several
conjoined words, each of which retains an upper case initial; for example AttributeFileWriter (AFW) or ShortestPathFinder (SPF).

Miss Vector says...
Try these questions to see if you can search for transformers.
Which of the following is NOT a category of transformers?
1. Database
2. Formats
3. Linear Referencing
4. Surfaces
Here are four transformers and four categories. Match the transformer to the correct category.
Scenario

Tool

Chopper

Infrastructure

Terminator

Calculators
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Matcher

Manipulators

DateFormatter

Filters
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Most Valuable Transformers
If you have a thorough understanding of the most common transformers then you have a good chance of being a very efficient
user of FME Workbench.
Anyone can be proficient in FME using only a handful of transformers; if they are the right ones!

The Top 25
At Safe Software, we find it useful to keep a list of the most-used transformers. It tells us where to direct our development efforts
in making improvements. And no doubt it will give users a head-start on knowing which of the (400+) FME transformers they’re
most likely to need in their work.
The following table provides the list of the most commonly used 25 transformers, calculated from user feedback. The Tester
transformer is consistently number one in the list every year, highlighting its importance.

Rank

Transformer

Rank

Transformer

1

Tester

2

AttributeCreator

3

Inspector

4

FeatureMerger

5

AttributeRenamer

6

AttributeKeeper

7

Creator

8

AttributeRemover

9

AttributeFilter

10

Reprojector

11

TestFilter

12

Clipper

13

Counter

14

Aggregator

15

GeometryFilter

16

DuplicateRemover

17

Bufferer

18

AttributeExposer

19

StringReplacer

20

ExpressionEvaluator

21

Joiner

22

StringConcatenator

23

VertexCreator

24

Sorter

25

StatisticsCalculator

Besides the obvious transformers for transforming geometry (Clipper, Bufferer - Dissolver is #26) and the obvious transformers
for transforming attribute values (StringReplacer, StringConcatenator, Counter) there are some other distinct groups of
transformers.

Managing Attributes
These transformers - mostly named the Attribute<Something> - are primarily for managing attributes (creating, renaming, and
deleting) for schema mapping purposes. However they can also be used to set new attribute values or update existing ones.

NEW
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FME2016 introduces a new transformer: the AttributeManager.

The AttributeManager is a multi-purpose transformer for carrying out most attribute-related functionality.
So look out for it to appear at the top of this list - replacing all other attribute transformers - in the next
year or two.

Filtering
These transformers - mostly named the <Something>Filter - subdivide data as it flows through a workspace. Commonly the filter
is a conditional filter, where the decision about which features are output to which connection is decided by some form of test or
condition.

Data Joins
Joins are the opposite action to filtering; they are when separate streams of data are combined as they flow through a workspace.
Like filtering there is a condition to be met - in this case matching key values - that determine how and where the join takes place.
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Managing Attributes
A high proportion of the top 25 transformers are support transformers for managing attributes. These create new attributes, rename
them, set values, and delete them.
A key use for these transformers is to rename attributes for the purpose of schema mapping.

Attribute Managing Transformers
The key attribute-management tasks and the transformers that can be used are as follows:

Task
Create Attributes

Transformers
AttributeCreator, AttributeManager

Set Attribute Values

AttributeCopier, AttributeCreator, AttributeManager, AttributeRenamer

Remove Attributes

AttributeKeeper, AttributeManager, AttributeRemover, BulkAttributeRemover

Rename Attributes

AttributeManager, AttributeRenamer, BulkAttributeRenamer

Copy Attributes

AttributeCopier, AttributeCreator, AttributeManager

Sort Attributes

AttributeManager

Change Attribute Case

BulkAttributeRenamer

Add Prefixes/Suffixes

BulkAttributeRenamer

Many of these transformers can carry out similar operations, and you can see that the AttributeManager does so many tasks you
can use it almost exclusively.

WARNING
Don't misunderstand the BulkAttributeRenamer. It changes the case - or adds suffixes/prefixes - to the
attribute name, not the attribute value.

Lists
A List in FME is a mechanism that allows multiple values per attribute.
For example, the attribute myAttribute can only contain a single value.
However, the list attribute myList{}.myAttribute can contain multiple values as:
myList{0}.myAttribute
myList{1}.myAttribute
myList{2}.myAttribute
etc.
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There are various transformers designed to operate specifically on lists - they can be found in the Lists category of the transformer
gallery - and list functionality is built into other transformers (such as the AttributeCreator) too.
For further reading check out this article on Attribute Management on the Safe Software blog.
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Creating and Setting Attributes
Creating attributes and setting a value are probably the primary attribute function used within FME. When an attribute is created
its value can be set in any one of a number of ways.
The transformers capable of creating an attribute - and setting its value - are:
AttributeCreator
AttributeManager
The AttributeCopier and AttributeRenamer transformers can set an attribute value, but only if it exists already.

The AttributeManager
For most operations we'll concentrate on the AttributeManager, so here is a quick overview of that transformer.
The AttributeManager parameters dialog has a number of fields: Input Attribute, Output Attribute, Attribute Value, and Action.
Uniquely among attribute-handling transformers, it is automatically filled in with the details of the attributes connected to it:

The action field can be set by the user, but is also set automatically when a change is made to the other fields.

Manually Create an Attribute
By entering a new attribute name into the Output Attribute field, it will be created in the output.
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The text <Add new Attribute> highlights where a new attribute can be created. By default, when the Attribute Value field is
empty, a new attribute has no value.

Set a fixed Attribute Value
A fixed (or constant) value for an attribute can be created by simply entering a value into the Attribute Value field:

Here, for example, a new attribute called City is being given a fixed value of Vancouver.
However, also note that the existing attribute NeighborhoodName is also being assigned a fixed value. It is being given the value
"Kitsilano". Notice how by entering a value into that field, the Action field has automatically changed from "Do Nothing" to "Set
Value".
Besides entering set values like this, it's possible to construct an attribute value in a number of different ways.
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Constructing Attributes
Besides constant attribute values FME also allows you to construct values using string manipulation and arithmetic calculations.
This is acheived using the menu opened by clicking on the arrow in the Attribute Value field:

This is very useful because the attribute now no longer is a fixed value: it can be constructed from a mix of existing attributes and
parameters. The two main methods are the Text Editor and Arithmetic Editor.

Text Editor
The text editor - as you would expect - allows you to construct a text value. It includes all the usual string-handling functionality
you would need, such as concatenation, trimming, padding, and case changing.
The text editor looks like this:

Here the user is constructing a simple address string by concatenating various existing attributes. Notice the menu on the left hand
side. Existing attributes are listed here and were added into the string by double-clicking them.
Also notice the other menu options. The most important (for a text editor) are the String Functions:
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These are the functions that can be used to manipulate the strings being used. For example, here the user is making sure the
attributes being used are trimmed when used:

Arithmetic Editor
The arithmetic editor is much the same as the text editor, except that whatever is entered into the dialog will be evaluated as an
arithmetic expression and a numeric result returned:
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Here the user is calculating a resident's tax using a simple equation containing property area and a tax code. As with the text
editor, existing attributes and arithmetic functions were obtained from the menu on the left-hand side.

FME Feature Functions
One other item in the menu of both text and arithmetic editors is FME Feature Functions:

These are functions that reach into the very heart of FME's core functionality. They are the building blocks that transformers are
built upon; basic functionality that can return values to the editor.
For example, the @Area() function returns the area of the current feature (assuming it is a polygon). @Timestamp() returns the
current time.
Some functions return strings, others return numeric values; therefore the available functions vary depending on whether the text
or arithmetic editor is being used. In the screenshot above, the text editor functions are on the left and the arithmetic editor
functions on the right. The text editor can use either text or numeric values; the arithmetic editor can only ever accept numeric
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values.
FME Feature Functions are useful because they allow you to build processing directly into the AttributeManager, instead of using
a separate transformer.

Replacing Other Transformers
Integrated text and arithmetic editors provide a great benefit for workspace creation. They allow attribute-creating functions to be
carried out directly in a single transformer.
For example, the AttributeManager text editor can be used as a direct replacement for the StringConcatenator and
ExpressionEvaluator transformers.
The AttributeManager could also replace the StringPadder and AttributeTrimmer transformers, albeit with a little less userfriendliness. If FME Feature Functions are used inside the editor, this transformer could also technically replace transformers such
as the AreaCalculator, LengthCalculator, CoordinateCounter, TimeStamper, and many more.
This is usually a good thing. Workspaces will be more compact and well-defined when as many peripheral operations as possible
are directly integrated into a single transformer. However, because it's possible for an AttributeManager to be carrying out one of
many, many operations, it is also more important to use Best Practice and ensure it has proper annotation.
If an AttributeManager is not properly annotated, it isn't possible to determine from looking at the Workbench canvas what action
it is carrying out!

Miss Vector says...
Here's a question to see if you are paying attention. Look at this screenshot of an editing dialog and tell
me what the value returned to the attribute will be:

1. 2+2
2. 4
3. 4.0
4. Error!
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Constructing Parameters
Let's just put attributes to one side for a moment and look at transformer parameters.
Transformer parameters are often set in a fixed way (hard-coded) or set to take on the value of a particular attribute. However, in
the same way that attributes can be constructed, text or arithmetic editors can be used to build values for transformer parameters.

Using Attributes for Parameters
As noted, most transformer parameters allow the user to select an attribute value instead of manually entering a fixed value. For
example, the LabelPointReplacer can create a label whose contents and height are specified by attribute values:

This is very useful because it allows the parameters (for example label size) to get a different value for each feature. An attribute
could be read from a source dataset, or calculated using an ExpressionEvaluator, so that one feature creates a label 10 units in
height, another creates a label 15 units high, and so on. It is no longer a fixed value.

Constructing Parameter Values
If a parameter value needs to be calculated or constructed, instead of using a separate transformer, FME has integrated string and
numeric editors built into parameter dialogs.
For example, here the user is choosing to calculate label height using an arithmetic calculator:
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The calculator allows the selection and use of FME attributes, other parameters, plus a number of mathematical and string-based
functions. For example, here the user has chosen to calculate the height of their labels using the logarithm of the taxable value:

Mr. E. Dict (attorney of FME law) says...
It's a fixed rule that the editor dialogs available depend upon the type of parameter being set. For
instance, the Label parameter in a LabelPointReplacer opens in a text editor because the parameter
requires a text value. The Label Height parameter opens in an arithmetic editor because that parameter
requires a numeric value.

Reducing Workspace Congestion
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Like when attribute values are constructed, workspaces are more compact when as many peripheral operations as possible are
directly integrated into a single transformer or parameter. However, as with attributes, it's important to use Best Practice and
ensure it has proper annotation, else it's difficult for a casual observer to understand what the workspace is meant to do.
Another drawback, specific to parameters, is that you don't also get the information as an attribute to use elsewhere. For example,
if you construct a label string in the LabelPointReplacer, that string isn't available as an attribute elsewhere in the workspace.
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Renaming and Copying Attributes
Renaming and - to a lesser extent - copying attributes are also key attribute functions within FME. When an attribute is renamed it
ceases to exist under its prior name; when it is copied it exists both in its new and old names.
The transformers capable of renaming an attribute are:

Transformer

Capability

AttributeCopier

Copy

AttributeCreator

Copy

AttributeManager

Copy and Rename

AttributeRenamer

Rename

Renaming
The fundamental purpose of this transformer is to manually enter a new name for a selected attribute. The old attribute is removed
and replaced with the newly named one.

Here the user is renaming a number of fields by entering a different name for the Output Attribute. The Action is automatically set
to Rename. Notice that the user is also entering a new constant value for the PSTLCITY/PostalCity attribute.
This type of behaviour is obviously of use when the Reader schema ('what we have') needs to be renamed to match the Writer
schema ('what we want').

TIP
Although you can manually type a new attribute name into the Output Attribute field, if the transformer is
connected to the correct Writer feature type, its attribute names will be automatically available to select
from:
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Copying
Depending on the transformer, copying an attribute can be one of two styles.

Here the AttributeCopier consists of selecting the existing attribute and entering a new name for it. Again, when connected to a
Writer feature type, its schema is available to select from.

TIP
You can (as above) enter a constant attribute value in the AttributeCopier, but in reality it's hardly a copy
operation in that case; it's more an attribute creation task.

Note how both PSTLCITY and PostalCity exist on the output of the transformer, proving that it is copying the attribute rather than
renaming it.
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For other transformers, the setup style is reversed: a new attribute is created and given the value of an existing attribute:

In this AttributeManager transformer the user creates a new attribute (PostalCity) and assigns it the value from another
(PSTLCITY). In effect they have made a copy of the original attribute.
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Bulk Attribute Renaming
Usual attribute renaming involves selecting individual attributes to operate on. However, in some cases it's important to be able to
carry out the same renaming operation on a large number of attributes.
This scenario is catered for by the BulkAttributeRenamer transformer.

BulkAttributeRenamer
The BulkAttributeRenamer carries out the core function of renaming attributes. But instead of manually specifying each attribute,
this transformer lets the user select multiple attributes - or all of them.

When multiple attributes are selected, the action must - of course - carry out the same renaming action on them all. These actions
are:
Add String Prefix
Add String Suffix
Remove Prefix String
Remove Suffix String
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Regular Expression Replace
String Replace
Change Case

The power of the transformer is also in its ability to manipulate multiple attributes at once, without having to individually select
them all. Here, for example, the incoming attributes are all being renamed to lower case names in order to match a Writer schema
that does not support upper case:

Here, for example, the user has converted to lower case and then used a second transformer to add a prefix:
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Removing Attributes
Removing attributes is perhaps seen as a less-important task in FME. That's because - for a manual attribute schema - only
attributes defined in the Writer are written to the output; extra attributes that are not required are just ignored.
However, removing attributes does carry useful benefits:
Removing attributes that aren’t required tidies up a workspace and makes it easier to understand
A workspace is a complex network of objects and schemas. Removing attributes simplifies the workspace and makes the
Workbench interface more responsive
All data processing incurs costs of time and memory. Removing attributes means less data is being processed and so the FME
engine performs faster

TIP
Hiding attributes on a Reader schema, while it helps tidy a workspace, is not the same as removing them
and does not help improve the translation performance.

Transformers that can remove attributes are:
AttributeKeeper
AttributeManager
AttributeRemover
BulkAttributeRemover

Removing Attributes
The AttributeManager and AttributeRemover have the same technique; select an attribute to be removed:
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Attributes can be removed in the AttributeManager by selecting it and clicking the - button. Alternatively you can change the
action field from Do Nothing to Remove.
Notice in the above that two attributes have been removed. The output attribute (when selected) shows the name struck out to
signify that it is no longer present.

Keeping Attributes
The AttributeKeeper transformer carries out the same function, but approaches it from the opposite direction. It lets the user
specify which attributes are not to be removed; in other words, this transformer lets the user specify which ones to keep.
So, the AttributeManager should be used where one or two attributes are to be removed, but the majority of them kept. The
AttributeKeeper should be used when the majority of attributes are to be removed, and only one or two of them kept.

Bulk Attribute Removal
The BulkAttributeRemover - like the BulkAttributeRenamer - lets the user carry out a process on multiple attributes. In this case,
instead of being able to select all attributes, the user enters a string-matching expression in order to define which attributes to
remove:

Here the user is removing all attribute whose name ends in the word "Street".
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Exercise 1

Address Open Data Project

Data

Addresses (File Geodatabase)

Overall Goal

Convert a File Geodatabase to GML and map the schema

Demonstrates

Attribute Management for Schema Mapping

Start Workspace

None

End Workspace

C:\FMEData2016\Workspaces\DesktopBasic\Transformers-Ex1-Complete.fmw

As part of a push for open government, the city's corporate address database is to be made available online. However, it is
currently held in Esri File Geodatabase format and this is not thought suitable to deliver in its raw form. Instead the data will be
translated to a GML/XML format and transformed into a new schema.
As custodian of all things to do with data translations, you have been handed this task to carry out.

1) Inspect Data
As usual, the first task is to familiarize yourself with the data. To do this open the following dataset within the FME Data
Inspector:
Reader Format

Esri Geodatabase (File Geodb API)

Reader Dataset

C:\FMEData2016\Data\Addresses\Addresses.gdb

The table that is to be translated is called "PostalAddress." The important thing here is not how the data looks in the graphic
display, but more what attributes exist in the Table View window.

Optionally you may wish to locate the file C:\FMEData2016\Resources\AddressSchema.xsd and open it in a text editor (or other
XML file viewer). An xsd file describes the schema of an XML/GML dataset, and this file has been created to define what
attributes we wish to have in our address GML dataset.
2) Create Workspace
Now that you are familiar with both the source data and the required output schema, start FME Workbench and begin with an
empty workspace. Select Readers > Add Reader from the menubar.
Add the Reader with the same values as in the Data Inspector.
Reader Format

Esri Geodatabase (File Geodb API)

Reader Dataset

C:\FMEData2016\Data\Addresses\Addresses.gdb

When prompted, select only the PostalAddresses table, and no others:
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3) Add Writer
Now let's add a Writer to write the output data. Select Writers > Add Writer from the menubar and use the following:
Writer Format

GML (Geography Markup Language)

Writer Dataset

C:\FMEData2016\Output\Training\AddressFile.gml

Select 'Import from Dataset' in the 'Add Feature Types' section of the dialog. Then Click OK to add the Writer.

4) Import Feature Types
When prompted set the following parameters. The Dataset can be left as it is or emptied (left blank). It is not the important part:
Reader Format

GML (Geography Markup Language)

Reader Dataset
Reader Parameters

Application Schema C:\FMEData2016\Resources\AddressSchema.xsd
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You may also need to set the Namespace Prefix parameter:

Click OK to accept the values. The new feature type will be created to match the chosen GML application schema.
The workspace will now look like this:

5) Add AttributeManager
OK, we now have the Reader and Writer in place. Now we can start to map the schema from Reader to Writer. As you'll have
noticed, the two do not currently match up very well.
So, place an AttributeManager connected between the two feature types. The dialog will look like this:
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Firstly let's clear up the Reader schema by removing some of the unwanted attributes.
Click on the following attributes and press the - button to remove them:
OBJECTID
GlobalID
OWNERNM1
OWNERNM2
INTSTATE
INTPSTLCD
REPRESENT
STATUS
LASTUPDATE
LASTEDITOR
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6) Rename Attributes
Several source attributes can be written to the output as they are, but do need renaming first.
in the AttributeManager rename the following:
PSTLCITY to City
PSTLPROV to Province
POSTALCODE to PostalCode
COUNTRY to Country

If the AttributeManager is connected to the Writer feature type then you should be able to select the Output Attribute field from a
drop-down list instead of typing it in.

7) Create Attribute
Two attributes on the output (Provider and UpdateDate) are new and cannot be copied from the source data. They must be created.
In the AttributeManager create the new attribute "Provider". Because the attribute does not already exist, you'll need to type the
new name, rather than select it from a drop-down list.
The value can be your own organization name, or "Safe Software" or "City of Interopolis."
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8) Create Attribute
Now create the new attribute "UpdateDate". Rather than hard-coding a value click on the drop-down arrow in the Attribute Value
field and choose Open Text Editor.
In the text editor locate the FME Feature Function called Timestamp and double-click to place it in the editor. Now replace the
<STRING> part with ^Y-^m-^d

By doing this not only will we get the correct date each time the workspace is run, it will also be in the correct ISO syntax for
GML format.
Click OK (and again) to close the AttributeManager dialog.

TIP
Why not run the translation now, with Redirect to FME Data Inspector turned on, to see what the result of
our efforts so far is?

9) Add AttributeSplitter
Looking at the output schema there are two fields for Number and Street (for example "3305" and "W 10th Av"). However, the
source schema condenses that information into one field with <space> characters separating the fields ("3305 W 10th Av").
Therefore we'll have to split the source attribute up in order to match the Writer schema.
Insert an AttributeSplitter transformer. Insert it before the AttributeManager - then if there are any actions to carry out on the split
attributes we can use the same AttributeManager transformer.
Open the AttributeSplitter parameters dialog. Set PSTLADDRESS as the attribute to split and enter a space character into the
Delimiter parameter. Ensure that a list name is set in that particular parameter.
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Click OK to close the dialog. If you run the workspace now you'll see the address as a list attribute:
_list{0} (encoded: utf-8) 3305
_list{1} (encoded: utf-8) W
_list{2} (encoded: utf-8) 10th
_list{3} (encoded: utf-8) Av

Remember a list attribute is one that can store multiple values under a single name (_list).

10) Rename Attribute
Now let's handle the Number field in the output.
Open the AttributeManager parameters.
Notice that there is now an entry for the list attribute called _list{}. However, the AttributeManager will not expose list elements
like other transformers will. So instead of renaming the attribute we have to copy its value into the new attribute.
In the Output Attribute field select Number from the drop-down list.
For the Attribute Value field click the drop-down arrow and select Attribute Value > _list{}...
You will now be prompted to select the element in the list. Ensure it is set to zero (0) and click OK.
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Click OK to close the dialog and run the workspace to ensure the number is being copied.

11) Construct Attribute
The final step is to recreate the Street attribute, without it being prefixed by the address number.
Open the AttributeManager again. This time in the Output Attribute field select Street from the list.
For the Attribute Value field there are multiple list elements to concatenate. So click the drop down arrow and choose Open Text
Editor.
Locate _list{} in the FME Feature Attributes menu and double-click it to place it in the editor. Again you will be prompted to
select a list element. This time select element 1
Press the spacebar to enter a <space> character.
Double-click _list{} again and this time select list item 2.
Again press the spacebar for another <space> character.
Double-click _list{} again, this time selecting item 3.
The dialog will now look like this:
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In this way we will have concatenated all parts of the street name back together, for example:
"W"+"17th"+"St" becomes "W 17th St"

We're assuming that no street name has more than three parts to it, but that's reasonable for our example.
12) Run Workspace
Save and then run the workspace (remember to turn off any Redirect option!)
Open the containing folder to check the output has been written. There should be both an output file and schema document.
Inspect the data in the FME Data Inspector. The output (with a background map turned on) should look like this:
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Tiles Courtesy of MapQuest

Querying a feature will return all of the attributes we've just put together:
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CONGRATULATIONS
By completing this exercise you have learned how to:
Use the AttributeManager transformer to create, delete, and rename attributes
Use the AttributeSplitter to split attributes into a list attribute
Handle list attributes in the AttributeManager
Use an FME function in the AttributeManager text editor
Import feature types from an XML schema document
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Conditional Filtering
Transformers that filter don’t transform data content, yet surveys show that they’re the most commonly used type of transformer
there is!

What is Filtering?
Filtering is the technique of subdividing data as it flows through a workspace. It’s the case where there are multiple output
connections from a transformer, each of which carries data to be processed in a different way.

A filtering transformer may be any transformer with multiple output ports, such as the GeometryFilter or Sampler transformers,
the latter of which create a sample selection of data and separates it out through Sampled and NotSampled output ports.

However, these are mostly in-built, fixed tests. Conditional filtering is where the decision about which features are output to
which connection is decided by some form of user-defined test or condition. The Tester transformer is the most obvious example
of this. It carries out a test and has different output ports for features that pass and fail the test.

Transformers that Filter
The transformers in the Filter category are the main group that carry out these tests and redirect data according to the results.
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Although the Tester transformer is the most used of this category, there are many other transformers such as the
TestFilter,GeometryFilter, AttributeFilter, SpatialFilter, and Sampler.

Miss Vector says...
Time for a quick question. How many of the transformers in the Filter category appear in the top-25 MostValuable Transformers list?
1. Three (3)
2. Four (4)
3. Five (5)
4. Six (6)
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The Tester and TestFilter Transformers
The Tester and TestFilter are the two key transformers for conditional filtering. They are for tests on attribute values.

Tester
The Tester transformer (number 1 in the top 25) is generally for single tests that produce a Yes/No result. For example:
Has there been more than six inches of snowfall?
Is this a major road?
Is the temperature less than zero degrees Celsius?
Was sand last applied more than 24 hours ago?

Here, features will pass if the value of their Snowfall attribute is greater than six. If it is less than (or equal to) six, the feature will
fail the test.
The Tester also allows the combination of multiple tests, where a user can combine any number of clauses using an AND and OR
statement. For example, if I was trying to determine whether to send a snow plough to a particular road I might ask:
Has there been more than six inches of snowfall AND is the temperature less than zero degrees Celsius?
Is this a major road AND (has there been more than six inches of snow OR (is the temperature less than zero AND was sand
last applied more than 24 hours ago))?
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When I have multiple tests I control them using the Pass Criteria field. A mix of AND/OR clauses requires a Composite Test, as
shown above. But - however complex the test becomes - it still results in a single Yes/No result; features will either pass or fail
this set of tests.
Notice we aren't restricted to simple tests of equality (A=B); in the above there are also "greater than" and "less than" tests. That's
because there are many different operations available for use in a test clause.

Operators
There are a number of operators available in the Tester transformer (or in many of the other locations that make use of the Tester
dialog):

Besides the usual operators, there are also some based on a SQL where clause. These include:
In
Between
Like
Matches Regex
Contains
Begins With
Ends With
…plus there are other tests that test for the existence of attributes and values:
Attribute has a value
Attribute is Null
Attribute is Empty String
Attribute is Missing

NEW
"Attribute has a value" is a new test for FME2016. It is basically the opposite of the three other tests; i.e.
this attribute is not Null, AND it is not an empty string, AND it is not missing.
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.1 UPDATE
In FME2016.1 the "Matches Regex" operator is changed to "Contains Regex." The 2016.0 version
required the entire string to match a regular expression, whereas now only part of the string needs to
match. For example...
Attribute Value: abcd
Search String:
^ab
Matches Regex (2016.0):
Contains Regex (2016.1):

Failed
Passed

Any existing Testers (i.e. added to a workspace in 2016.0) will act the same as before, but newly added
Testers will exhibit the new behaviour.

TestFilter
The TestFilter (#11 in the top 25) is essentially a way to combine multiple Tester transformers into one. Instead of the Tester's
single Passed and Failed ports, you can create an output port for each condition (it does not need to be called "Passed") and an
output port for features that fail all of the test conditions.
The TestFilter is very similar to the CASE or SWITCH command in programming or scripting languages.

Sister Intuitive says...
The TestFilter is very good for filtering a feature by a set of cascading conditions, for example here are a
set of tests to again determine whether to send out a snow plough:
- Has there been more than six inches of snowfall?
- Has there been more than four inches of snowfall AND is this a major road?
- Is the temperature less than zero degrees Celsius AND was sand last applied more than 24 hours ago?
It’s a set of cascading tests, because if there has been more than six inches of snow, the ploughs are sent
out anyway; you don’t need to test any other criteria. So the test order can be very important. Also notice
that you can include composite tests (those with ANDs or ORs in them).

The TestFilter has the full set of operators available with the Tester such as equals, greater than, less than, and so forth. Each
condition is tested in turn.
Features that pass are output through the matching output port. Features that fail are sent on to the next condition in the list.
Therefore it’s very important to get the conditions in the correct order.
In this example the user has used three Tester transformers (and six connections) to filter out the different parts of this data.
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With the TestFilter, the three Testers are now replaced with one single transformer and there are only four connections.

Also notice how the TestFilter output ports have custom naming. This is another advantage to this transformer.

Chef Bimm says...
Because the TestFilter can carry out a single test (as well as multiple ones) it's possible to use it
exclusively instead of the Tester transformer.
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Other Key Filter Transformers
The Tester and TestFilter are not the only useful filter transformers.

AttributeFilter
The AttributeFilter transformer (#9 in the top 25) directs features on the basis of values in a chosen attribute. It is best for testing
many values for a single attribute, for example:
Is that road a Primary , Secondary, Residential, Private, or Other type of road?
Is the forecast for sun, rain, snow, or fog?
In this example features are divided into different postal codes depending on the value of a PostalCode attribute.

If your workspace looks like this then an AttributeFilter transformer might be a better option.

In this transformer the only "operator" is to find equivalency, so you would rarely use it for arithmetical tests.

Confused from Interopolis says...
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Dear Aunt Interop
If the Tester, TestFilter, and AttributeFilter all filter features on the basis of an attribute condition, then
what’s the difference? When would I use each?

Aunt Interop says...
Dear Confused
The best solution is to check out these two articles on the Safe Software blog:
- Conditional Processing in FME
- A Simple Guide to FME Filter Transformers

AttributeRangeFilter
The AttributeRangeFilter carries out the same operation as the AttributeFilter, except that it can handle a range of numeric values
instead of just a simple one-to-one match.

The AttributeRangeFilter parameters dialog has the option to generate ranges automatically from a set of user-defined extents.

GeometryFilter
The GeometryFilter (#15 in the top 25) directs features on the basis of geometry type; for example, point, line, area, ellipse.
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The GeometryFilter is useful for:
Filtering out unwanted geometry types; for example removing non-linear features before using an AreaBuilder transformer
(above)
Dividing up geometry types to write to separate destination Feature Types; for example, when writing to a geometryrestricted format such as Esri Shapefile
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Exercise 2

Noise Control Laws Project

Data

Addresses (File Geodatabase)
Zoning (MapInfo TAB)
Roads (AutoCAD DWG)

Overall Goal

To find all residential addresses within 50 meters of an arterial highway

Demonstrates

Methods of conditional filtering

Start Workspace

None

End Workspace

C:\FMEData2016\Workspaces\DesktopBasic\Transformers-Ex2-Complete.fmw

City councillors have voted to amend noise control laws. However, local residents living in a single-family residence within 50
metres of a major highway must be contacted to inform them of these changes.
You have been recommended by your manager to take on the task of finding all affected addresses. There's a tight deadline and at
least three city councillors are standing watching you work. The pressure is on and it's up to you to deliver!

1) Start Workbench
Start Workbench and create a new empty workspace.

2) Add Reader (Roads data)
Use Readers > Add Reader to add a Reader for the roads data. The roads data will be used to determine distance from an arterial
route.
Reader Format

Autodesk AutoCAD DWG/DXF

Reader Dataset

C:\FMEData2016\Data\Transportation\Roads.dwg

When prompted, select only the feature type (layer) called Arterial.

3) Add Reader (Zoning data)
Use Readers > Add Reader to add a reader for zoning data. The zoning data will be used to determine whether an address is
single-family residential or not.
Reader Format

MapInfo TAB (MITAB)

Reader Dataset

C:\FMEData2016\Data\Zoning\Zones.tab

4) Add Reader (Address data)
Use Readers > Add Reader to add a reader for address data:
Reader Format

Esri Geodatabase (File Geodb API)

Reader Dataset

C:\FMEData2016\Data\Addresses\Addresses.gdb

Reader Parameters

Table List: PostalAddress

Ensure the feature types on the canvas are laid out in the order Arterial - Zones - PostalAddress; the workspace will now look like
this:
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Feel free to inspect all of the source data to familiarize yourself with the contents.

5) Add Tester Transformer
Add a Tester transformer to the Zoning feature type.
This Tester will be used to filter residential zones from the other zoning areas. All single-family residential zones will start with
RS, so the Tester should be set up like this:

The important thing is to set up the tests using the “Begins With” predicate.

Miss Vector says...
So... why the Tester? Why not use the AttributeFilter? Do you know?

6) Add SpatialFilter
Add a SpatialFilter transformer to the workspace. This will be used to test each address to show whether that address falls inside
one of the filtered residential zones.
Connect the Tester:Passed output to the SpatialFilter:Filter port
Connect the feature type PostalAddress to the SpatialFilter:Candidate port

372

Exercise: Noise Control Laws Project

7) Set up SpatialFilter
Open the SpatialFilter parameters dialog. Set up the parameters.
Tests to Perform should be set to 'Contains' (i.e. find addresses that the zones contain). The Filter Type should be set to Multiple
Filters (as there are multiple zoning areas). However, the Pass Criteria parameter should be “Pass Against One Filter.”
This parameter is very important. The test will fail if it is not set correctly, as a single address cannot be in ALL zones.

8) Add Inspectors
Now let's test what we have so far. Add Inspectors to both SpatialFilter output ports, and the Tester:Passed port.

9) Save and Run Workspace
Save the workspace. Run the workspace. Inspect the output to prove that it has worked as expected. The only area features will be
the residential zones, and SpatialFilter:Passed (address) features will fall inside these areas.

10) Add Bufferer
Now we can determine which of the filtered addresses fall within 50 metres of an arterial route.
The SpatialFilter does not have a test for "within X distance" therefore we'll have to set that up a little differently. Add a Bufferer
transformer to the workspace. Connect it to the Arterial roadsdata:
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Now open the parameters dialog for the Bufferer. Set the buffer amount to be 50.

.1 UPDATE
The Bufferer transformer in the above screenshot gained a <Rejected> port in FME2016.1

TIP
Optionally you can add a Dissolver transformer after the Bufferer, to merge all the buffer features
together.
The results of the translation will be the same (in terms of addresses selected) but the data will look better
in the FME Data Inspector.

11) Add SpatialFilter
Add a second SpatialFilter transformer. The buffered arterial routes are the Filter. The prefiltered addresses are the Candidates:

As before, open the parameters dialog and change the settings to be a 'Contains' test against multiple filters.
12) Run Workspace
Attach some Inspector transformers to show you the output from various transformers. Save and run the workspace. The output
(zoomed in) should look like this:
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Tiles Courtesy of MapQuest

CONGRATULATIONS
By completing this exercise you have learned how to:
Use the Tester transformer to filter by an attribute value
Use the SpatialFilter transformer to filter by geometry
Use the Bufferer transformer to set up a "within x distance of" test
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Data Joins
Transformers that join data together are also very commonly used in FME.

What is a Data Join?
Whereas Filter transformers divide data into different streams, other transformers bring data streams together, merging the data
according to a set of user-defined conditions.

To merge data in FME Workbench it is necessary to do more than just draw two connections into the same input port; that will
only combine the data into a single stream, not fuse it together. To truly merge data it is necessary to define a relationship for the
basis of the join, and this is done with one of a number of transformers.
These transformers allow you to merge not just data that is being processed by the workspace, but provide the ability to form a
join against a database or other external dataset.
Joins in FME can either be based on matching attribute values (Joiner or FeatureMerger), or they can be based on a spatial
relationship such as an overlap between features or proximity from one feature to another (NeighborFinder or SpatialRelator).
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Attribute Join Transformers
These are transformers that join data on the basis of a matching attribute value.

FeatureMerger
The FeatureMerger is the primary transformer for joining two streams of data within a workspace. This is achieved on the basis of
one or more matching attribute values (keys).

Here, for example, a dataset of facilities has an AddressId number, but no address. The FeatureMerger is being used to combine
data from an address table into the facilities data.
Of interest for QA reasons is the NotMerged port. Here facilities that did not have a matching AddressId are sent to a Inspector
transformer to record the fact that there was no match. These records could then be checked to ensure they have a valid AddressId.
The parameters dialog for the FeatureMerger looks like this:
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Notice how the AddressId attribute from each set of data is being used to merge the features together. Also notice that the merge
can (and in this case does) include both attributes and geometry; i.e. the "requestor" can be updated with the geometry of the
"supplier."
Attribute Accumulation parameters allow you to determine what to do if the requestor already has an attribute of the same name
as one being supplied to it (for example, if the Facility records already had a Postcode field, which should take precedence?)

TIP
Another useful parameter is called Number of Suppliers Attribute. This attribute will be used to record the
number of suppliers that were matched to any one requestor (assuming Process Duplicate Suppliers is
turned on).

Joiner
The Joiner transformer is similar to the FeatureMerger, but instead of merging two streams of features, it merges one stream of
features with data from an external database.

Here is the same example as for the FeatureMerger above. In this case the facilities features are obtaining address data directly
from an address table in a PostGIS database.
The parameters dialog for the Joiner looks like this:
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Again, AddressId is being used to facilitate a merge between the two sets of data.

First-Officer Transformer says...
The Joiner has a number of advantages over the FeatureMerger. Firstly it has parameters to control how
multiple matches are handled, as well as parameters for optimizing the database query.
Secondly, it allows features to be joined without having to read the entire dataset into a workspace. FME
can just query the database and select the individual records it needs. This can improve performance
greatly.
It does, of course, require the supplier records to be stored in an appropriate database format!
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Spatial Join Transformers
These are transformers that join data on the basis of a spatial relationship. There are many of these in FME Workbench, but the
following are some of the key ones.

Overlayers
There are a number of different "overlayer" transformers, each handling a different form of overlay. For example the
PointOnAreaOverlayer carries out a spatial join on points that fall inside area (polygon) features. As the help explains, "Each
point receives the attributes of the area(s) it is contained in, and each containing area receives the attributes of each point it
contains."

Here the facility features are being provided with a postal code depending on which postal code polygon feature they fall inside.
The "_overlaps" attribute is another useful outcome of this transformer. It tells us how many polygons each facility fell inside; in
this case it would be an easy way to spot the problem of a facility falling inside more than one postal code.
Conversely, the Area output would have an "_overlaps" attribute that would tell us how many facilities fell inside each postal
code.

NeighborFinder
The NeighborFinder transformer carries out a spatial join based on a proximity relationship.

Here the NeighborFinder is being used to identify the closest fire hall to each facility. The FireHallId and FireHallAddress
attributes will be merged onto each Facility feature along with a number of useful attributes recording the X/Y coordinate,
direction, and distance of the closest fire hall.
The parameters of the NeighborFinder includes the ability to specify a maximum distance for the relationship, or the maximum
number of neighbors to find.
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FeatureReader
The FeatureReader is the spatial equivalent of the Joiner transformer. It reads from an external dataset and forms a match based on
a spatial relationship between the initiating feature and features in that dataset.

Here the FeatureReader is being used to carry out the same overlay of facility and postal code, but the postal code information is
being stored in a separate database and queried to retrieve data based on the spatial relationship with the facility.

SpatialFilter
The SpatialFilter - as its name suggests - filters data according to a spatial relationship. However, it does also merge attributes
from one feature to another, therefore can be said to be a type of Spatial Join.

Miss Vector says...
Here is a question on data joins. Look at the following screenshot, then answer how many features will
appear in the output connection...

1. Eight (8)
2. Eighteen (18)
3. Twenty-six (26)
4. Can't tell
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Module Review
This module was designed to introduce you to a wider range of FME transformers, plus a number of techniques for applying
transformers more efficiently.

What You Should Have Learned from this Module
The following are key points to be learned from this session:

Theory
There are distinct groups of transformers that do work other than transforming data attributes or geometry
A large proportion of the most-used transformers are related to attribute-handling
Filtering is the act of dividing data. Conditional Filtering is the act of dividing data on the basis of a test or condition
Data Joins are carried out by transformers that merge data together, from within Workbench or from external data sources
Integrated functionality allows the author to replace support transformers with tools built-into operational transformers

FME Skills
The ability to locate a transformer to carry out a particular task, without knowing about that transformer in advance
The ability to use common transformers for attribute management
The ability to use transformers for filtering and dividing data
The ability to use transformers for merging data together
The ability to build strings and calculate arithmetic values using integrated tools

Further Reading
For further reading why not browse blog articles for particular transformers such as the TestFilter, AttributeCreator, or
FeatureMerger?
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Questions
Here are the answers to the questions in this chapter.

Miss Vector says...
Which of the following is NOT a category of transformers?
1. Databases
2. Formats
3. Linear Referencing
4. Surfaces

Miss Vector says...
Here are four transformers and four categories. Match the transformer to the correct category.
Scenario

Tool

Chopper

Manipulators

Terminator

Infrastructure

Matcher

Filters

DateFormatter

Calculators

Did you look through the transformer gallery to find these? The quicker way is to look at the help page for
the transformer. While we are on the subject, transformers can belong to more than one category (though
not all do).

Miss Vector says...
Look at this screenshot of an editing dialog and tell me what the value returned to the attribute will be:
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1. 2+2
2. 4
3. 4.0
4. Error!
The key is to notice that the header of this dialog says "String Editor". Therefore the value returned to this
attribute will be the literal string "2+2". If the user wishes to add 2+2 to get 4, they should have used the
arithmetic editor!

Miss Vector says...
How many of the transformers in the Filter category appear in the top-25 Most-Valuable Transformers
list?
1. Three (3)
2. Four (4)
3. Five (5)
4. Six (6)
They are the Tester (1st), TestFilter (11th), and GeometryFilter (15th)

Miss Vector says...
So... why the Tester? Why not use the AttributeFilter?
Because we only need to test for one value in a simple Yes/No format. The AttributeFilter is better for
testing multiple values. Also the AttributeFilter doesn't let us do "Begins With" tests.

Miss Vector says...
Look at the following screenshot, then answer how many features will appear in the output connection...

1. Eight (8)
2. Eighteen (18)
3. Twenty-six (26)
4. Can't tell
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It's impossible to tell from the screenshot, because you don't know how many attribute values will be a
match. Because there are eight firehalls it will be anywhere from zero to eight, but that's all we can tell.

Miss Vector says...
Why do we use the StringCaseChanger on the roads data (to change it to UPPERCASE) rather than on
the crime data (to change it to TitleCase)?
Because uppercase is easier to match and has no risk of bad data. If a block was wrongly labelled W
Georgia ST in the original data, a title case match would fail. An uppercase conversion would not.
Also, be sure not to confuse the StringCaseChanger (changes attribute values) with the
BulkAttributeRenamer (changes attribute names)!
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Exercise 3

Crime Mapping Data Request

Data

Roads (AutoCAD DWG)
Crime Statistics (CSV)

Overall Goal

Carry out a join between crime statistics and city block

Demonstrates

Attribute-Based Joins

Start Workspace

None

End Workspace

C:\FMEData2016\Workspaces\DesktopBasic\Transformers-Ex3-Complete.fmw
C:\FMEData2016\Workspaces\DesktopBasic\Transformers-Ex3-Complete-Advanced.fmw

A data journalist with a national newspaper has made a request for spatial data showing the location of crime within the city on a
block-by-block basis. It's partly a test of the city's open data policy and there's no question of not complying.
However, a crisis arises as the current datasets for crime (CSV, non-spatial) and city blocks (AutoCAD) are not joined in any way!
You hear about the problem and suggest that FME can create a join between the crime figures and city blocks so that the
information can be provided in the format requested. Pull this off and you will be a spatial superhero!

1) Inspect Source Data (Crime)
The first task is to familiarize yourself with the source data. To do this open the following dataset within the FME Data Inspector
or a simple text editor.
Reader Format

Comma Separated Value (CSV)

Reader Dataset

C:\FMEData2016\Data\Emergency\Crime2011.csv

Reader Parameters

File Has Field Names: Yes (Checked)
Lines to Skip: Header 1

The data will look like this in the Data Inspector Table View window:

Notice how there is no spatial data as such, but there is a block number.

Police-Chief Webb-Mapp says...
Crime?! In my city? I think not. But if there was... be aware that 7XX W Georgia Street means the seventh
block on Georgia Street west of Ontario Street and covers building numbers 700-800. 7XX E Georgia
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Street would be 14 blocks away, the seventh block east of Ontario. Got it?

2) Inspect Source Data (Roads)
Now let's inspect some spatial data that we can merge the crime statistics onto. Open the following dataset in the Data Inspector
Reader Format

Autodesk AutoCAD DWG/DXF

Reader Dataset

C:\FMEData2016\Data\Transportation\Roads.dwg

Reader Parameters

Group Entities By: Attribute Schema

This is a dataset of roads. You'll see that the roads are split up at the junction of each city block, which is perfect for our purposes.
It too has a block number attribute:

One difference that will make the join harder is that the block number is padded with zeros ("700" instead of "7XX"). Another
difference is that the road data is stored in Title case ("W Georgia St") in the roads dataset, whereas the crime dataset is upper case
("W GEORGIA ST").

3) Add Readers
Now let's start working with this data. Start FME Workbench and begin with a blank canvas.
Add a Reader to the workspace using Readers > Add Reader from the menubar. This Reader should be used to read the crime
(CSV) data. Be sure to use the same parameters as specified for the Data Inspector.
Now add a second Reader to read the roads (DWG) data. However, from inspecting the data, I see that the roads are stored on a
set of seven different layers. We don't need that, so set the "Single Merged Feature Type" parameter when adding the Reader, like
so:
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Again, be sure to use the same Group Entities By parameter as specified for the Data Inspector.
The workspace will now look like this:

If you don't click the Single Merged Feature Type option you'll get a feature type for each AutoCAD layer. That's OK, but you'll
have to make sure you connect each of them to the subsequent transformers.

4) Add StringReplacer
To merge the data we need a common block attribute. The current difference in how the block number is structured can be fixed
very simply by replacing "XX" with "00" using a StringReplacer transformer.
Add a StringReplacer transformer and connect it to the Crime dataset feature type.
Open the parameters dialog for the StringReplacer. Set the proper parameters. The Attribute to process will be "Block", the Text to
Match will be "XX" and the Replacement Text will be "00", like so:

388

Exercise: Crime Mapping Data Request

Click OK to accept the values. If you wish, attach Inspector transformers and run the workspace to ensure the transformer is
working as expected.

5) Add StringCaseChanger
The other difference in crime/road data was in UPPER/Title case street names. This disparity can be fixed with a
StringCaseChanger transformer.
Add a StringCaseChanger transformer and connect it to the roads dataset feature type:

Open the parameters dialog. Set the parameters to change the values of HBlock to upper case:

Miss Vector says...
So, answer me this. Why do we use the StringCaseChanger on the roads data (to UPPERCASE) rather
than changing the crime data (to TitleCase)? Do you know?

6) Add FeatureMerger
Now we've sorted out the structure of our join keys we can merge the data together with a FeatureMerger.
Add a FeatureMerger to the canvas. Connect the roads data as the Requestor and the crime data as the Supplier (we wish to supply
the roads data with crime statistics):
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If, like me, you don't like connections that cross over, feel free to swap the position of the objects around to untangle it.
Open the parameters dialog for the FeatureMerger.
For the "Join On" set of parameters, the Requestor join attribute will be HBlock, the Supplier join attribute will be Block, and the
Comparison Mode will be String:

Dr Workbench says...
If you are sharp, you may have noticed that the Requestor and Supplier parameters can be defined within
a text edit window.
That means, instead of using the transformers we just added, we could replicate their functionality using
functions inside that text editor, like so:
@ReplaceString(@Value(Block),XX,00)
@UpperCase(@Value(HBlock))

For the "Merge Parameters" the Feature Merge Type should be Attributes Only. Because we can expect multiple crimes per block
the parameter Process Duplicate Suppliers should be set to Yes. Set the Number of Suppliers Attribute to be "NumberOfCrimes" this will create an attribute of that name recording how many crimes occurred in that block.
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Finally, the attribute accumulation needs to be "Merge Supplier."
Click OK to close the dialog.

7) Add Inspectors
Add Inspector transformers to the Merged and NotMerged output ports (or connect both outputs to one Inspector). This will give
us the roads data with crime info attached. The NotMerged data is important because there may be blocks without any crime.
The Unreferenced output port will show us crimes that didn't match to a known address, so connect a Logger transformer here to
record any features that fail in this respect.

8) Save and Run Translation
Save the workspace and then run the translation. By querying a block you should be able to see how many crimes took place
there.

TIP
If you want to see a list of crimes that took place in each block, open the FeatureMerger parameters and
check the box to Generate List. Now re-run the workspace and query a feature (the list won't show up in
the table view window).

Advanced Exercise
You've now successfully merged crime statistics onto a set of spatial data, which is what the data
journalist was asking for. However, if he can create a map from that information, then so can we. If you
have time, let's give it a try.
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9) Add MapnikRasterizer
The MapnikRasterizer is a way of creating nicely formatted raster map output from a set of vector data.
Place a MapnikRasterizer transformer connected to the Merged output port of the FeatureMerger:

Open the parameters dialog. Set the Merged layer to be a Line symbolizer. Then click the Edit button to the right.
For the Line Width (pixels) parameter click the drop down arrow and select Attribute Value > Number of Crimes. Click OK to
close the dialog.
Set the output raster size to be 2500 cells for both Columns and Rows.

10) Add RasterExpressionEvaluator
If you run the workspace now you will see a white square containing black "features". To see the background map through the
white area we can set the transparency of the white data.
To do this, add a RasterExpressionEvaluator transformer. Open the parameters dialog and set the parameters as follows:
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This basically means set the Red-Green-Blue values as they were before. If the blue value was 255 then set transparency to 0, else
set it to 255. i.e. If the area is white, then set it to transparent.

11) Run Workspace
Now you can add an Inspector and run the workspace.
The output will look like this:

Tiles Courtesy of MapQuest

Basically we've created a map where road width reflects the amount of crime on that block.

CONGRATULATIONS
By completing this exercise you have learned how to:
Pre-process data to get join keys with a matching structure
Join non-spatial data with a join key in the FeatureMerger
Use the MapnikRasterizer to create a map output
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Course Wrap-Up
Although your FME training is now at an end, there is a good supply of expert information available for future assistance.
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Product Information and Resources
Safe Software Web Site
The Safe Software web site is the official information source for all things FME. It includes information on FME products, Safe
Software services, FME solutions, FME support and Safe Software itself.

Safe Support Team
Behind FME are passionate, fun, and knowledgeable experts, ready to help you succeed, with a support team philosophy built on
the principle of knowledge transfer.
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Your Local Partner
Safe Software has partners and resellers around the world to provide expertise and services in your region and your language.
You can find a list of official partners on the Safe Software web site.

Safe Software Blog
The Safe Software blog provides technical information about FME, articles about customers' use cases, and general thoughts on
spatial data interoperability.
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FME Manuals and Documentation
Use the Help function in FME Workbench to access help and other documentation for FME Desktop. Alternatively, look on our
web site under the Knowledge Center section.
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Community Information and Resources
Safe Software actively promotes users of FME to become part of the FME Community.

The FME Knowledge Center
The FME Knowledge Center is our community web site - a one-stop shop for all community resources, plus tools for browsing
documentation and downloads.

Knowledge Base
The FME Knowledge Base contains a wealth of information; including tips, tricks, examples, and FAQs. There are sections on
both FME Desktop and FME Server, with articles on topics from installation and licensing to the most advanced translation and
transformation tasks.

Q&A Forum
FME community members post FME-related messages, ask questions, and share in answering other users’ questions. Members
earn "reputation" and "badges" and there is a leaderboard of the top-participating users. Come and see how they can help with
your FME projects!

Ideas Exchange
FME development is very much user-driven. The Ideas Exchange gives users the chance to post their ideas for new FME
functionality, or improvements to existing functionality, and allows everyone to vote on the proposed ideas. The more votes an
idea gets, the more likely it is to be implemented!
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The FME Channel
This FME YouTube channel is for those demos that can only be properly appreciated through a screencast or movie. Besides this
there are a host of explanatory and helpful movies, including recordings of most training and tutorials.
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Feedback and Certificates
The format of this training course undergoes regular changes prompted by comments and feedback from previous courses.

Course Feedback
Miss Vector says...
There's one final set of questions – and this time you'll be telling me if the answers are correct or not!

Safe Software greatly values feedback from training course attendees and our feedback form is your chance to tell us what you
really think about how well we’re meeting your training goals.
You can fill in the feedback form now, but you'll also be reminded by email shortly after your course. Safe Software's partners
who carry out training may ask that you fill in a separate form, but you can also use the official Safe Software form if you wish.

Certificates
Mr. E. Dict, (Attorney of FME Law)says...
In order to prove you have taken this training course, a certificate will be emailed automatically to anyone
who was logged on for the duration of Safe Software hosted courses.
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Thank You
Thank you for attending this FME training course.
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Congratulations!
As a reward for reading this far, here's a little quiz for you to try out.
As you may know, if you opt in, FME records information about what formats and transformers you are using. It lets us create
general statistics and shows us where to focus our development work.
The following questions are based on these statistics for FME2016 beta (from the time it first appeared on our web site, up until
December 2015). They refer to the number of times a transformer or format was added to a workspace, by a user.
Each question has a number of correct answers. Your job is to pick one of these answers, but get the LOWEST score you can; i.e.
identify a transformer or format that was used as little as possible during the beta period!
The ultimate answer is one that is pointless (i.e. with no score)!
So, here goes...

Miss Vector says...
Without looking in Workbench (that would be cheating) identify a transformer that is in the Filters
category in the transformers gallery in FME2016. Remember, you're trying to guess one that was as little
used as possible!
One answer is very high (you can probably guess which). But there are two transformers that were not
used at all in the 2016 beta phase and so will score zero points. Will the transformer you select be one of
those?!
If the transformer you select is incorrect - i.e. it is not a transformer in the Filters category - then you will
score 100 points!

Dr Workbench says...
Again without looking in Workbench, identify a Reader in FME2016 that includes the word "XML" in its
full FME name.
I don't just want an XML-based format. For example "GeoRSS/RSS Feed" might be XML-based, but it
doesn't have the string "XML" in its name, so it doesn't count. There are nine different formats to choose
from, and four of them will score you zero points, so your chances are quite good!

Sister Intuitive says...
I'll be kind to you. All I need is a transformer whose name begins with the word "Attribute".
There are lots of these - and I'm including aliases - so you shouldn't get a completely wrong answer.
However, it will take a lot of meditating to choose the one transformer that is a zero score.
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Police Chief Webb-Mapp says...
So! You think you're good, do you? Well here is a really tough question to sort out the good guys from the
bad.
The What's Great in 2015 article on the FME blog listed 18 transformers that were new in 2015 (or a
2014 Service Pack). All you have to do is name one.
That shouldn't be too hard, should it? Not many were used much in the 2016 beta period, so if you can get
it right, you will score well!

Miss Vector says...
Have you written down your answers? And are you sure you didn't cheat? Good.
To find out what your score is, visit this page: http://www.safe.com/training/quiz/
Good luck!
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